
Server Migration Service

User Guide

Date 2023-04-30



Contents

1 Service Overview..................................................................................................................... 1
1.1 What Is SMS?............................................................................................................................................................................ 1
1.2 SMS Functions.......................................................................................................................................................................... 2
1.2.1 Migration Feasibility Check.............................................................................................................................................. 2
1.2.2 Migration and Synchronization for Windows............................................................................................................ 2
1.2.3 Migration and Synchronization for Linux.................................................................................................................... 2
1.2.4 Dynamical Secure Transmission Channel.................................................................................................................... 3
1.3 SMS Advantages...................................................................................................................................................................... 3
1.4 Related Services....................................................................................................................................................................... 4
1.5 Precautions................................................................................................................................................................................ 4
1.5.1 Constraints............................................................................................................................................................................. 4
1.5.2 Supported OSs...................................................................................................................................................................... 6
1.5.2.1 Supported Windows OSs............................................................................................................................................... 6
1.5.2.2 Supported Linux OSs....................................................................................................................................................... 7
1.5.3 Disclaimer............................................................................................................................................................................ 10
1.6 Service Agreement................................................................................................................................................................11
1.7 Permissions Management..................................................................................................................................................15

2 Getting Started...................................................................................................................... 17
2.1 Quick Start.............................................................................................................................................................................. 17
2.2 Preparing for Migration...................................................................................................................................................... 17
2.3 Installing the Agent on Source Servers......................................................................................................................... 19
2.3.1 Windows............................................................................................................................................................................... 19
2.3.2 Linux.......................................................................................................................................................................................21
2.4 (Optional) Creating a Migration Template..................................................................................................................22
2.5 (Optional) Creating a Server Template.........................................................................................................................22
2.6 Configuring a Target Server.............................................................................................................................................. 23
2.7 Starting a Full Replication................................................................................................................................................. 29
2.8 Launching a Target Server................................................................................................................................................. 30
2.9 Synchronizing Incremental Data..................................................................................................................................... 31

3 User Guide...............................................................................................................................32
3.1 Permissions Management..................................................................................................................................................32
3.1.1 Creating a User and Assigning Permissions............................................................................................................. 32

Server Migration Service
User Guide Contents

2023-04-30 ii



3.1.2 SMS Custom Policies........................................................................................................................................................ 34
3.2 Server Management............................................................................................................................................................ 35
3.2.1 Configuring a Target Server........................................................................................................................................... 35
3.2.2 Starting a Full Replication.............................................................................................................................................. 42
3.2.3 (Optional) Cloning a Target Server.............................................................................................................................43
3.2.4 Launching a Target Server..............................................................................................................................................43
3.2.5 Viewing a Server Details................................................................................................................................................. 44
3.2.6 Synchronizing Incremental Data.................................................................................................................................. 45
3.2.7 Deleting the Target Server Configuration................................................................................................................. 45
3.2.8 (Optional) Deleting a Cloned Server.......................................................................................................................... 46
3.2.9 Deleting a Server............................................................................................................................................................... 46
3.2.10 Setting the Migration Rate.......................................................................................................................................... 47
3.2.11 Unlocking a Target Server............................................................................................................................................47
3.3 Template Management...................................................................................................................................................... 48
3.3.1 Creating a Migration Template.....................................................................................................................................48
3.3.2 Modifying a Migration Template................................................................................................................................. 51
3.3.3 Deleting a Migration Template.................................................................................................................................... 51
3.3.4 Creating a Server Template........................................................................................................................................... 51
3.4 Viewing CTS Traces...............................................................................................................................................................54
3.4.1 SMS Operations Supported by CTS............................................................................................................................. 54
3.4.2 Viewing Tracing Logs........................................................................................................................................................54

4 FAQs..........................................................................................................................................56
4.1 Product Consulting............................................................................................................................................................... 56
4.1.1 Can I Migrate Physical Servers and VMs from Other Clouds to the Cloud Platform Using SMS?........56
4.1.2 Can I Migrate ECSs to an On-premises Environment or Another Cloud Using SMS?............................... 56
4.1.3 Can I Ask the Technical Support to Help Me Move Servers?............................................................................. 56
4.1.4 Can I Migrate Workloads to a DeH, or DeC Using SMS?.................................................................................... 56
4.1.5 Does SMS Support Resumable Data Transfer?....................................................................................................... 57
4.1.6 How Do I Migrate an ECS from One Account to Another?................................................................................ 57
4.1.7 How Do I Migrate an ECS from One Region to Another Using SMS?............................................................ 57
4.1.8 Will My Services on the Source Server Be Interrupted During Migration?................................................... 57
4.1.9 How Do I Create an AK/SK Pair for an Account?................................................................................................... 57
4.1.10 How Do I Create an AK/SK Pair for an IAM User?.............................................................................................. 58
4.1.11 How Do I Migrate a Linux Source Server as a Non-root User?...................................................................... 59
4.1.12 What Information Does SMS Collect About Source Servers?.......................................................................... 59
4.1.13 How Do I Select a Target Server?..............................................................................................................................62
4.1.14 How Do I Create an ECS?............................................................................................................................................. 62
4.1.15 What Is the Block-Level Migration?..........................................................................................................................63
4.1.16 What are Valid Data Blocks?...................................................................................................................................... 63
4.1.17 Why Is the OS Name of the Target ECS Displayed on the ECS Console Different from That of the
Source Server?............................................................................................................................................................................... 63
4.1.18 How Do I Determine Whether a Migration Task Is Complete?...................................................................... 64

Server Migration Service
User Guide Contents

2023-04-30 iii



4.1.19 Can I Migrate Only Some Services on the Source Server?............................................................................... 64
4.1.20 Can the Target Server Run a Different Type of OS from the Source Server?............................................ 64
4.1.21 What Determines the Specifications of a Target Server?................................................................................. 64
4.1.22 Which Download Option Should I Choose When I Download the Windows Agent?............................. 64
4.1.23 How Does SMS Differ from IMS in the Migration Scenario?...........................................................................65
4.1.24 How Do I Display the OS Name of a Target Server on the ECS Console?..................................................65
4.1.25 What Are the Snapshots of a Target Server Used for?...................................................................................... 67
4.1.26 In a Linux File-Level Migration, How Do I Exclude Directories from Migration and Synchronization?
............................................................................................................................................................................................................ 67
4.1.27 Will an Incremental Synchronization Overwrite the Existing Data on a Launched Target Server?... 69
4.1.28 How Do I Create a Target Server that Meets the SMS Requirements?........................................................69
4.1.29 Can SMS Migrate Self-built Databases, Big Data Services, or Websites Deployed on a Source
Server?............................................................................................................................................................................................. 70
4.1.30 Can the AK/SK of a Federated User (Virtual IAM User) Be Used for Authentication During the
SMS-Agent Startup?.................................................................................................................................................................... 71
4.1.31 How Do I Synchronize Files in Specific Directories After a Linux File-Level Migration Is Complete?
............................................................................................................................................................................................................ 71
4.1.32 Will the Migration Be Affected If the SSH Service Does Not Use Default Port 22 on the Source
Server?............................................................................................................................................................................................. 71
4.1.33 How Do I Obtain the SMS Domain Name?........................................................................................................... 71
4.1.34 How Many Resources Will Be Used for a Linux Block-Level Migration?..................................................... 71
4.1.35 How Do I Disable Data Compression When the CPU Usage Is Too High During a Linux Block-Level
Migration?...................................................................................................................................................................................... 73
4.1.36 Do I Need to Activate My Windows OS and Paid Software After the Migration?...................................74
4.1.37 How Do I Set the Number of Concurrent Processes for Linux File-Level Migrations?........................... 74
4.1.38 Which Directories Are Not Synchronized by Default During Incremental Synchronization on a Linux
Server?............................................................................................................................................................................................. 75
4.1.39 How Do I Verify Data Consistency Between the Source and Target Servers?........................................... 76
4.2 OS Compatibility and Migration Restrictions..............................................................................................................79
4.2.1 What Source Server OSs Are Supported by SMS and Are There Any Restrictions on Using SMS?.......79
4.2.2 What Are the Important Statements of SMS?........................................................................................................ 84
4.2.3 How Many Servers Can I Migrate Concurrently Using SMS?.............................................................................85
4.2.4 How Do I Resolve the Error "Inconsistent firmware type. Source: UEFI, Target: BIOS" When I Create
a Migration Task?.........................................................................................................................................................................85
4.2.5 How Do I Resolve Error "Incompatible file system of the source server"?................................................... 86
4.2.6 How Do I Resolve Error "Insufficient permissions. Add corresponding fine-grained permissions"?.... 87
4.2.7 How Do Resolve the Error "Source server lacks driver files"?........................................................................... 87
4.2.8 How Do I Resolve Error "VSS not installed on the source server"?................................................................. 88
4.2.9 How Do I Check the Firmware Type of a Source Server?....................................................................................90
4.2.10 Why Can't I Save the Migration Configuration as a Template?..................................................................... 90
4.2.11 How Do I Set Resource Limits for SMS-Agent During a Linux Server Migration?................................... 91
4.3 Migration Network............................................................................................................................................................... 94
4.3.1 How Do I Set Up a Secure Migration Network for Using SMS?....................................................................... 95
4.3.2 How Do I Prepare a Target Server Before the Migration?.................................................................................. 96

Server Migration Service
User Guide Contents

2023-04-30 iv



4.3.3 How Do I Configure Security Group Rules for Target Servers?......................................................................... 96
4.3.4 How Do I Resolve the Error "Failed to establish an SSH connection with the target ECS"?.................. 97
4.3.5 How Do I Fix the Error "Failed to connect to the target ECS. Check whether its IP address is
reachable and confirm that port XX is enabled"?.............................................................................................................99
4.3.6 How Do I Fix a Connection Failure Between the Source Server and API Gateway Due to a Busy
Network?...................................................................................................................................................................................... 100
4.3.7 How Do I Restore the Connection Between the Agent and SMS?................................................................ 101
4.3.8 Why the Migration Progress Is Suspended or Slow?.......................................................................................... 105
4.3.9 Does a Source Server Have to Connect to the Internet?.................................................................................. 105
4.3.10 Can I Release or Change the Target Server EIP During the Migration?.................................................... 106
4.3.11 How Do I Resolve the Error "SMS.0302 Failed to resolve domain name xxx"?......................................107
4.3.12 How Do I Resolve the Error "SMS.0303 Unable to access domain name xxx"?.....................................107
4.3.13 How Do I Measure the Network Performance Before the Migration?...................................................... 108
4.4 Migration Duration............................................................................................................................................................ 109
4.4.1 How Long Does a Migration Take?.......................................................................................................................... 109
4.4.2 How Do I View the Remaining Migration Time?................................................................................................. 112
4.4.3 How Is the Migration Rate Displayed on the SMS Console Calculated?.....................................................113
4.4.4 How Do I Speed Up Migration?................................................................................................................................. 116
4.4.5 Why Does the Migration Speed Fluctuate?........................................................................................................... 116
4.4.6 How Do I Test the Network Between the Source and Target Servers Using iPerf?.................................116
4.4.7 Why Isn't the Increased Bandwidth Being Used During the Migration?..................................................... 119
4.4.8 Is the Migration Speed Determined by the Source Bandwidth or the Target Bandwidth?................... 119
4.4.9 Why Does the Migration Stay in a Stage for a Long Time? ........................................................................... 119
4.4.10 What Factors Affect the Migration Speed?......................................................................................................... 120
4.4.11 Why Is the Linux Block-Level Migration Very Slow?........................................................................................ 122
4.5 Agent Installation and Startup...................................................................................................................................... 122
4.5.1 How Do I Install the Agent on Source Servers?................................................................................................... 122
4.5.2 What Can I Do If I Fail to Download the Agent Installation File?................................................................. 122
4.5.3 How Do I Verify the Integrity of the Agent Installation File?......................................................................... 123
4.5.4 Why Wasn't My Source Server Added to the SMS Console After I Configured the Agent?..................123
4.5.5 How Do I Find and Modify the Agent Configuration Files?.............................................................................124
4.5.6 Where Can I Find the Agent Run Logs?.................................................................................................................. 125
4.5.7 Why Is My Target Server Locked During the Migration?.................................................................................. 125
4.5.8 How Do I Unlock a Target Server Manually?........................................................................................................ 125
4.5.9 How Do I Resolve the "No such file or directory: 'rsync':'rsync" Error When I Start the Linux Agent?
......................................................................................................................................................................................................... 126
4.5.10 How Do I Resolve Error "The application cannot be started due to incorrect parallel configuration"
When I Start the Agent? ........................................................................................................................................................ 129
4.5.11 Why Does the Agent Not Start the First Time I Launch It?...........................................................................129
4.5.12 Why Does the Windows Agent Executable Not Run When I Double-Click It?....................................... 130
4.5.13 How Do I Fix Error "Failed to start the I/O monitoring module" When I Start the Agent?...............130
4.5.14 How Do I Fix Error "INTERNAL ERROR: cannot create temporary directory!" When I Start the
Agent?............................................................................................................................................................................................132

Server Migration Service
User Guide Contents

2023-04-30 v



4.5.15 How Do I Resolve Error "AK/SK authentication failed. Ensure that the system time is consistent
with the standard time and the AK and SK are correct" When I Start the Agent?............................................133
4.5.16 How Do I Troubleshoot Failures of Pasting the AK/SK Pair When I Start the Agent (Python 2)?...134
4.5.17 How Do I Resolve Error "utf-8 codec can't decode byte 0xce in position0: invalid continuation byte"
When I Start the Agent?......................................................................................................................................................... 135
4.5.18 How Do I Resolve Error "Failed to load wmi" During the Agent Startup?...............................................136
4.5.19 How Do I Fix the Agent Startup Failures Due to Agent Files Write or Read Failures?........................ 137
4.5.20 How Do I Restart the Agent?................................................................................................................................... 137
4.5.21 How Do I Fix Agent Startup Failures Due to Insufficient Space in /tmp on a Linux Source Server?
......................................................................................................................................................................................................... 138
4.5.22 How Do I Fix Error "Agent startup failed because the noexec permission is not allowed on /tmp for
SMS Agent. Please remount /tmp without noexec" When I Start the Linux Agent?.........................................138
4.5.23 How Do I Resolve Error "Only servers with x86 architecture can be migrated"?.................................. 139
4.5.24 How Do I Fix Error "Failed to start sms agent! 'disks'" When I Start the Agent on a Linux Source
Server?........................................................................................................................................................................................... 139
4.5.25 How Do I Fix Error "SMS.1901, Agent cannot read disk information" When I Start the Agent
Installed on a Windows Source Server?.............................................................................................................................140
4.5.26 How Do I Fix Error "Failed to obtain information about disk X" When I Start the Agent on a Linux
Source Server?............................................................................................................................................................................ 141
4.5.27 How Do I Choose When the System Asks Whether to Disable the Google Services Detected on My
Source Server on the Google Cloud?.................................................................................................................................. 142
4.5.28 How Do I Fix Error "SMS.0410: Failed to obtain NicName/IPAddress information of source server "
When I Start the Agent on a Linux Server?......................................................................................................................143
4.5.29 What Do I Do If the SMS-Agent Fails to Start and Error "SMS.0609 An earlier version of Agent is
detected. Please exit the old Agent, uninstall the old Agent completely, and install the latest version" Is
Displayed?.................................................................................................................................................................................... 145
4.5.30 How Do I Fix Error "SMS.5103: Agent startup failed." When I Fail to Start the Agent on a Linux
Source Server? Folder /tmp is missing............................................................................................................................... 146
4.5.31 How Do I Fix Error "SMS.1353: Bind mount or repeated mount detected on /xxx of the source
server" When I Fail to Start the Agent on a Linux Source Server?...........................................................................147
4.5.32 How Do I Fix Error "SMS.1352: Unknown physical volumes detected on the source server" When I
Fail to Start the Agent on a Linux Source Server?......................................................................................................... 151
4.5.33 How Do I Fix Error "SMS.1351: Mount point /xxx detected on the source server, which has no free
space. Ensure that there is at least 1 MB of space" When I Fail to Start the Agent on a Linux Source
Server?........................................................................................................................................................................................... 152
4.6 Disk Management.............................................................................................................................................................. 152
4.6.1 Why Was a 40 GB EVS Disk Added to the Target Server During the Migration?.....................................152
4.6.2 Why Can't I Attach the Original System Disk Back to a Target Server?...................................................... 153
4.6.3 How Do I Resolve Error "Disk info in source server has changed, task fail, please delete the task and
then restart the agent"?.......................................................................................................................................................... 153
4.6.4 How Do I Resize Partitions and Disks When I Migrate a Windows Source Server?................................ 154
4.6.5 How Do I Shrink the Disk Partitions on a Source Server Running Windows?...........................................156
4.6.6 How Do I Exclude a Partition from Migration in Windows?............................................................................158
4.6.7 How Do I Fix Error "Failed to modify the configuration files of the target server"?.............................. 159
4.6.8 How Do I Fix Error "Failed to create snapshot"?................................................................................................. 159
4.6.9 How Do I Fix Error "Failed to mount partition xxx to directory xxx"?..........................................................160
4.6.10 How Do I Troubleshoot a Failed Migration or Synchronization of a Partition?......................................161

Server Migration Service
User Guide Contents

2023-04-30 vi



4.6.11 How Do I Fix Error "Failed to create a file on the source server. Cause: /bin/sh: line 0: echo: write
error: No space left on device"?........................................................................................................................................... 162
4.6.12 How Do I Fix Error "Failed to read /etc/fstab on the source server"?........................................................162
4.6.13 How Do I Resolve Error "Insufficient disks on the Target ECS"?..................................................................163
4.6.14 How Do I Resolve Error "SMS.1105 Disk creation failed"?............................................................................ 164
4.6.15 How Do I Resolve Error "Failed to execute df -TH"?....................................................................................... 164
4.6.16 What Are the Requirements on Disks on a Target Server?............................................................................164
4.6.17 How Can I Migrate a Source Server with a Large System Disk?..................................................................165
4.6.18 How Do I Resolve Error "Some disks on the target server are smaller than those on the source
server. Select another target server" When I Configure the Target Server?......................................................... 166
4.6.19 Can SMS Migrate Local Disks on a Source Server?.......................................................................................... 166
4.6.20 Why Can't I Specify Whether to Migrate a Physical Volume When I Resize Disk Partitions in Linux?
......................................................................................................................................................................................................... 167
4.6.21 Why Can't I Specify Whether to Migrate a Logical Volume When I Resize Disk Partitions in Linux?
......................................................................................................................................................................................................... 167
4.6.22 What Are the Rules for Resizing Volume Groups, Disks, and Partitions?................................................. 168
4.6.23 How Do I Migrate a Server with a System Disk Larger Than 1 TB?...........................................................169
4.6.24 How Do I Detach the Temporary System Disk from My Target Server and Re-attach the Original
Disk?............................................................................................................................................................................................... 170
4.6.25 Why Is There Less Data on the Target Server After the Migration Than There Was on the Source
Server?........................................................................................................................................................................................... 171
4.6.26 How Do I Merge Disks During a Linux Migration?...........................................................................................173
4.6.27 How Do I Split a Disk During a Linux Migration?.............................................................................................175
4.7 Migration or Synchronization Failures........................................................................................................................ 177
4.7.1 After the Migration Is Complete, How Do I Replicate Any New Data from the Source Server to the
Target Server?............................................................................................................................................................................. 177
4.7.2 How Do I Fix the Error "The migration module stops abnormally and cannot synchronize data"?. 177
4.7.3 What Do I Do If the SMS-Agent Exits Suddenly and Disconnects a Windows Source Server from the
SMS Console During a Migration?.......................................................................................................................................177
4.8 Target Server Configuration and Launch................................................................................................................... 180
4.8.1 What Are the Differences Between Target and Source Servers After the Migration?............................ 181
4.8.2 How Will the Authentication of a Target Server Change?............................................................................... 183
4.8.3 How Do I Optimize a Windows Target Server After the Migration Is Complete?....................................183
4.8.4 How Do I Fix the Error "SMS.1113 Failed to reconfigure partition details on the target server" When
I Launch the Target Server?................................................................................................................................................... 184
4.8.5 After a Windows Server Was Migrated, Why Is the Used Space of C: Drive Increased?........................184
4.8.6 How Do I Uninstall the SMS-Agent from the Source and Target Servers After the Migration Is
Complete?.................................................................................................................................................................................... 186
4.8.7 Why Is the File System Size Inconsistent Before and After the Migration?................................................186
4.8.8 Why Can't I See Data Disks on a Windows Target Server After Migration?.............................................. 188
4.8.9 Why Can't a Windows Target Server Access the Internet After the Migration?....................................... 190
4.8.10 Why Is the System Recovery Options Window Displayed When the Target Server Is Started?........191
4.8.11 How Do I Expand the Capacity of a Windows System Disk After the Migration?................................ 192
4.8.12 How Do I Fix a GRUB Error Because an XFS Volume Is Mounted to the /boot Partition?................. 195
4.8.13 What Do I Do If a Target Server Fails to Be Created?..................................................................................... 196

Server Migration Service
User Guide Contents

2023-04-30 vii



4.8.14 How Do I Troubleshoot a MySQL Startup Failure on the Target Server After the Migration?..........197
4.8.15 How Do I Resolve Error "SELinux targeted" When I Start a Linux Target Server After the Migration
Is Complete?................................................................................................................................................................................ 197
4.8.16 Why Do the Agent Plug-ins from the Source Cloud Service Provider Exist on the Target Server After
the Migration Is Complete?....................................................................................................................................................198
4.8.17 Why Is the Usable Memory (RAM) Less Than the Total Installed Memory on a Target Server
Running 64-bit Windows?...................................................................................................................................................... 199
4.8.18 How Do I Fix Error "Failed to execute boot loader on the target ECS" When I Launch the Target
Server?........................................................................................................................................................................................... 199
4.8.19 After the Migration Is Complete, Will Deleting the Target Server Configuration or Server Record
Affects the Source or Target Server?.................................................................................................................................. 200
4.8.20 How Do I Fix BSOD Errors When I Start a Windows Target Server After the Migration?.................. 200
4.8.21 How Do I Fix Startup Failures of a Windows Target Server After the Migration?.................................201
4.8.22 If I Change the Password of the Source Server and Perform an Incremental Replication After the
Full Migration Is Complete, Will the New Password Be Synchronized to the Target Server?.........................202

5 Change History.................................................................................................................... 204

Server Migration Service
User Guide Contents

2023-04-30 viii



1 Service Overview

1.1 What Is SMS?
Server Migration Service (SMS) helps you migrate applications and data from x86
physical or virtual servers on premises or in another private cloud or cloud
platform to Elastic Cloud Servers (ECSs) on the cloud platform.

Figure 1-1 How SMS works
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How SMS works
You only need to perform steps 1 and 3, and SMS takes care of the other steps
automatically.

1. Install the Agent on the source server.
2. The Agent registers its connection status with SMS and reports the

information about the source server to SMS. Then, SMS evaluates migration
feasibility.

3. Create a migration task.
4. The Agent receives and executes the migration commands sent by SMS.
5. SMS migrates the system disk of the source server.
6. SMS migrates data disks of the source server.

NO TE

● Source server is a x86 physical server or VM running on-premises or on other cloud that
you want to migrate.

● Target server is the ECS you select when creating the migration task. The target server
takes over the migrated data and applications. During the migration, data on the source
server is transmitted based on the migration policy and overwrites the existing data on
the target server.

● SMS is the SMS service.

1.2 SMS Functions

1.2.1 Migration Feasibility Check
After you install the Agent on a source server and the Agent is authenticated
using the access key ID (AK) and secret access key (SK) of your cloud platform
account, the Agent automatically reports the information about the source server
to SMS. SMS validates the source server information and determines whether the
source server can be migrated. You can view the check results on the Source
Check tab page of the source server.

1.2.2 Migration and Synchronization for Windows
After the source server passes a migration feasibility check, you can start the
migration on the SMS console. When the migration starts, the Agent on the source
server receives migration commands from SMS and executes the migration. During
execution, the Agent validates blocks in the source server disk partitions and
migrates the valid blocks to the corresponding partitions on the target server.
After the migration is complete, the Agent automatically starts a continuous
incremental synchronization. In this stage, as long as it is not during peak hours,
you can stop services running on the source server and cut over the services to the
target server.

1.2.3 Migration and Synchronization for Linux
After the source server passes a migration feasibility check, you can start the
migration on the SMS console. When the migration starts, the Agent on the source
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server receives migration commands from SMS and executes the migration. During
execution, the Agent migrates directories and files from the source server to the
target server. After the migration is complete, the Agent automatically starts a
continuous incremental synchronization. In this stage, as long as it is not during
peak hours, you can stop services running on the source server and cut over the
services to the target server.

1.2.4 Dynamical Secure Transmission Channel
After the Agent on the source server receives the migration commands from SMS,
the Agent dynamically generates a security certificate and secret key and
transmits them to the target server through the OpenStack Metadata service. The
target server then restarts and establishes a secure SSL channel to the source
server using the newly generated certificate.

Figure 1-2 Secure transmission channel

1.3 SMS Advantages
● Ease of use

– You only need to install and configure the Agent on the source server,
configure the target server and start the migration, and launch the target
server when the migration is in the Continuous sync state. SMS takes
care of the remaining works.

– You can start the migration in only three steps: select the source server
and target server, configure server details, and confirm migration
information.

● Seamless migration
You can maintain service running through out the full migration process.
– If you choose not to perform a continuous synchronization after the full

migration, you only need to pause services briefly before the final
synchronization. After the final synchronization is complete, you can start
services on the target server immediately. This minimizes the service
downtime.

– If you choose to perform a continuous synchronization after the full
migration, you only need to stop services temporarily before launching
the target server. This minimizes the service downtime.

● Robust compatibility
– SMS can migrate x86 virtual and physical servers on premises or in many

popular clouds.
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– SMS allows migration of over 90 different operating systems (OS) and
distributions.

● Fast transmission
The migration network utilization reaches above 90%.

● High security
– SMS authenticates the Agent using an AK/SK pair.
– SMS uses a dynamically generated SSL certificate and key pair to encrypt

the transmission channel for data security.

1.4 Related Services

Table 1-1 Related services

Service Interaction Reference

ECS SMS migrates systems,
applications, and data from
source servers to ECSs on the
cloud platform.

How Do I Create
an ECS?

Elastic IP (EIP) SMS allows you to use a
public network for migration.
An EIP must be configured for
your target server.

How Can I
Configure
Network
Security for
SMS?

Virtual Private Cloud (VPC) Before creating a migration
task, you need to configure
the security group of the VPC
where the target server is
located.

How Can I
Configure the
Security Group
Rules for Target
Servers?

Elastic Volume Service
(EVS)

After a migration task is
created and started, SMS will
create a temporary EVS disk
which will be deleted after the
migration is complete.

N/A

 

1.5 Precautions

1.5.1 Constraints
Table 1-2 lists the constraints and limitations on source servers for using SMS.
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Table 1-2 Constraints and limitations on source servers

Item Description

Source server quantity A user can migrate a maximum of 1,000 source
servers concurrently. Delete the migrated servers from
the server list in a timely manner so that other servers
can continue to be migrated.

OS ● The Windows OSs supported by SMS are all listed
in Supported Windows OSs.

● The Linux OSs supported by SMS are all listed in
Supported Linux OSs.

● A server running multiple OSs cannot be migrated.

Available disk space ● Windows:
– At least 320 MB available space on a partition

not smaller than 600 MB
– At least 40 MB available space on a partition

smaller than 600 MB
● Linux: At least 200 MB of available space on the

root partition

File system ● Windows: Only NTFS partitions are supported.
● Linux: Only ext2, ext3, ext4, VFAT, XFS, and Btrfs

file systems are supported.

Shared file system SMS does not support the migration of files from
shared file systems such as NFS or CIFS, or from NAS
devices.

Encrypted file OSs that contain protected folders and encrypted
volumes cannot be migrated.

Servers that run multi-
node databases and
Active Directory
Domain Services (AD
DS)

SMS cannot migrate servers that host active
directories or multi-node databases.

Applications bound to
hardware

SMS does not support the migration of OSs that
contain applications bound to hardware.

Dynamic disk In Windows, dynamic disks are migrated as basic
disks. After the migration is complete, the target
server will not have dynamic disks.

Servers added to a
domain

If you want to migrate a server added to a domain,
after the migration is complete, the target server must
be added to that domain.

External storage of
servers

External storage attached to a source server cannot be
migrated.
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Item Description

Data of database
applications and
domain controller
applications

SMS cannot migrate data of active directories,
database applications, and domain controller
applications.

Servers with system
volumes not on the
first disks

SMS does not support the migration of servers whose
system volumes are not on the first disks.

Thin-provisioning
volumes tagged with
pool in LVM

SMS does not support migration of thin volumes
tagged with pool.

Servers with RAID
arrays

SMS does not support migration of servers with RAID
arrays.

GPU servers SMS does not support the migration of GPU servers.

 

1.5.2 Supported OSs

1.5.2.1 Supported Windows OSs

The following table lists the Windows OSs supported by SMS.

If you want to migrate a source server that runs an OS not supported by SMS, use
any of the following methods:

● Use a public image on the cloud platform to create a server and deploy
source server applications on the target server. With this method, there is no
need for you to migrate source servers.

Table 1-3 Supported Windows OSs

OS Bit UEFI Remarks

Windows Server
2008

64 No Windows Server
2008 and
Windows Server
2008 R2 fail to
boot in UEFI
mode.

Windows Server
2008 R2

64 No

Windows Server
2012

64 Yes N/A

Windows Server
2012 R2

64 Yes

Windows Server
2016

64 Yes
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OS Bit UEFI Remarks

Windows Server
2019

64 Yes

Windows 7 64 No

Windows 8.1 64 No

Windows 10 64 Yes

 

1.5.2.2 Supported Linux OSs
SMS supports file-level migration for Linux.

● Table 1-4 lists the Linux OSs supported by SMS for file-level migration.
If the source server runs an OS that is not supported by SMS, use any of the
following methods:
– Use a public image on the cloud platform to create a server and deploy

source server applications on the target server. With this method, there is
no need for you to migrate source servers.

Table 1-4 Linux OSs supported by file-level migration

OS Version Bit UEFI
Supp
ort

Remarks

Red Hat Red Hat Enterprise Linux 6.0 (Only
KVM servers are supported.)

64 No -

Red Hat Enterprise Linux
6.1/6.2/6.3/6.4/6.5/6.7/6.8/6.9/6.10

64 No

Red Hat Enterprise Linux 7.0 64 No

Red Hat Enterprise Linux
7.1/7.2/7.3/7.4/7.5/7.6/7.7/7.8/7.9

64 Yes

Red Hat Enterprise Linux
8.0/8.1/8.2/8.3/8.4/8.5/8.6

64 Yes

Red Hat Enterprise Linux 9.0 64 Yes

CentOS CentOS 6.0 (Only KVM servers are
supported.)

64 No -

CentOS
6.1/6.2/6.3/6.4/6.5/6.6/6.7/6.8/6.9/6.1
0

64 No

CentOS 7.0 64 No
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OS Version Bit UEFI
Supp
ort

Remarks

CentOS
7.1/7.2/7.3/7.4/7.5/7.6/7.7/7.8/7.9

64 Yes

CentOS 8.0/8.1/8.2/8.3/8.4/8.5 64 Yes

CentOS Stream 8 64 Yes This
distribution
will be
identified as
CentOS 8.0.
This does not
affect the
migration.

CentOS Stream 9 64 Yes This
distribution
will be
identified as
CentOS 9.0.
This does not
affect the
migration.

Oracle Oracle Linux
6.0/6.1/6.2/6.3/6.4/6.5/6.6/6.7/6.8/6.9/
6.10

64 No -

Oracle Linux 7.0 64 No

Oracle Linux
7.1/7.2/7.3/7.4/7.5/7.6/7.7/7.8/7.9

64 Yes

Oracle Linux 8.0/8.1/8.2/8.3/8.4/8.5 64 Yes

SUSE SUSE Linux Enterprise Server 11 SP3 64 No -

SUSE Linux Enterprise Server 11 SP4 64 Yes

SUSE Linux Enterprise Server 12 SP0 64 Yes Btrfs file
systems on
this
distribution
cannot be
migrated.

SUSE Linux Enterprise Server 12
SP1/SP2/SP3/SP4/SP5

64 Yes -

SUSE Linux Enterprise Server 15
SP0/SP1/SP2/SP3

64 Yes

SUSE Linux Enterprise Server 15 SP4 64 No
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OS Version Bit UEFI
Supp
ort

Remarks

Ubuntu Ubuntu Server 12.04 64 No -

Ubuntu Server 14.04 64 Yes

Ubuntu Server 16.04 64 Yes

Ubuntu Server 18.04 64 Yes

Ubuntu Server 19.04 64 Yes

Ubuntu Server 20.04 64 Yes

Ubuntu Server 22.04 64 Yes

Debian Debian GNU/Linux 6.0.10 64 No -

Debian GNU/Linux 7.11.0 64 No

Debian GNU/Linux
8.0/8.1/8.2/8.3/8.4/8.5/8.6/8.7/8.8/8.9/
8.10/8.11

64 No

Debian GNU/Linux
9.0/9.1/9.2/9.3/9.4/9.5/9.6/9.7/9.8/9.9/
9.10/9.11/9.12/9.13

64 No

Debian GNU/Linux
10.0/10.1/10.2/10.3/10.4/10.5/10.6/10.
7/10.8/10.9/10.10/10.11/10.12/10.13

64 Yes

Debian GNU/Linux 11.0/11.1/11.2 64 Yes

Debian GNU/Linux
11.3/11.4/11.5/11.7

64 No

Fedora Fedora
23/24/25/26/27/28/29/33/34/35/36/3
7

64 No -

EulerOS EulerOS 2.2.0 64 No -

EulerOS 2.3.0 64 No

EulerOS 2.5.0 64 No

Amazon
Linux

Amazon Linux 2.0 64 No -

Amazon Linux 2018.3 64 No

Alibaba
Cloud
Linux

Alibaba Cloud Linux 3.2104 64 No -

Alibaba Cloud Linux 3.2104 (Quick
Start)

64 No

Alibaba Cloud Linux 2.1903 LTS 64 No
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OS Version Bit UEFI
Supp
ort

Remarks

Alibaba Cloud Linux 2.1903 LTS
(Quick Start)

64 No

Alibaba Cloud Linux 2.1903 LTS (CCSP
2.0 Level 3)

64 No

Tencent
OS

TencentOS Server 2.4 64 No -

TencentOS Server 2.4 (TK4) 64 No

TencentOS Server 3.1 (TK4) 64 No

Kylin Kylin Linux Advanced Server V10
(Sword)

64 No -

OpenEul
er

OpenEuler 20.03 64 No -

OpenEuler 21.09 64 No

OpenSU
SE

OpenSUSE 15.1/15.2/51.3/15.4 64 No -

Rocky
Linux

Rocky Linux 8.5/8.6/8.7/9.0/9.1 64 No -

 

1.5.3 Disclaimer
● Source server data collection

After the Agent is installed and configured on the source server, it
automatically reports the source server information to SMS for verification.
The collected information is used only for migration feasibility check. To use
SMS, you need to allow SMS to collect source server information.

● License invalidity
After OSs, applications, and files on source servers are migrated to target
servers, the SIDs and MAC addresses of the servers will change. This means
that some OS or application licenses may be invalidated. SMS is not
responsible for this type of issue. You can use the license server on the cloud
platform to obtain new licenses and update or obtain application licenses at
your own expense.

● Target server disk formatting
During a migration, disks on the target server are formatted and re-
partitioned based on the source disk settings. Any existing data on the target
server will be lost. Before the migration, make sure you have backed up any
data on the target server that you need to save and ensure that the disks can
be formatted. SMS is not responsible for any data losses incurred.

● If your target servers on the cloud platform cannot be started after the
migration, the cloud platform can provide technical support to help you solve
the problem, but does not promise that the all possible problems can be
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resolved. There are many possible reasons that a target server may be unable
to start, for example:

– The source server cannot be restarted.

– The source server has non-standard OS configurations.

– The source server has drivers or software that are incompatible with the
cloud platform.

● SMS modifies the system configuration of a target server to make it
compatible with the cloud service platform. SMS can ensure data consistency
before and after the migration but cannot ensure that your services run
properly after the migration. You need to modify related service
configurations.

1.6 Service Agreement
This Service Agreement (hereinafter referred to as "this Agreement") describes
your rights, obligations, and responsibilities during your use of Server Migration
Service (SMS) (hereafter referred to as this Service). Please read the terms
carefully, especially the terms that have a significant impact on your rights
and interests, such as exemption from liability and limitation of liability. Such
terms are in bold in this Statement.

You understand and agree that by using any service in this Agreement, you are
deemed to have read and agree to the General Terms of Service in this Agreement
and the Dedicated Terms of Service for the service you use. This Agreement shall
become legally binding on you. If you do not agree to part or all of the terms of
this Agreement, you shall stop using related services.

1. General Terms of Service

1.1 Contracting Entity: This Agreement is entered into by and between SMS
(or "We") and you (o "User"). Once this agreement takes effect, it has legal
effect between you and us. You acknowledge that you are a natural person,
legal person, or organization that has full capacity for civil conduct and may
independently carry out civil juristic acts. If the foregoing is not true, please
do not use this Service. Otherwise, you shall bear all consequences caused
thereby. In the event that you register on behalf of a company or other legal
entity or use this Service in a manner permitted by the cloud platform, you
represent and warrant that you are an authorized representative of the
company or legal entity to bind such company or legal entity to the terms of
this Agreement.

1.2 Separate Agreement: If you subscribe to this Service offline, purchase this
Service through our partners, or purchase partner products that integrate this
Service, you may sign a separate agreement with us or our partners. You
acknowledge and agree that you will remain bound by the separate
agreement mentioned in this article if you are authorized to access and
use this Service. If this Agreement conflicts with the separate agreement, the
separate agreement shall prevail.

1.3 Agreement Update: This Agreement is subject to change. We will notify
you of any changes to this Agreement by posting a notice on our website or
by other means. You can also visit our website to read the latest service
agreement. If you do not agree to part or all of the latest Agreement,
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please stop using this Service. By continuing to use this Service, you
acknowledge that you are aware of and agree to the latest Agreement.
1.4 Service Maintenance: We may maintain this Service from time to time
through application upgrade, patch installation, or bug fixing. We will
use our reasonable efforts to notify you of such maintenance events
(except for emergency maintenance). You agree to use your best efforts
to comply with any notified cooperation requirements.
1.5 You are committed to being responsible for your end users. If your end
users violate laws and regulations when using services related to this
Agreement, or improperly use the services and cause damages to any third
parties, you will be liable for compensation.
1.6 Disclaimers
1.6.1 You understand and agree that we are not liable for unavailability of
related services in the following situations:

a. Service unavailability or any legal consequences caused by your refusal to
provide relevant information or the information provided not meeting
service requirements

b. Service unavailability due to force majeure
c. Service unavailability due to your reasons or non-cloud platform reasons
d. Service unavailability during regular service maintenance

1.6.2 You understand and agree that before the lifecycle of a specific cloud
service reaches the end of all service activities, we will make our best
commercial efforts to notify you. You need to migrate or upgrade related
workloads within a certain time window based on the notification. If you do
not upgrade the cloud service to the new version, you agree that we have the
right to automatically upgrade it when the right opportunity arises. We shall
not be liable for any potential service outages arising from the upgrade.

2. Dedicated Terms of Service
2.1 Service Content
This Service helps you migrate servers from on-premises environments,
private clouds, or public clouds to the cloud platform.
2.2 Collection and Processing of Your Personal Data
For the entire service process, you understand and agree that the cloud
platform is entitled to collect, use, and process your personal data in
accordance with the Privacy Statement.
2.3 Processing Your Content Data
You understand and agree that SMS is entrusted to collect and use your
server information for the purposes of providing this Service. The information
includes the host names, IP addresses, and MAC addresses of your servers.
SMS provides a controllable data deletion mechanism for you. The
aforementioned information will be deleted when you confirm that your
migration is complete and delete migration tasks on the console of this
Service. Otherwise, deleting the information will cause migration failures.
You understand that the above information is necessary to provide services to
you. If you choose not to provide or authorize us to collect and use of the
above information, we will not be able to provide you with this Service.
You understand and agree that you and/or your end users entrust us to
process your source server information and the data contained in the source
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servers in any format when using SMS. You have full ownership and control
over the data. You are responsible for the legality of the source and
acquisition of such data as well as the legality of migrating it from
source servers to target servers, including but not limited to the
compliance of cross-border data transfer. SMS is entrusted to process your
data in order to migrate source server OSs and disk data to target servers
on the cloud platform.
2.4 Cooperation You Need to Provide
Creating agent images
Security standards iterate and security vulnerabilities develop over time.
Before the migration, you need to create agent images and perform security
scanning and hardening on the images. SMS provides standard agent images
for you to test SMS availability. Do not use them to migrate your services.
Configuring security groups of target servers
SMS requires that traffic from source servers be allowed over specified ports
on target servers. You need to configure security groups of target servers to
allow only access from source servers and take other necessary measures to
ensure migration security.
2.5 Service Pricing
SMS is free of charge, but you are billed at standard rates for the EVS disks,
EVS disk snapshots, and data transfer generated during the migration process.
EVS disk
SMS creates and attaches a 40 GB EVS disk to each target server temporarily
during the migration. These EVS disks are billed on a pay-per-use base. After
the migrations are complete, these EVS disks will be released. Do not delete
these EVS disks during the migration or change their billing modes to yearly/
monthly, or the migrations will fail.
EVS disk snapshot
SMS creates snapshots for service cutover, data synchronization, and cloning
target servers.
Data traffic
Traffic is generated during the migration and is billed as follows:
If the source public IP address is billed by bandwidth and you use the fixed
bandwidth for migration over the Internet, the traffic you used will not be
billed.
If the source public IP address is billed by traffic and you migrate data over
the Internet, the price is calculated by multiplying the unit price of traffic by
the amount of data migrated. For details about the unit price of traffic,
contact the provider of the source public IP address. The amount of data
migrated is the actual usage of disks on source servers.
If you use Direct Connect or Virtual Private Network (VPN) for migration, the
cost depends on the price of your Direct Connect or VPN connections.
2.6 Disclaimer
License invalidity
After OSs, applications, and files on source servers are migrated to target
servers, the SIDs and MAC addresses of the servers will change. This means
that some OS or application licenses may become invalid. SMS is not
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responsible for this type of issue. You can contact the image providers of your
target servers to activate Windows OSs and update or obtain application
licenses at your own expense.
Before a migration is complete, do not perform operations on the OS or
disks of the target server, including but not limited to changing the OS and
reinstalling the OS. SMS is not responsible for any fees or data damage
incurred.
Target server disk formatting
During a migration, disks on the target server are formatted and re-
partitioned based on the source disk settings. Any existing data on the target
server will be lost. Before the migration, make sure you have backed up any
data on the target server that you need to save and ensure that the disks can
be formatted. SMS is not responsible for any data losses incurred.
Migration errors caused by source servers
SMS is not responsible for migration errors caused by source server problems,
including but is not limited to damaged hardware (such as damaged disks or
NICs), improper configurations, or software compatibility issues (such as
incompatible OSs and applications), damaged data files, heavy service traffic,
or slow network speeds. You can fix these problems by yourself, but if any
such problems persist, you can contact us for assistance. We will make every
effort to assist in resolving the problems but does not guarantee all possible
problems can be resolved. The following problems with a source server may
lead to migration errors:
A faulty source server OS. For example, a Windows startup file is damaged or
missing.
An incorrectly configured source server OS. For example, GRUB or fstab is
incorrectly configured on the source server.
Source server network problems. For example, the source server cannot access
the Internet, the network is too slow, or the SSH connection or firewall is
faulty.
Slow I/O on source server disks, too much incremental data, scattered
effective clusters (on Windows), or too many small files (on Linux). These
problems can slow down the migration or synchronization progress.
An incompatible source platform service or software
The Agent may be disabled by a source platform service or software, or the
I/O monitoring could be disabled by antivirus software on the source server.
If your target servers on the cloud platform cannot be started after the
migration, we can provide technical support to help you solve problems. We
do not promise that the problems can be resolved.
To ensure compatibility with the cloud platform, SMS modifies the system
configurations of target servers. SMS can ensure data consistency before and
after the migration but cannot ensure that your services run properly after the
migration. You need to modify related service configurations thereafter.
You are advised not to add data to target servers before the service cutover or
to source servers after the service cutover. If new data is generated on both
your source and target servers after the service cutover, SMS cannot combine
data on the source and target servers. If you want to combine the new data
on the source and target servers, you must design a solution by yourself.
2.7 Other Special Notes
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Log printing
During a migration, SMS prints logs on the source and target servers. After
the migration is complete, SMS automatically deletes the logs on the target
server, and you need to manually delete the logs from the source server. The
logs contain the IP addresses and disk, mounting, and fstab details. Logs on
the source server will not be uploaded to SMS.
Configuration modification
To ensure that target servers can be started properly after the migration is
complete, SMS modifies the boot, network, and system configurations of the
servers.
Cross-border data transfer
SMS is only responsible for point-to-point data migration from source servers
to target servers. It is unaware of the data migrated. If your server data needs
to be migrated across borders, you must ensure the compliance of the
migration.

Last updated on 22 November 2023

1.7 Permissions Management
You can use IMS for free to manage SMS permissions and grant your employees
with different permissions, to ensure secure access to your resources.

With IAM, you can use your account to create IAM users for your employees, and
grant permissions to the users to control their access to specific resources of
various types.

NO TE

For example, you can create IAM users for software developers and assign specific
permissions to allow them to use SMS but disallow them to delete the resources or perform
any high-risk operations.

If your account does not need individual IAM users for permissions management,
skip this section.

SMS Permissions

By default, new IAM users do not have any permissions assigned. To assign
permissions to these new users, you need add them to one or more groups, and
attach permission policies or roles to these groups. Users inherit permissions from
the groups to which they are added and can perform specified operations on cloud
services.

SMS is a global service deployed for all physical regions. SMS permissions are
assigned to users in the Global project, and the users do not need to switch
regions when accessing SMS.

Table 1-5 lists all the system-defined policies and roles of SMS. The cloud
platform services interwork with each other, and some SMS roles are dependent
on the roles of other services. When assigning SMS permissions to users, you need
to also assign dependent roles for the SMS permissions to take effect.
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Table 1-5 Common operations supported by each dependent system-defined
policy or role

Operation SMS
FullAccess
(Global)

OBS
OperateAccess
(OBS)

ECS
FullAccess

VPC
FullAccess

Creating
migration
tasks

√ x √ √

Viewing
migration
progresses

√ x x x

 

IAM supports two types of policies: system-defined policies and custom policies.

● If an IAM user needs all SMS permissions, attach the preceding system-
defined policies to the user group to which the user has been added.

● If an IAM user only needs some SMS permissions, you can create custom
policies and attach these policies to the user group to which the user has
been added.

For details, see Creating a User and Assigning Permissions.

NO TE

Compared with system-defined policies, custom policies provide more fine-grained and
secure permissions control.
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2 Getting Started

2.1 Quick Start
The following figure describes the basic process of using SMS.

Figure 2-1 Process of using SMS

2.2 Preparing for Migration
Before using SMS, make the following preparations:

1. Obtain an AK/SK pair for your target account.
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If you use an IAM user for migration, contact the administrator for
authorization and then create an AK/SK pair. For more information, see How
Do I Create an AK/SK Pair for an IAM User?

2. Ensure that the source server OS is supported by SMS.
See Supported Windows OSs and Supported Linux OSs.

3. Ensure that the following network requirements are met:

a. The source server can connect to the cloud platform API Gateway over
TCP port 443. For more information, see Connecting Source Servers to
the Cloud Platform API Gateway.

b. The source server can connect to the target server. For more information,
see Connecting Source Servers to Target Servers.

▪ To implement migration over the Internet, purchase and configure an
EIP for the target server in advance.

▪ To implement migration using Direct Connect or VPN, purchase and
configure Direct Connect or VPN connections in advance.

c. The required ports are enabled in any security group to which the target
server belongs.

▪ Windows: TCP ports 8899, 8900, and 22

▪ Linux: TCP ports 8900 and 22

For more information, see How Do I Configure Security Group Rules for
Target Servers?

4. Ensure that the following source server requirements are met:
Available Space
– Windows: at least 320 MB of available space on a partition not smaller

than 600 MB; at least 40 MB of available space on a partition smaller
than 600 MB

– Linux: at least 200 MB of available space on the root partition
Source Environment
– The system time of the source server must be consistent with the local

standard time to prevent Agent registration failures.
– For Linux servers, ensure that rsync is installed. You can run the rsync -v

command to check whether rsync is installed.
If it is not installed on the source server, install it as follows:

▪ CentOS: yum -y install rsync

▪ Ubuntu: apt-get -y install rsync

▪ Debian: apt-get -y install rsync

▪ SUSE: zypper install rsync

▪ For other distributions, refer to the official website documentation.

NO TE

rsync usually comes pre-installed on most distributions by default.
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– For Windows servers, install one of the following Agents:

▪ Windows Agent (Python 3): Windows Server 2019/2016/2012 and
Windows 10/8.1

▪ Windows Agent (Python 2): Windows Server 2008 and Windows 7

2.3 Installing the Agent on Source Servers

2.3.1 Windows

Scenarios
You need to install the Agent on each Windows source server that you want to
migrate. During the Agent installation, you need to enter the AK/SK pair of your
target account. After the Agent is started successfully, it automatically reports
source server information to SMS. All collected data is used for migration only. For
more information, see What Information Does SMS Collect About Source
Servers?

There are two options for Windows:

● GUI-based Windows Agent (Python 3): Windows Server 2019/2016/2012 and
Windows 10/8.1

● CLI-based Windows Agent (Python 2): Windows Server 2008 and Windows 7

CA UTION

You must log in to the Windows source server as user Administrator.

Prerequisites
● You have obtained the AK/SK pair of your target account

– If you use an IAM user for migration, see How Do I Create an AK/SK
Pair for an IAM User?

– If you use an account for migration, see How Do I Create an AK/SK Pair
for an Account?

● You have obtained the administrator permissions of the source server.
● You have confirmed that the source server OS is included in Supported

Windows OSs.
● There is no antivirus software installed on the source server. Antivirus

software may prevent the Agent from starting up.
How Do I Fix the Error "Failed to start the I/O monitoring module" When
I Start the Agent?

Downloading the Agent Installation File

Step 1 Log in to the management console.
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Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, choose Agents.

Step 4 In the Windows area, click Agent to download the Agent you need. Please
carefully read the precautions.
● Windows Agent (Python 3)

This GUI-based version is designed for Windows Server 2019/2016/2012 and
Windows 10/8.1.

● Windows Agent (Python 2)
This CLI-based version is designed for Windows Server 2008 and Windows 7.

Step 5 Click SHA256 File in the pane of the Agent you have downloaded. Use the hash
value contained in the downloaded file to verify the integrity of the Agent
installation file. For details, see How Do I Verify the Integrity of the Agent
Installation File?

----End

Installing Windows Agent (Python 3)

Step 1 Transmit the SMS-Agent-Py3.exe file to the source server.

Step 2 Log in to the source server as user Administrator and double-click the SMS-
Agent-Py3.exe file.

Step 3 Click Install and wait for the installation to complete.

Step 4 Click Finish. The SMS-Agent GUI is displayed.

Step 5 Enter the AK/SK pair of the account and the SMS domain name in the region you
are migrating to. You can obtain the SMS domain name on the Agents page of
the SMS console.

Step 6 Click Start.

Step 7 Carefully review the Privacy Statement and click Yes if you want to continue.

When message Upload success. Waiting for the SMS instruction is displayed,
the Agent has started up and started reporting source server information to SMS.

----End

Installing Windows Agent (Python 2)

Step 1 Upload the SMS-Agent-Py2.exe file to the source server.

Step 2 Log in to the source server as user Administrator and double-click the SMS-
Agent-Py2.exe file.

Step 3 Click Install and wait for the installation to complete.

Step 4 Click Finish. The SMS-Agent CLI is displayed.

NO TE

To manually start the Agent when needed, double-click agent-start.exe in the installation
directory C:\SMS-Agent-Py2.
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Step 5 When prompted, enter the AK/SK pair of the cloud account and the SMS domain
name in the region you are migrating to. You can obtain the SMS domain name
on the Agents page of the SMS console.

After the authentication succeeds, the Agent starts to report source server
information to SMS, and the window is closed.

----End

Troubleshooting

How Do I Resolve the Error "AK/SK authentication failed. Ensure that the
system time is consistent with the standard time and the AK and SK are
correct" When I Start the Agent?

2.3.2 Linux

Scenarios

You need to install the Agent on the source server. During the Agent installation,
you need to enter the AK/SK pair of your account. After the Agent is started
successfully, it automatically reports source server information to SMS. All
collected data is used for migration only. For details, see What Information Does
SMS Collect About Source Servers?

Prerequisites
● You have obtained the AK/SK pair of your cloud platform account

– If you use an IAM user for migration, see How Do I Create an AK/SK
Pair for an IAM User?

– If you use an account for migration, see How Do I Create an AK/SK Pair
for an Account?

● You have confirmed that the source server OS is included in Supported Linux
OSs.

Installation

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, choose Agents.

Step 4 Run any of the following commands to download the Agent installation file. You

can also, in the Linux area of the Agents page, click  to copy the command
for downloading the installation file.

wget -t 3 -T 15 https://sms-agent-bucket.obs.ae-ad-1.myhuaweicloud.com/
SMS-Agent.tar.gz

curl -O https://sms-agent-bucket.obs.ae-ad-1.myhuaweicloud.com/SMS-
Agent.tar.gz
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Step 5 Run the command following SHA256 File. Use the hash value contained in the
SHA256 file to verify the integrity of the Agent installation package. For details,
see How Do I Verify the Integrity of the Agent Installation File?

Step 6 On the source server, decompress the installation package.

tar -zxvf SMS-Agent.tar.gz

Step 7 Switch to the SMS-Agent directory on the source server.

cd SMS-Agent

Step 8 Start the Agent.

./startup.sh

Step 9 Carefully review the description of what information will be collected by the
Agent, enter y, and press Enter.

Step 10 Enter the AK/SK pair of the account and the SMS domain name in the region you
are migrating to. You can obtain the SMS domain name on the Agents page of
the SMS console.

When the following information is displayed, the Agent has been started up and
will automatically start reporting source server information to SMS.

----End

Troubleshooting
● How Do I Resolve the Error "No such file or directory: 'rsync':'rsync" When

I Start the Linux Agent?
● How Do I Resolve the Error "AK/SK authentication failed. Ensure that the

system time is consistent with the standard time and the AK and SK are
correct" When I Start the Agent?

2.4 (Optional) Creating a Migration Template
SMS allows you to create migration templates for quick configuration. When you
configure the migration settings, you can use these templates to quickly configure
parameters Network, Migration Rate Limit, Continuous Synchronization
Region, and Project. For details, see Creating a Migration Template.

2.5 (Optional) Creating a Server Template
SMS allows you to create server templates for quick configuration. When you
configure the target server, you can use these templates to quickly configure
parameters such VPC, Subnet, and Security Group. For details, see Creating a
Server Template.
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2.6 Configuring a Target Server

Scenarios
After the Agent installed on a source server is started successfully, a migration
record will be created for the source server on the SMS console. You need to
configure a target server for receiving data migrated from the source server. You
can clone the target server for service testing, and launch the target server after
you verify that your services run properly on the target server.

Prerequisites

The migration is in the  stage and Ready status.

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, click Servers.

Step 4 In the server list, locate the server to be migrated, and click Configure in the
Target column.

After locating the server, you can also choose More > Configure Target in the
Operation column.

Step 5 On the Configure Basic Settings page, configure parameters as prompted.

Table 2-1 Basic settings

Parameter Sub-Parameter Description

Migration
Template

N/A After you select a migration
template, the system automatically
sets Network, Migration Rate
Limit, Migration Method,
Continuous Synchronization,
Partition Resizing, Region, and
Project based on the template. The
system automatically creates a
default migration template for you.
You can also create a migration
template in advance. For details,
see Creating a Migration
Template.

Server Migration Service
User Guide 2 Getting Started

2023-04-30 23



Parameter Sub-Parameter Description

Network Internet An EIP must be bound to the target
server.
Network is set to Internet by
default.

Direct Connect/VPN You need to create a Direct Connect
or VPN connection between the
source server and the VPC subnet
where the target server is located in
advance.
If the source and target servers are
in the same VPC, set Network to
Direct Connect/VPN.

Migration Rate
Limit

N/A You can set the rate limits as
needed based on the bandwidth
size of the source server and service
requirements.
0 indicates that the migration rate
is not limited.

CPU Limit - These options are only available for
Linux migrations. For details, see
How Do I Set Resource Limits for
SMS-Agent During a Linux Server
Migration?

Memory Limit -

Disk Throughput
Limit

-

Migration Method Linux block-level Migration and synchronization are
performed block by block. This
method has high efficiency but
poor compatibility.

Linux file-level Migration and synchronization are
performed file by file. This method
has low efficiency but excellent
compatibility.

Migration Method Windows block-level Migration and synchronization are
performed block by block. For
Windows servers, SMS only
supports block-level migration. This
method has high efficiency.

Continuous
Synchronization

No After the full replication, SMS will
automatically launch the target
server without synchronizing
incremental data. To synchronize
incremental data, click Sync in the
Operation column.
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Parameter Sub-Parameter Description

Yes After the full replication, SMS will
periodically synchronize
incremental data. To complete the
migration, you need to manually
launch the target server.

Partition Resizing No The disk partitions on the target
ECS are the same as those on the
source server.

Yes You can resize the disk partitions on
the target server. For details, see
Resizing disk partitions.

Start Target Upon
Launch

No After the migration is complete, the
target server will automatically
shut down.

Yes After the migration is complete, the
target server will automatically
start.

Advanced Options - ● Advanced options Exclude
Migration Paths, Include Sync
Paths, and Exclude Sync Paths
are available for Linux file-level
migrations. For details, see In a
Linux File-Level Migration,
How Do I Exclude Directories
from Migration and
Synchronization?

● Advanced options Data
Compression and Compression
Threads are available for Linux
file-level migrations. For details,
see How Do I Configure Data
Compression for a Linux Block-
Level Migration?

● For a Windows block-level
migration over a private
network, Transit IP Address is
available.

 

● Resizing disk partitions

1. Click Resize Partition on the right of option Yes. In the displayed Resize
Partition dialog box, resize the disk partitions on the target server as needed.
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NO TE

● You can choose whether to migrate a source partition and resize the corresponding
target partition.

CA UTION

– For the system and boot partitions on a Windows source server, Migration is fixed to
Yes by default.

– For Windows target servers, you can only expand a partition.

– For the system and swap partitions on a Linux source server, Migration is fixed to
Yes by default.

– For Linux Btrfs file systems, Migration is fixed to Yes by default.

– If you set Migration to No for all the logical volumes in the LVM, Migration will be
set to No for the corresponding physical volumes automatically.

– If you set Migration to Yes for at least one of the logical volumes in the LVM,
Migration will also be set to Yes for the corresponding physical volumes
automatically.

– In Linux block-level migration, you can only increase a partition size.

– In Linux file-level migration, you can increase or decrease a partition size. Ensure
that the new partition size is at lease 1 GB larger than the used partition space. If
the current partition size is smaller than the sum of the used partition space plus 1
GB, the disk partition size cannot be decreased.

● If the new partition size is larger than the disk size, click Resize Disk to expand the disk.

● If the new partition size is smaller than the disk size, click Resize Disk to shrink the disk.

2. Click OK.

CA UTION

After you click OK, the setting of Partition Resizing cannot be changed to No. If
you want to restore the original disk partition settings, locate the row that
contains the server to be migrated, click More in the Operation column, and
select Delete from the drop-down list. Then, restart the Agent installed on the
source server, configure the target server again, and set Partition Resizing to No.

Step 6 Click Next: Configure Target in the lower right corner.

Step 7 On the Configure Target page, set parameters as prompted.

Table 2-2 Parameters for configuring a target server

Parameter Sub-Parameter Description

Region N/A ● Select a region where
the target server is to
be provisioned from
the drop-down list.

● Consider your service
requirements.
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Parameter Sub-Parameter Description

Project N/A ● Select a project in the
region from the drop-
down list.

● You can select a
project only after
selecting a region.

Server Use existing Select an existing server
based on the
recommended target
server specifications
above the server list. For
details, see Use existing.

Create during migration Configure VPC, Subnet,
Security Group, and
parameters in Advanced
Settings. For details, see
Create during
migration.

 

● Use existing

A target server must meet requirements listed below. If no existing server
meets the requirements, click Buy Now to create one that meets the
requirements based on the recommended target server specifications.

– A target server running Windows must have at least 2 GB of memory.

– The target server must have at least as many disks as the source server,
and the size of each disk on the target server must be at least as large as
the recommended size.

– The target server must run the same OS as the source server, or there will
be a server name conflict.

– The target server must have been configured with an EIP, VPN, or Direct
Connect connection.

– The security group of the target server must be correctly configured. It
must be configured to allow access on the following ports:

Windows: TCP ports 8899, 8900, and 22

Linux: port 22 for a file-level migration and ports 8900 and 22 for a
block-level migration

For details, see How Do I Configure the Security Group Rules for
Target Servers?

● Create during migration

– If you select Recommended for Server Template, the VPC, subnet, and
security group will be automatically created. You can change the
configurations as needed.
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The server name, AZ, specifications, system disk, data disk and EIP in
advanced settings are automatically configured. You can modify the
configurations as needed.

NO TE

▪ Supported device types for data disks are Virtual Block Device (VBD) and
Small Computer System Interface (SCSI). VBD is the default data disk device
type.

▪ Data disks can be created as shared disks.

– If you select an existing template, the VPC, subnet, security group, AZ,
and disk will be configured based on the template. You can change the
configurations as needed. For details, see Creating a Server Template.

NO TE

If you set Server Template to Recommended, SMS will automatically:

▪ Create a VPC and subnet.
If the source IP address is 192.168.X.X, SMS creates a VPC and a subnet that
both belong to network segment 192.168.0.0/16.
If the source IP address is 172.16.X.X, SMS creates a VPC and a subnet that
both belong to network segment 172.16.0.0/12.
If the source IP address is 10.X.X.X, SMS creates a VPC and a subnet that
both belong to network segment 10.0.0.0/8.

▪ Create a security group and enable ports based on the service requirements:
ports 8899, 8900, and 22 for Windows migration, ports 8900 and 22 for
Linux block-level migration, or port 22 for Linux file-level migration.

Step 8 Click Next: Confirm in the lower right corner.

Step 9 (Optional) Click Save as Server Template. In the displayed Create Server
Template dialog box, enter the template name and click OK to save the target
configuration as a template.

NO TE

Save as Server Template is available only when you set Server Template to
Recommended.

Step 10 After you confirm that the configuration is correct, click Save. In the displayed
dialog box, read the migration conditions and click Yes.

If you want to start the migration immediately, click Save and Start. In the
displayed dialog box, read the migration conditions and click Yes.

NO TE

If  is displayed in the Migration Stage column, the target server has been configured.

----End
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2.7 Starting a Full Replication

Scenarios

A full replication replicates all data from the source server to the target server. The
replication speed depends on the smaller one between the outbound bandwidth
of the source server and the inbound bandwidth of the target server.

Constraints

After the full replication starts, do not restart the source server or Agent, or the
migration will fail.

Prerequisites
● You have configured the target server. For details, see Configuring a Target

Server.

● The Migration Stage is .

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, click Servers.

Step 4 Locate the source server to be migrated and click Start in the Operation column.
In the displayed Start Migration dialog box, click OK to start the full replication.

Alternatively, select the server to be migrated and click Start above the server list.
In the displayed Start Migration dialog box, click OK to start the full replication.

NO TE

During the full replication, the target server is locked by default and you are not allowed to
perform any operations on it. After the migration is complete, the system automatically
unlocks the target server. If you need to perform operations on the target server during the
replication, unlock the target server first. For details, see Unlocking a Target Server.

Step 5 During the migration, you can click  to view the migration progress.

Step 6 Wait for the full replication to complete.

● If you set Continuous Synchronization to No when you configure the
migration settings, the migration enters the Target Launch stage, and the
system launches the target server automatically after the full replication is
complete.

● If you set Continuous Synchronization to Yes, the migration enters the
Continuous sync state after the full replication is complete. You need to
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manually launch the target server. For details, see Launching a Target
Server.

----End

2.8 Launching a Target Server
This section describes how to manually launch the target server after the full
replication is complete if you set Continuous Synchronization to Yes when
configuring the migration settings.

NO TE

If you set Continuous Synchronization to No, skip this section because the system will
automatically launch the target server after the full replication is complete.

Scenarios

You can launch a target server for a migration in the Continuous sync status, and
the continuous synchronization will be interrupted. If continuous synchronization
is required after you launch the target server, click Sync to continuously
synchronize incremental data.

Before launching the target server, you can clone the target server for service
testing, and only launch the target server until tests confirm there are no issues.

NO TE

The cloned server must be in the same AZ as the target server, but can be in a different
VPC.

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, click Servers.

Step 4 Locate the target server you want to launch, and click Launch Target in the
Operation column.

Alternatively, select the server you want to launch, and click Launch Target above
the server list.

Step 5 In the displayed Launch Target dialog box, click OK.

Step 6 Check whether the Status has changed to Finished. If it has, the target server has
been launched and the migration is complete.

----End
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2.9 Synchronizing Incremental Data

Scenarios
After the target server is launched, if there are data changes on your source server,
you can synchronize the incremental data from the source server to the target
server.

NO TE

Only tasks in the Finished status can be synchronized.

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, click Servers.

Step 4 In the server list, locate the source server you want to synchronize and click Sync
in the Operation column.

Step 5 In the displayed Synchronize Incremental Data dialog box, check the
synchronization description carefully and click Yes.

----End
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3 User Guide

3.1 Permissions Management

3.1.1 Creating a User and Assigning Permissions
This section describes how to use IAM to implement fine-grained permissions
control on your SMS resources. With IAM, you can:

● Create IAM users for employees based on the organizational structure of your
enterprise. Each IAM user is assigned their own distinct security credentials for
SMS.

● Assign only the minimum permissions required for users to perform a given
task.

● Entrust a cloud platform account or cloud service to perform professional and
efficient O&M on your SMS resources.

NO TE

A cloud platform account has all permissions required for using SMS by default. If you use
your account to perform migration, skip this section.

Figure 3-1 shows the process for assigning permissions.

Prerequisites
You must learn about the permissions (see Permissions Management) supported
by SMS and choose policies or roles based on your service requirements. You can
also use IAM to assign permissions of the other services.
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Process Flow

Figure 3-1 Process for assigning SMS permissions

Procedure

Step 1 Create a user group and assign permissions to it.
● If the IAM users who will be added to this group need all SMS permissions,

attach the system-defined policies supported by SMS, including SMS
FullAccess, OBS OperateAccess, ECS FullAccess, and VPC FullAccess, to the
group.

● If the IAM users only need specific SMS permissions, create custom policies
and attach these policies to the user group. For details, see SMS Custom
Policies.

NO TE

Compared with system-defined policies, custom policies provide more fine-grained and
secure permissions control.

Step 2 Create an IAM user and add it to the user group.

Create a user on the IAM console and add the user to the group created in Step 1.

Step 3 Log in and verify permissions.

Log in to the management console as the created user, and verify the user's
permissions for SMS.

● Choose Service List > Server Migration Service. In the navigation pane on
the left, click Servers. In the server list, locate the server to be migrated, and
click Configure in the Target column to configure the target server. If the
target server can be configured, the permissions have taken effect.

Server Migration Service
User Guide 3 User Guide

2023-04-30 33



● Choose any other service in the Service List. If a message appears indicating
insufficient permissions to access the service, the permissions have taken
effect.

----End

3.1.2 SMS Custom Policies
You can create custom policies using the visual editor, or with a JSON file.

● Visual editor: Select cloud services, actions, resources, and request conditions.
This does not require knowledge of policy syntax.

● JSON: Edit JSON policies from scratch or based on an existing policy.

The section provides a typical SMS custom policy example.

Example SMS Custom Policy

{
    "Version": "1.1",
    "Statement": [
        {
            "Action": [
                "vpc:securityGroups:create",
                "vpc:securityGroupRules:create",
                "vpc:vpcs:create",
                "vpc:publicIps:create",
                "vpc:subnets:create",
                "ecs:cloudServers:create",
                "ecs:cloudServers:attach",
                "ecs:cloudServers:detachVolume",
                "ecs:cloudServers:start",
                "ecs:cloudServers:stop",
                "ecs:cloudServers:delete",
                "ecs:cloudServers:reboot",
                "ecs:cloudServers:updateMetadata",
                "ecs:serverPasswords:manage",
                "ecs:serverKeypairs:delete",
                "ecs:diskConfigs:use",
                "ecs:CloudServers:create",
                "ecs:servers:setMetadata",
                "ecs:serverVolumes:use",
                "ecs:serverKeypairs:create",
                "ecs:serverInterfaces:use",
                "ecs:serverGroups:manage",
                "ecs:securityGroups:use",
                "ecs:servers:unlock",
                "ecs:servers:rebuild",
                "ecs:servers:lock",
                "ecs:servers:reboot",
                "evs:volumes:use",
                "evs:volumes:create",
                "evs:volumes:update",
                "evs:volumes:delete",
                "evs:volumes:attach",
                "evs:volumes:detach",
                "evs:snapshots:create",
                "evs:snapshots:delete",
                "evs:snapshots:rollback",
                "ecs:*:get*",
                "ecs:*:list*",
                "evs:*:get*",
                "evs:*:list*",
                "vpc:*:list*",
                "vpc:*:get*",
                "ims:*:get*",

Server Migration Service
User Guide 3 User Guide

2023-04-30 34



                "ims:*:list*"
            ],
            "Effect": "Allow"
        }
    ]
}

For details about policies supported by SMS, see Table 3-1.

Table 3-1 Policy description

Policy Permission Description

sms:server:queryServer Read-only permission for viewing
source servers

sms:server:registerServer Read/write permission for registering
source servers

sms:server:migrationServer Read/write permission for migrating
source servers

 

3.2 Server Management

3.2.1 Configuring a Target Server

Scenarios

After the Agent installed on a source server is started successfully, a migration
record will be created for the source server on the SMS console. You need to
configure a target server for receiving data migrated from the source server. You
can clone the target server for service testing, and launch the target server after
you verify that your services run properly on the target server.

Prerequisites

The migration is in the  stage and Ready status.

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, click Servers.

Step 4 In the server list, locate the server to be migrated, and click Configure in the
Target column.

After locating the server, you can also choose More > Configure Target in the
Operation column.
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Step 5 On the Configure Basic Settings page, configure parameters as prompted.

Table 3-2 Basic settings

Parameter Sub-Parameter Description

Migration
Template

N/A After you select a migration
template, the system automatically
sets Network, Migration Rate
Limit, Migration Method,
Continuous Synchronization,
Partition Resizing, Region, and
Project based on the template. The
system automatically creates a
default migration template for you.
You can also create a migration
template in advance. For details,
see Creating a Migration
Template.

Network Internet An EIP must be bound to the target
server.
Network is set to Internet by
default.

Direct Connect/VPN You need to create a Direct Connect
or VPN connection between the
source server and the VPC subnet
where the target server is located in
advance.
If the source and target servers are
in the same VPC, set Network to
Direct Connect/VPN.

Migration Rate
Limit

N/A You can set the rate limits as
needed based on the bandwidth
size of the source server and service
requirements.
0 indicates that the migration rate
is not limited.

CPU Limit - These options are only available for
Linux migrations. For details, see
How Do I Set Resource Limits for
SMS-Agent During a Linux Server
Migration?

Memory Limit -

Disk Throughput
Limit

-

Migration Method Linux block-level Migration and synchronization are
performed block by block. This
method has high efficiency but
poor compatibility.
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Parameter Sub-Parameter Description

Linux file-level Migration and synchronization are
performed file by file. This method
has low efficiency but excellent
compatibility.

Migration Method Windows block-level Migration and synchronization are
performed block by block. For
Windows servers, SMS only
supports block-level migration. This
method has high efficiency.

Continuous
Synchronization

No After the full replication, SMS will
automatically launch the target
server without synchronizing
incremental data. To synchronize
incremental data, click Sync in the
Operation column.

Yes After the full replication, SMS will
periodically synchronize
incremental data. To complete the
migration, you need to manually
launch the target server.

Partition Resizing No The disk partitions on the target
ECS are the same as those on the
source server.

Yes You can resize the disk partitions on
the target server. For details, see
Resizing disk partitions.

Start Target Upon
Launch

No After the migration is complete, the
target server will automatically
shut down.

Yes After the migration is complete, the
target server will automatically
start.
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Parameter Sub-Parameter Description

Advanced Options - ● Advanced options Exclude
Migration Paths, Include Sync
Paths, and Exclude Sync Paths
are available for Linux file-level
migrations. For details, see In a
Linux File-Level Migration,
How Do I Exclude Directories
from Migration and
Synchronization?

● Advanced options Data
Compression and Compression
Threads are available for Linux
file-level migrations. For details,
see How Do I Configure Data
Compression for a Linux Block-
Level Migration?

● For a Windows block-level
migration over a private
network, Transit IP Address is
available.

 

● Resizing disk partitions

1. Click Resize Partition on the right of option Yes. In the displayed Resize
Partition dialog box, resize the disk partitions on the target server as needed.
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NO TE

● You can choose whether to migrate a source partition and resize the corresponding
target partition.

CA UTION

– For the system and boot partitions on a Windows source server, Migration is fixed to
Yes by default.

– For Windows target servers, you can only expand a partition.

– For the system and swap partitions on a Linux source server, Migration is fixed to
Yes by default.

– For Linux Btrfs file systems, Migration is fixed to Yes by default.

– If you set Migration to No for all the logical volumes in the LVM, Migration will be
set to No for the corresponding physical volumes automatically.

– If you set Migration to Yes for at least one of the logical volumes in the LVM,
Migration will also be set to Yes for the corresponding physical volumes
automatically.

– In Linux block-level migration, you can only increase a partition size.

– In Linux file-level migration, you can increase or decrease a partition size. Ensure
that the new partition size is at lease 1 GB larger than the used partition space. If
the current partition size is smaller than the sum of the used partition space plus 1
GB, the disk partition size cannot be decreased.

● If the new partition size is larger than the disk size, click Resize Disk to expand the disk.

● If the new partition size is smaller than the disk size, click Resize Disk to shrink the disk.

2. Click OK.

CA UTION

After you click OK, the setting of Partition Resizing cannot be changed to No. If
you want to restore the original disk partition settings, locate the row that
contains the server to be migrated, click More in the Operation column, and
select Delete from the drop-down list. Then, restart the Agent installed on the
source server, configure the target server again, and set Partition Resizing to No.

Step 6 Click Next: Configure Target in the lower right corner.

Step 7 On the Configure Target page, set parameters as prompted.

Table 3-3 Parameters for configuring a target server

Parameter Sub-Parameter Description

Region N/A ● Select a region where
the target server is to
be provisioned from
the drop-down list.

● Consider your service
requirements.
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Parameter Sub-Parameter Description

Project N/A ● Select a project in the
region from the drop-
down list.

● You can select a
project only after
selecting a region.

Server Use existing Select an existing server
based on the
recommended target
server specifications
above the server list. For
details, see Use existing.

Create during migration Configure VPC, Subnet,
Security Group, and
parameters in Advanced
Settings. For details, see
Create during
migration.

 

● Use existing

A target server must meet requirements listed below. If no existing server
meets the requirements, click Buy Now to create one that meets the
requirements based on the recommended target server specifications.

– A target server running Windows must have at least 2 GB of memory.

– The target server must have at least as many disks as the source server,
and the size of each disk on the target server must be at least as large as
the recommended size.

– The target server must run the same OS as the source server, or there will
be a server name conflict.

– The target server must have been configured with an EIP, VPN, or Direct
Connect connection.

– The security group of the target server must be correctly configured. It
must be configured to allow access on the following ports:

Windows: TCP ports 8899, 8900, and 22

Linux: port 22 for a file-level migration and ports 8900 and 22 for a
block-level migration

For details, see How Do I Configure the Security Group Rules for
Target Servers?

● Create during migration

– If you select Recommended for Server Template, the VPC, subnet, and
security group will be automatically created. You can change the
configurations as needed.
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The server name, AZ, specifications, system disk, data disk and EIP in
advanced settings are automatically configured. You can modify the
configurations as needed.

NO TE

▪ Supported device types for data disks are Virtual Block Device (VBD) and
Small Computer System Interface (SCSI). VBD is the default data disk device
type.

▪ Data disks can be created as shared disks.

– If you select an existing template, the VPC, subnet, security group, AZ,
and disk will be configured based on the template. You can change the
configurations as needed. For details, see Creating a Server Template.

NO TE

If you set Server Template to Recommended, SMS will automatically:

▪ Create a VPC and subnet.
If the source IP address is 192.168.X.X, SMS creates a VPC and a subnet that
both belong to network segment 192.168.0.0/16.
If the source IP address is 172.16.X.X, SMS creates a VPC and a subnet that
both belong to network segment 172.16.0.0/12.
If the source IP address is 10.X.X.X, SMS creates a VPC and a subnet that
both belong to network segment 10.0.0.0/8.

▪ Create a security group and enable ports based on the service requirements:
ports 8899, 8900, and 22 for Windows migration, ports 8900 and 22 for
Linux block-level migration, or port 22 for Linux file-level migration.

Step 8 Click Next: Confirm in the lower right corner.

Step 9 (Optional) Click Save as Server Template. In the displayed Create Server
Template dialog box, enter the template name and click OK to save the target
configuration as a template.

NO TE

Save as Server Template is available only when you set Server Template to
Recommended.

Step 10 After you confirm that the configuration is correct, click Save. In the displayed
dialog box, read the migration conditions and click Yes.

If you want to start the migration immediately, click Save and Start. In the
displayed dialog box, read the migration conditions and click Yes.

NO TE

If  is displayed in the Migration Stage column, the target server has been configured.

----End
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3.2.2 Starting a Full Replication

Scenarios
A full replication replicates all data from the source server to the target server. The
replication speed depends on the outbound bandwidth of the source server and
the inbound bandwidth of the destination server, whichever is smaller.

Constraints
After the full replication starts, do not restart the source server or Agent, or the
migration will fail.

Prerequisites
● You have configured the target server. For details, see Configuring a Target

Server.

● The Migration Stage is .

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, click Servers.

Step 4 Locate the source server to be migrated and click Start in the Operation column.
In the displayed Start Migration dialog box, click OK to start the full replication.

Alternatively, select the server to be migrated and click Start above the server list.
In the displayed Start Migration dialog box, click OK to start the full replication.

NO TE

During the full replication, the target server is locked by default and you are not allowed to
perform any operations on it. After the migration is complete, the system automatically
unlocks the target server. If you need to perform operations on the target server during the
replication, unlock the target server first. For details, see Unlocking a Target Server.

Step 5 During the migration, you can click  to view the migration progress.

Step 6 Wait for the full replication to complete.
● If you set Continuous Synchronization to No when you configure the

migration settings, the migration enters the Target Launch stage after the
full replication is complete, and the system launches the target server.

● If you set Continuous Synchronization to Yes, the migration enters the
Continuous sync stage after the full replication is complete, and the system
synchronizes incremental source data to the target server. You need to
manually launch the target server. For details, see Launching a Target
Server.

----End
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3.2.3 (Optional) Cloning a Target Server

Scenarios
Before launching the target server, you can clone the target server for service
testing, and only launch the target server until tests confirm there are no issues.

NO TE

The cloned server must be in the same AZ as the target server, but can be in a different
VPC.

Prerequisites

The migration is in the  stage and Continuous sync status.

Procedure
Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, click Servers.

Step 4 Locate the target server you want to clone, click More in the Operation column,
and select Clone Target.

Step 5 Set the parameters and click Clone Target.
● If you set Recommended for Server Template, the system automatically sets

VPC, Subnet, Security Group, and parameters in Advanced Settings based
on the current target server configuration. You can also manually modify
these parameters.

● If you select an existing template for Server Template, parameters VPC,
Subnet, Security Group, and those in Advanced Settings are set based on
the template. You can also manually modify these parameters.

Step 6 Check whether the name of the cloned server is displayed in the server details. If it
is, the cloning is complete.

----End

3.2.4 Launching a Target Server
This section describes how to manually launch the target server after the full
replication is complete if you set Continuous Synchronization to Yes when
configuring the migration settings.

NO TE

If you set Continuous Synchronization to No, skip this section because the system will
automatically launch the target server after the full replication is complete.

Scenarios
You can launch a target server for a migration in the Continuous sync status, and
the continuous synchronization will be interrupted. If continuous synchronization
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is required after you launch the target server, click Sync to continuously
synchronize incremental data.

Before launching the target server, you can clone the target server for service
testing, and only launch the target server until tests confirm there are no issues.

NO TE

The cloned server must be in the same AZ as the target server, but can be in a different
VPC.

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, click Servers.

Step 4 Locate the target server you want to launch, and click Launch Target in the
Operation column.

Alternatively, select the server you want to launch, and click Launch Target above
the server list.

Step 5 In the displayed Launch Target dialog box, click OK.

Step 6 Check whether the Status has changed to Finished. If it has, the target server has
been launched and the migration is complete.

----End

3.2.5 Viewing a Server Details

Scenarios

After the Agent is installed and started, it automatically reports the source server
information to SMS. All collected data is used for migration only. For details, see
What Information Does SMS Collect About Source Servers? You can log in to
the SMS console to view server information at any time. You can review source
server details, target server configurations, migration status, and error messages.

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, click Servers.

Step 4 Click the name of the server you want to view.

Step 5 On the Basic Information tab page, view the source server details, migration
settings, target server details, and latest task progress. On the Task Tracing tab
page, view the migration tasks and progresses.

----End
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3.2.6 Synchronizing Incremental Data

Scenarios

After the target server is launched, if there are data changes on your source server,
you can synchronize the incremental data from the source server to the target
server.

NO TE

Only tasks in the Finished status can be synchronized.

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, click Servers.

Step 4 In the server list, locate the source server you want to synchronize and click Sync
in the Operation column.

Step 5 In the displayed Synchronize Incremental Data dialog box, check the
synchronization description carefully and click Yes.

----End

3.2.7 Deleting the Target Server Configuration

Scenarios

If a target server is incorrectly configured or its configurations need to be
modified, you can delete the target server configuration and reconfigure the
target server.

CA UTION

Migration tasks will be deleted together with the target configurations. All source
data needs to be migrated again.

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, click Servers.

Step 4 Locate the server for which you want to delete the target server configuration,
and choose More > Delete Target Configuration in the Operation column.
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You can also select the server for which you want to delete the target server
configuration, and choose More > Delete Target Configuration in the upper left
corner of the server list.

Step 5 In the displayed Delete Target Configuration dialog box, click OK.

----End

3.2.8 (Optional) Deleting a Cloned Server

Scenarios
You can delete a cloned server when it is no longer needed or the service test
succeeds.

NO TE

You can switch to the ECS console to check whether the deletion is successful.

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, click Servers.

Step 4 Locate the server for which you want to delete the cloned server, and choose
More > Delete Clone in the Operation column.

Step 5 In the Delete Clone dialog box, click OK.

----End

3.2.9 Deleting a Server

Scenarios
Deleting a server means deleting a server record from SMS. You can delete a
server record as needed.

CA UTION

● After deleting a server record, restart the Agent on the source server if you
want to register the server again with SMS.

● Deleting a server record will not delete the corresponding source or target
server.

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.
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Step 3 In the navigation pane on the left, choose Servers.

Step 4 Locate the server record you want to delete, and choose More > Delete in the
Operation column.

Alternatively, select the target source server and choose More > Delete in the
upper left corner of the server list.

Step 5 In the displayed Delete Server dialog box, click OK.

----End

3.2.10 Setting the Migration Rate

Scenarios

During the migration, a large amount of traffic is generated and bandwidth
consumed. To reduce the impact of the migration on services, you can limit the
migration rate.

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, choose Servers.

Step 4 Locate the server for which you want to set the migration rate, and choose More
> Set Migration Rate in the Operation column.

NO TE

The value of Migration Rate must be an integer from 0 to 1000.

● You can enter 0 or leave this field blank to remove migration speed limits. In this case,
the migration rate is the network rate between the source and target servers.

● If the migration rate you configure is greater than the network rate available between
the two servers, then the actual migration rate will depend on the speed of the network
connection.

Step 5 In the displayed Set Migration Rate dialog box, set migration rate limits and click
OK.

----End

3.2.11 Unlocking a Target Server

Scenarios

During the full replication, the target server is locked by default and you are not
allowed to perform any operations on it. After the migration is complete, the
system automatically unlocks the target server. If you need to perform operations
on the target server during the migration, unlock the target server first.
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Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, choose Servers.

Step 4 Locate the server for which you want to unlock the target server, and choose
More > Unlock Target in the Operation column.

Step 5 In the displayed Unlock Target dialog box, click OK.

----End

3.3 Template Management

3.3.1 Creating a Migration Template

Scenarios

SMS allows you to create migration templates for quick configuration. You can use
these templates to quickly configure the migration settings, such as parameters
Network, Migration Rate Limit, Continuous Synchronization, Region, and
Project.

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, choose Configurations to switch to the desired
page.

Step 4 In the upper right corner of the Migration Templates area, click Create
Migration Template. In the displayed Create Migration Template dialog box,
enter a name and description, and click OK.

NO TE

The template name cannot be changed after the template is created.

Step 5 In the left part of the Migration Templates area, click the name of the created
template.

In the right part of the Migration Templates area, click  next to Parameter
Settings to configure template parameters.

Table 3-4 describes the parameters.

Server Migration Service
User Guide 3 User Guide

2023-04-30 48



Table 3-4 Parameters

Parameter Sub-Parameter Description

Region N/A Select a region based on
service requirements.

Project N/A You can select a project
only after a region is
selected.

Linux Migration Linux block-level Migration and
synchronization are
performed block by
block. This method has
high efficiency but poor
compatibility.

Linux file-level Migration and
synchronization are
performed file by file.
This method has low
efficiency but excellent
compatibility.

Windows Migration Windows block-level Migration and
synchronization are
performed block by
block. For Windows
servers, SMS only
supports block-level
migration. This method
has high efficiency.

Network Internet An EIP must be bound to
the target server.
Network is set to
Internet by default.

Direct Connect/VPN You need to create a
Direct Connect or VPN
connection between the
source server and the
VPC subnet where the
target server is located in
advance.
If the source and target
servers are in the same
VPC, set Network to
Direct Connect/VPN.
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Parameter Sub-Parameter Description

Migration Rate Limit N/A You can set the rate
limits as needed based
on the bandwidth size of
the source server and
service requirements. If
this parameter is set to
0, the migration rate is
not limited.

Continuous
Synchronization

No After the full replication,
SMS will not perform a
continuous
synchronization and
launch the target server
automatically. To
synchronize incremental
data, click Sync in the
Operation column.

Yes After the full replication,
SMS will periodically
synchronize incremental
data. To complete the
migration, you need to
manually launch the
target server.

Server Use existing You need to select an
existing server based on
the recommended target
server specifications
when you configure the
target server.

Create during migration You need to set
parameters such as the
VPC, subnet, and security
group as required when
you configure the target
server.

 

Step 6 Click OK.

Step 7 (Optional) Click the name of the created template, and click Set as Default
Template to set it as the default template.

----End
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3.3.2 Modifying a Migration Template

Scenarios
You can modify a migration template that does not meet your requirements.

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, choose Configurations to switch to the desired
page.

Step 4 In the left part of the Migration Templates area, click the name of the template
you want to modify.

In the right part of the Migration Templates area, click  next to Basic
Information and Parameter Settings to modify the template description and
parameters.

Step 5 Click OK.

----End

3.3.3 Deleting a Migration Template

Scenarios
You can delete a migration template that is no longer needed.

Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, choose Configurations to switch to the desired
page.

Step 4 In the left part of the Migration Templates area, click  next to the name of the
template you want to delete.

Step 5 In the displayed dialog box, click OK.

----End

3.3.4 Creating a Server Template

Scenarios
SMS allows you to create server templates for quick configuration. You can use
these templates to quickly configure target server settings, such as VPC, Subnet,
and Security Group.
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Procedure

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

Step 3 In the navigation pane on the left, choose Configurations to switch to the desired
page.

Step 4 In the upper right corner of the Server Templates area, click Create Server
Template.

Step 5 Enter a template name, click  next to Configuration, and set parameters listed
in Table 3-5.

Table 3-5 Parameters

Parameter Description

Region ● Select a region where the target
server resides from the drop-down
list.

● By default, the region is the one set
in the default migration template,
but you can select another region
you want to use.

Project ● Select a project in the region from
the drop-down list.

● You can select a project only after a
region is selected.

VPC If you select Create during migration,
SMS will recommend a VPC when you
use this template to configure the
target server.
● If the source IP address is

192.168.X.X, SMS will recommend a
VPC and a subnet that both belong
to network segment 192.168.0.0/16.

● If the source IP address is
172.16.X.X, SMS will recommend a
VPC and a subnet that both belong
to network segment 172.16.0.0/12.

● If the source IP address is 10.X.X,
SMS will recommend a VPC and a
subnet that both belong to network
segment 10.0.0.0/8.
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Parameter Description

Subnet ● If you select Create during
migration, SMS will recommend a
subnet when you use this template
to configure the target server.

● The subnet is in the same network
segment as the VPC.

Security Group If you select Create during migration,
SMS will recommend a security group
and allow traffic on required ports
when you use this template to
configure the target server.
● Windows: ports 8899, 8900, and 22
● Linux: port 22 for file-level

migration and ports 8900 and 22
for block-level migration

AZ The parameter is set to Random by
default. You can also select another
AZ.

Data Disk The value can be Common I/O, High
I/O, or Ultra-high I/O.

 

Step 6 Click OK.

----End

Related Operations
You can perform the following operations on a created server template.

Operation Description

Modifying a server template 1. Locate the server template you
want to modify and click Modify in
the Operation column.

2. In the displayed Modify dialog box,
modify the parameters and click
OK.

Deleting a server template 1. Locate the server template you
want to delete and click Delete in
the Operation column.

2. In the displayed Delete dialog box,
click OK.

 

Server Migration Service
User Guide 3 User Guide

2023-04-30 53



3.4 Viewing CTS Traces

3.4.1 SMS Operations Supported by CTS

Table 3-6 Key SMS operations recorded by CTS

Operation Resource Type Event Name

Adding a source sourceServer addSource

Deleting a source sourceServer removeSource

Updating a source name sourceServer updateSourceName

Creating a task addTask addTask

Deleting a task deleteTask deleteTask

Starting a task updateTask task-start

Stopping a task updateTask task-stop

Synchronizing a task updateTask task-sync

Updating the task
progress

updateTaskProgress updateTaskProgress

Saving a template addTemplate addTemplate

Modifying a template updateTemplate update

Deleting a template deleteTemplate deleteTemplate

Deleting templates in
batches

deleteTemplates deleteTemplates

Response results of
operations

TaskCommand processCommandResult

 

3.4.2 Viewing Tracing Logs

Scenarios

CTS starts to record SMS operations immediately after it is provisioned. You can
view the operation records of the last seven days on the CTS console.

Procedure
1. Log in to the management console.
2. Click Service List and choose Management & Deployment > Cloud Trace

Service.
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3. In the navigation pane on the left, choose Trace List
4. In the upper right corner of the trace list, click Filter to set the search criteria.

The following four filter criteria are available:
– Trace Type, Trace Source, Resource Type, and Search By: Select a filter

from the drop-down list.
When you select Resource ID for Search By, you also need to select or
enter a resource ID.

– Operator: Select a specific operator from the drop-down list.
– Trace Status: Available options include All trace statuses, Normal,

Warning, and Incident.
– Time range: In the upper right corner of the page, you can query traces in

the last one hour, last one day, last one week, or within a customized
period.

5. Click Query.
6. On the right of the filter box, click Export. CTS exports a CSV file listing query

results.
7. Click on the left of the required trace to expand its details.
8. Click View Trace in the Operation column. A dialog box is displayed, showing

the trace structure details.
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4 FAQs

4.1 Product Consulting

4.1.1 Can I Migrate Physical Servers and VMs from Other
Clouds to the Cloud Platform Using SMS?

Yes.

SMS makes it easy to migrate physical servers in data centers and VMs on various
popular private and public clouds to ECSs on the cloud platform. In principle, all
x86 servers can be migrated to the cloud platform using SMS.

For details about the supported OSs, see What Source Server OSs Are Supported
by SMS and Are There Any Restrictions on Using SMS?

4.1.2 Can I Migrate ECSs to an On-premises Environment or
Another Cloud Using SMS?

SMS does not support the direct migration of ECSs to on-premises environments
or other clouds.

4.1.3 Can I Ask the Technical Support to Help Me Move
Servers?

We do not directly migrate your services. For how to use SMS to implement
migration, see SMS Documentation.

4.1.4 Can I Migrate Workloads to a DeH, or DeC Using SMS?

DeH

Yes. Before the migration, purchase a DeH. For details, see . When configuring the
target server, select the DeH that you purchased.
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Dedicated Cloud
Yes. Before the migration, purchase a DeC. For details, see . When configuring the
target server, select the enabled DeC.

4.1.5 Does SMS Support Resumable Data Transfer?
Yes. However, the Agent or source server cannot be restarted during a Windows
migration. This is because the address corresponding to the incremental data is
stored in the memory. If the Agent is restarted, incremental synchronization
cannot be performed.

4.1.6 How Do I Migrate an ECS from One Account to Another?
To migrate an ECS from one account to another, perform the following operations:

1. Install the Agent on the ECS under the first account, but when starting the
Agent, enter the AK/SK pair of the destination account. To learn how to install
the Agent, see Installing the Windows Agent or Installing the Linux Agent.

2. Log in to the management console using the destination account, configure
the target server, start the replication, and launch the target server.

NO TE

For details about how to migrate an ECS from one region to another, see How Do I
Migrate an ECS from One Region to Another Using SMS?

4.1.7 How Do I Migrate an ECS from One Region to Another
Using SMS?

Supposed that you want to migrate an ECS from region A to region B. You need to
install the Agent on the ECS in region A. When creating a migration task, select
region B as the target region.

NO TE

For details about migration between accounts, see How Do I Migrate an ECS from One
Account to Another?

4.1.8 Will My Services on the Source Server Be Interrupted
During Migration?

No. The migration consumes the source bandwidth, and has little impact on other
source resources such as CPU and memory.

Before the migration, you are advised to check the source bandwidth usage and
properly allocate bandwidth to the migration process.

4.1.9 How Do I Create an AK/SK Pair for an Account?

Scenarios
An access key comprises an access key ID (AK) and secret access key (SK). It is
used as a long-term identity credential to sign your requests for the cloud
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platform APIs. Like a user name and password, you must use both the AK and SK
together to authenticate your requests. Manage your access keys as securely as
you do your user name and password.

When creating a migration task, you need to enter an AK/SK pair for
authentication. If you use an account for migration, you can create an AK/SK pair
for the account by referring to Access Keys.

CA UTION

During the migration, do not delete the AK/SK pair, or the migration will fail.

4.1.10 How Do I Create an AK/SK Pair for an IAM User?

Scenarios
When creating a migration task, you need to enter an AK/SK pair for
authentication. To safeguard the resources in your account on the cloud platform,
you are advised to create a IAM user in the account, assign permissions to the
user, and create an access key for the user. This section describes how to create an
AK/SK pair for an IAM user.

Procedure

Step 1 Create a user group and assign permissions to it.
● If the IAM users who will be added to this group need all SMS permissions,

attach the system-defined policies supported by SMS, including SMS
FullAccess, OBS OperateAccess, ECS FullAccess, and VPC FullAccess, to the
group.

● If the IAM user only needs specific SMS permissions, create custom policies
and attach these policies to the user group. For details, see SMS Custom
Policies.

NO TE

Compared with system-defined policies, custom policies provide more fine-grained and
secure permissions control.

Step 2 Create an IAM user and add it to the user group.

Create a user on the IAM console and add the user to the group created in 1.

Step 3 Log in to the management console as the IAM user. Create an AK/SK pair by
referring to Access Keys.

----End
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4.1.11 How Do I Migrate a Linux Source Server as a Non-root
User?

Scenarios

If you must use a non-root user account to perform the migration, ensure that the
user has the required permissions before creating a migration task.

Procedure

Step 1 For a hypothetical user, test, check whether the user is included in /etc/passwd. If
it is not, run the following two commands to add the user and set the password:

If it is, confirm that user test has a /home directory. If the user does not have a
home directory, add one.
useradd -m test
passwd test

Step 2 Modify the /etc/sudoers file.

1. Add the following information to the end of the /etc/sudoers file based on
the OS version:
– Debian and Ubuntu

test    ALL=(ALL:ALL)    ALL
test    ALL=(ALL:ALL)   NOPASSWD:ALL

– Other distributions:
test    ALL=(ALL)    ALL
test    ALL=(ALL)   NOPASSWD:ALL

2. If Defaults requiretty is in the /etc/sudoers file, comment out it.

CA UTION

These modifications to the sudoers file enable the user to execute
administrator level commands without entering a password. After the
migration is completed, you need to remove the added lines, or an exception
occurs.

Step 3 After the permissions are configured, switch to a regular account and run the
following command to start the Agent:
sudo ./startup.sh

----End

4.1.12 What Information Does SMS Collect About Source
Servers?

SMS uses the Agent to collect source server details to evaluate the migration
feasibility and provide data required for selecting or configuring target servers.
Table 4-1 lists the data collected from a Windows server. Table 4-2 lists the data
collected from a Linux server. All collected data is used for migration only.
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Table 4-1 Collected Windows server details

Item Sub-Item Usage

Environme
nt
information

OS version Used for migration feasibility checks.
Only source servers with OSs included
in Supported Windows OSs can be
migrated.

Firmware type Used for migration feasibility check.
The source server can be booted from
BIOS or UEFI.

CPU Used for recommending the target
server flavor.

Memory Used for recommending the target
server flavor.

System directory Used for configuring the target server.
After the migration is complete, it will
be used to restore the registry.

Disk partition style Used for configuring the target server.
Before the migration, the disks of the
target server must be formatted to be
the same as those of the source server.

File system Used for migration feasibility check.
Only the NTFS partitions can be
migrated.

Available space Used for migration feasibility check. If
there is not enough space on a source
server partition, the migration may fail.

OEM system check Used for migration feasibility check. If
the system is an OEM system, the OS
needs to be reactivated after the
migration.

Driver files Used for migration feasibility check.
The source server must have basic disk
drivers.

System services Used for migration feasibility check.
Volume Shadow Copy Service (VSS)
must be available on the source server.

User permissions Used for migration feasibility check.
You must have the administrator
permissions to run the Agent.
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Item Sub-Item Usage

Disk
information

● Disk name
● Disk partition style
● Disk size
● Used space

Used for checking whether the disk
specifications of the target server meet
the migration requirements.

 

Table 4-2 Collected Linux server details

Item Sub-Item Usage

Environme
nt
information

OS version Used for migration feasibility checks.
Only source servers with OSs included
in Supported Linux OSs can be
migrated.

CPU Used for recommending the target
server flavor.

Memory Used for recommending the target
server flavor.

Paravirtualization Used for migration feasibility check.
SMS does not support migration of
paravirtualized source servers.

Firmware type Used for migration feasibility check.
The source server can be booted from
BIOS or UEFI.

Boot mode Used for migration feasibility check.
The source server must be booted from
BIOS.

rsync Used for evaluating synchronization
feasibility. SMS synchronization
depends on rsync on the source server.

Raw device Used for migration feasibility check.
The source servers to be migrated
cannot contain raw devices.

Disk partition Used for migration feasibility check.
The source disk partition style must be
Main Boot Record (MBR) or GUID
Partition Table (GPT).

Disk partition style Used for configuring the target server.
Before the migration, the disks of the
target server must be formatted to be
the same as those of the source server.
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Item Sub-Item Usage

File system Used for migration feasibility check.
The file systems on the source server
must be Ext2, Ext3, Ext4, VFAT, XFS, or
Btrfs.

Disk
information

● Disk name
● Disk partition style
● Disk size
● Used space

Used for checking whether the disk
specifications of the target server meet
the requirements.

 

4.1.13 How Do I Select a Target Server?
A target server must meet the requirements described here. If no existing ECSs
meet these requirements, you can create one. For details, see "How Do I Create an
ECS?" in Elastic Cloud Server User Guide.
● A target ECS running Windows must have at least 2 GB of memory.
● A target server must have at least as many disks as the source server, and

each disk on the target server must be at least as large as the paired source
disk.

● A target server must run the same type of OS as the source server. Otherwise,
OS inconsistency may occur.

4.1.14 How Do I Create an ECS?

Scenarios
Source servers can be migrated to the ECSs on the cloud platform. You can create
one or more ECSs as target servers before the migration.

Procedure

Step 1 Log in to the management console.

Step 2 Click  in the upper left corner and select the desired region and project.

Step 3 Click Service List and choose Compute > Elastic Cloud Server.

The Elastic Cloud Server page is displayed.

Step 4 Click Create ECS and configure basic parameters on the displayed page.

For more information, see section "Creating an ECS" in Elastic Cloud Server User
Guide.
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● A target server running Windows must have at least 2 GB of memory.

● A target server must run the same type of OS as the source server.

● A target server must have at least as many disks as the source server, and each disk on
the target server must be at least as large as the paired source disk.

Step 5 Click Apply Now.

After the ECS is created, it will be displayed in the ECS list.

----End

4.1.15 What Is the Block-Level Migration?
In block-level migrations, a block refers to a disk block. A disk block is the
minimum logical unit of the file system for managing disk partitions. Disk blocks
are similar to clusters in Windows. A block is also the minimum logic unit of disks
used by OSs and software. The smallest unit for disk read or write is a sector. A
sector is a physical area on the disk. The read and write operations to disk blocks
are performed in sectors. Generally, a file is stored in several blocks, and one block
maps to several physical sectors.

In block-level migrations, file systems are migrated by blocks. If the network is
interrupted during the migration, only impacted blocks need to be migrated again
after the network recovers. If files are modified during the migration, only
modified blocks need to be synchronized after the migration. In file-level
migrations, various tools like TAR and SSH or other transmission protocols are
used for remote replication. If a file is changed during decompression or the
network is interrupted during migration, the migration will fail. In addition, if a file
is changed during incremental data synchronization, the file needs to be
synchronized again. In this case, all the blocks of the file must be synchronized. So,
the synchronization efficiency is low

4.1.16 What are Valid Data Blocks?
Valid data blocks are blocks that are allocated or used by a file system, for
example, Ext. SMS migrates only valid data blocks. For data blocks that are not
allocated or used and can be allocated by the system, SMS does not migrate them
during migration. This reduces how much data needs to be migrated. The
migration efficiency is improved.

4.1.17 Why Is the OS Name of the Target ECS Displayed on
the ECS Console Different from That of the Source Server?

It is the name of the image used for creating the ECS rather than the ECS OS that
is displayed on the ECS console.

● If you use an existing ECS as the target server, the name of the image used to
create the ECS is displayed on the ECS console.

● If you choose to automatically create an ECS as the target server, the name of
the public image selected by SMS for the ECS is displayed on the ECS console.
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NO TICE

To display the same OS name as the source server on the ECS console, create
an ECS using an image whose name is the same as the source server OS, and
use this ECS as the target server.

4.1.18 How Do I Determine Whether a Migration Task Is
Complete?

If the status of a migration task changes to Finished, the migration task is
complete.

4.1.19 Can I Migrate Only Some Services on the Source
Server?

No. SMS only supports whole server migration. If you want to migrate only the
databases on source servers, Data Replication Service (DRS) can help you.

4.1.20 Can the Target Server Run a Different Type of OS from
the Source Server?

The OS types of target and source servers must be the same, but the OS versions
can be different.

For example, if the source server runs Windows Server 2008, the target server may
run Windows Server 2012; if the source server runs Ubuntu, the target server may
run CentOS.

4.1.21 What Determines the Specifications of a Target Server?
The specifications of a target server are determined by the option you select when
you configure the target server.

● Use existing
If you select this option, the target server will have the same specifications as
the existing server that you choose.

● Create new
If you select this option, the target server will have the specifications that you
configure in the Advanced Settings area.

4.1.22 Which Download Option Should I Choose When I
Download the Windows Agent?

After you log in to the SMS console, and click Agents in the left navigation pane,
you can see two download options in each Windows Agent pane.

● Agent: Download the Agent installation package.
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● SHA256 File: Download the hash value of the Agent installation package,
which is used to verify the integrity of the downloaded package.

4.1.23 How Does SMS Differ from IMS in the Migration
Scenario?

This following describes the differences between SMS and IMS in terms of
application scenarios, migration processes, and service continuity.

Application Scenario
● IMS is used to migrate on-premises servers to the cloud. IMS enables you to

create images for source servers and use the images for migration. The
common application scenarios are: deploying a specified software
environment, batch deploying software environments, and backing up server
running environments.

● SMS is used to migrate x86 physical or virtual servers on premises, private or
public clouds to the cloud platform.

Migration Process
● If you use IMS for migration, you need to create images for source servers and

then use the images to create target servers.
● If you use SMS for migration, you need to install and start the Agent on each

source server and start the migration.

Service Continuity
● If you use IMS for migration, your services need to be stopped for long time

for image creation.
● If you use SMS for migration, your services do not have to go down during

the migration. You only need to pause services briefly for service cutover
before the final synchronization. After the final synchronization is complete,
you can start services on the target server. SMS ensures minimal downtime.

NO TE

Service cutover refers to switching services from the source to the target.

4.1.24 How Do I Display the OS Name of a Target Server on
the ECS Console?

Symptom

On the ECS console, you found that the OS name of your target server was
different from the actual OS name of the server.

NO TE

This is a normal event resulting from a limitation of the ECS console.
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Possible Causes

The ECS console displays the image name of an ECS, not the OS name. The two
names may be different. When you configure the target server:

● If you choose to automatically create an ECS as the target server, an SMS-
defined image name will be displayed for the new ECS on the ECS console,
such as LinuxServer or WindowsServer.

● If you choose to use an existing ECS as the target server, the image name of
the existing ECS is displayed on the ECS console.

Solution

To display the actual OS name of your target server on the ECS console, perform
the following steps:

Step 1 Obtain an image file based on the source server OS.

Step 2 Upload the image file to an OBS bucket.

Step 3 Use the image file to create a private image.

1. Log in to the management console and click Image Management Service
under Compute.

2. On the Image Management Service page, click Create Image.
3. Set Type to Import Image and Image Type to System disk image.
4. Select the image file uploaded to your OBS bucket.
5. Select ECS system disk image for Function and x86 for Architecture. Set

Boot Mode to the actual boot mode of the source server.
You can see the boot mode of the source server on the SMS console. For more
information, see Checking the Firmware Type of a Source Server.

6. Set OS to the source server OS. If the source server OS is not an available
option, select Other from the drop-down list.

7. Set System Disk based on the system disk of the source server. If the source
system disk is smaller than 40 GB, set System Disk to 40 GB.

8. Set Name to the source server OS. The name you specified here will be
displayed on the ECS console.

9. Select an enterprise project for the target server. If no other enterprise
projects are available, select Default.

Step 4 Confirm the configuration details, select I have read and agree to the Statement
of Commitment to Image Creation and Image Disclaimer, and click Next. On
the Resource Details page that is displayed, click Submit. Wait for the image
creation to complete.

Step 5 If you have an ECS suitable as a target server, use this image to change the OS of
the ECS. If you have no suitable ECS available, use this image to create one.

Step 6 When configuring the target server on the SMS console, select the one you
prepared above. For more details, see Configuring the Target Server.

----End
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Checking the Firmware Type of a Source Server

After the Agent is installed and started on the source server, click the source server
name on the Servers page of the SMS console. On the Basic Information tab
page, in the Source Server area, you can view the firmware type of the source
server.

4.1.25 What Are the Snapshots of a Target Server Used for?
SMS creates the following types of snapshots for each target server disk:

● Cutover snapshots: After a migration is complete, SMS creates a snapshot for
each target server disk before the service cutover. These snapshots are used
for rollback if any service faults happen. Old snapshots are deleted and new
snapshots are created automatically whenever the target server is launched
again.

NO TE

It is recommended that these snapshots are deleted after your services are running
smoothly on the target server.

● Synchronization snapshots: For a Windows server migration or Linux block-
level migration, after the source data is migrated and synchronized and before
the target server is launched, SMS creates a snapshot for each target server
disk to ensure data consistency between the source and target.

● Clone snapshot: When you clone a target server, SMS creates a snapshot for
each target server disk. These snapshots are used to clone the target server
and put the migration status back to continuous synchronization after the
clone is complete.

4.1.26 In a Linux File-Level Migration, How Do I Exclude
Directories from Migration and Synchronization?

Scenario

When you migrate a Linux server using the file-level migration method, you can
exclude the files or directories that are no longer needed from the migration. After
the migration is complete, if you need to synchronize only some incremental data
to the target server, you can exclude the files or directories that do not need to be
synchronized from the synchronization.

Procedure

Step 1 Log in to the SMS console.

Step 2 In the navigation pane on the left, choose Servers.

Step 3 In the server list, locate the source server to be migrated, and click Configure in
the Target column.

Step 4 On the Configure Basic Settings tab, select Advanced Options.
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Step 5 Configure Exclude Migration Paths, Exclude Sync Paths, and Include Sync Paths
by referring to the following table. You can configure both directory paths and file
paths, for example, /root/data/path,/data/file.txt.

Table 4-3 Parameter description

Parameter Description Remarks

Exclude
Migration
Paths

Excludes directory paths and file
paths you do not want to
migrate from the full migration.

● Absolute paths are
required.

● SMS does not check
whether the configured
paths exist. Make sure
you have specified
existing, correct paths.

● Use commas (,) to
separate multiple paths.

● The Exclude Migration
Paths settings will
become invalid in
incremental
synchronizations. If you
do not want to
synchronize these
directories or files, add
the absolute paths to
Exclude Sync Paths.

● You can configure
Exclude Sync Paths and
Include Sync Paths at
the same time. Exclude
Sync Paths overrides
Include Sync Paths. If
the same paths are
configured for Exclude
Sync Paths and Include
Sync Paths, Exclude
Sync Paths takes
precedence, and the
configured paths will not
be synchronized.

Include Sync
Paths

Includes absolute paths of the
directories and files you want to
synchronize in incremental
synchronizations. Other paths
will be skipped during
synchronizations.

Exclude Sync
Paths

Excludes absolute paths of the
directories and files not to be
synchronized from incremental
synchronizations. Data in the
excluded paths will not be
synchronized.

 

----End

Related Operations
After you configure the target server or start the migration task, if you want to
change the settings of Exclude Migration Paths and Exclude Sync Paths, pause
the migration task, and choose More > Advanced Options in the Operation
column.
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4.1.27 Will an Incremental Synchronization Overwrite the
Existing Data on a Launched Target Server?

After a target server is launched when the migration is complete, new data will be
written to target server disks as the services run. If you perform an incremental
synchronization, the existing data on the target server disks will be overwritten by
the data in corresponding directories on the source server, except for directories
excluded by the rsync.exclude.dir parameter in the /SMS-Agent/agent/config/g-
property.cfg file and the partitions that are not migrated.

Back up data on the target server before performing incremental synchronizations.

CA UTION

You are not advised to delete the original value of rsync.exclude.dir.

4.1.28 How Do I Create a Target Server that Meets the SMS
Requirements?

When you use SMS to migrate a server, you can prepare a target server on the
cloud platform to receive data from your source server.

SMS supports migration to ECSs, DeHs, and DeCs.

Target Server Environment Requirements
1. A target server must run the same type of OS as the source server. Otherwise,

there will be a server name conflict or other problems.
2. A target server running Windows must have at least 2 GB of memory.
3. A target server must use the same type of firmware as the source server.

Otherwise, the system will warn you the firmware type of the target server is
different from that of the source server, or the firmware type of the source
server is unknown. For details, see How Do I Check the Firmware Type of a
Source Server?
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4. Target Server Disk Requirements

– A target server must have at least as many disks as the source server.
Otherwise, the error "Insufficient disks on the Target Server" will be
reported. In such a case, see How Do I Resolve Error "Some disks on
the target server are smaller than those on the source server. Select
another target server" When I Configure the Target Server?

– Each target server disk must be at least as large as the paired source
server disk, or the migration cannot continue.

In such a case, see How Do I Resolve Error "Some disks on the target
server are smaller than those on the source server. Select another
target server" When I Configure the Target Server?

5. The required ports are enabled in a security group the target server belongs
to.

– Windows: TCP ports 8899, 8900, and 22

– Linux: TCP port 22 for file-level migration, and ports 8900 and 22 for
block-level migration

CA UTION

● For security purposes, these ports are only opened to the source server.

● The firewall of the target server must allow traffic to these ports.

How to Create a Target Server

Method 1: Create a target server before the migration

Create an ECS, DeH, or DeC that meet the requirements in advance.

When you configure the target server on the SMS console, set Server to Use
existing and select the server you created.

Method 2: Create a target server during the migration

When you configure the target server on the SMS console, set Server to Create
during migration.

For details, see Step 7 in Configuring the Target Server.

4.1.29 Can SMS Migrate Self-built Databases, Big Data
Services, or Websites Deployed on a Source Server?

SMS lifts and shifts entire servers. All self-built services deployed on source servers,
such as databases, big data services, and websites, can be migrated.

After the migration is complete, you need to pause these services but do not stop
the source server before performing the final service cutover. Otherwise, the target
server may take a long time to launch, data will be inconsistent between the
source and target servers, or the services may not be started on the target server.
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4.1.30 Can the AK/SK of a Federated User (Virtual IAM User)
Be Used for Authentication During the SMS-Agent Startup?

SMS does not support authentication using AKs/SKs of federated users (virtual
users) during the SMS-Agent startup.

4.1.31 How Do I Synchronize Files in Specific Directories After
a Linux File-Level Migration Is Complete?

After a Linux file-level migration is complete, you can choose which incremental
service data to be synchronized from the source server to the target server. To do
so, see In a Linux File-Level Migration, How Do I Exclude Directories from
Migration and Synchronization?.

4.1.32 Will the Migration Be Affected If the SSH Service Does
Not Use Default Port 22 on the Source Server?

The migration will not be affected, regardless of what OS the source server runs.

4.1.33 How Do I Obtain the SMS Domain Name?

Scenarios
When starting the Agent, you need to enter the SMS domain name of the region
to which you are migrating to obtain the latest configuration files.

Procedure

Step 1 Log in to the management console.

Step 2 In the upper left corner of the page, select the region you are migrating to.

Step 3 Click Service List. Under Migration, click Server Migration Service.

Step 4 In the navigation pane on the left, choose Agents.

Step 5 Obtain the SMS domain name you need.

----End

4.1.34 How Many Resources Will Be Used for a Linux Block-
Level Migration?

Memory Usage (of Data Cache)
There are six data cache nodes configured by the Agent on a source server. The
default size of a single cache node is 4 MB.

● Minimum memory occupied by data cache: 6 x 1 MB = 6 MB
● Default memory occupied by data cache: 6 x 4 MB = 24 MB
● Maximum memory occupied by data cache: 6 x 8 MB = 48 MB
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CPU Usage
The details about the CPU usage during a Linux block-level migration are as
follows.

Number of
CPUs

CPU Usage (%)
Before the Agent
Starts (n)

Default Compression
Threads
Configured by the
Agent

CPU Usage
After the Agent
Starts

1 - 0. Data compression
is disabled by default.

< n + 10%

2 n ≥ 50% 0. Data compression
is disabled by default.

< n + 10%

2 n < 50% 1 < n + 50%

4 n ≥ 75% 0. Data compression
is disabled by default.

< n + 4%

4 50% ≤ = n ≤ 75% 1 < n + 25%

4 25% ≤ n < 50% 2 < n + 50%

4 n < 25% 3 < n + 75%

8 n ≥ 87% 0. Data compression
is disabled by default.

< n + 3%

8 75% ≤ n < 87% 1 < n + 13%

8 62% ≤ n < 75% 2 < n + 25%

8 n < 62% 3 < n + 38%

16 n ≥ 93% 0. Data compression
is disabled by default.

< n + 1%

16 87% ≤ n < 93% 1 < n + 6%

16 82% ≤ n < 87% 2 < n + 13%

16 n < 82% 3 < n + 17%

≥ 32 - 3 < n + 10%

 

● If data compression is enabled, the formula for calculating the CPU usage
after the Agent starts is as follows:
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in which, c indicates the number of CPUs, p indicates the number of
compression threads, and n indicates the CPU usage before the Agent starts.

● If data compression is disabled, the Agent occupies less than 10% of memory.
The formula for calculating the CPU usage is as follows:

By default, data compression is enabled for Linux block migrations. To disable
this function, see How Do I Disable Data Compression When the CPU
Usage Is Too High During a Linux Block-level Migration?

4.1.35 How Do I Disable Data Compression When the CPU
Usage Is Too High During a Linux Block-Level Migration?

By default, data compression is enabled for Linux block-level migrations. The
number of compression threads is configured based on the resource usage of the
source server. The default value is the number of idle CPUs, and the maximum
value is 3. Data compression may cause high CPU usage. In this case, you can
disable this function in the SMS-Agent/agent/config/g-property.cfg file.

Go to the SMS-Agent installation directory and run the following command:

cd ./agent/config && vi g-property.cfg

Configure the following parameters.

● block.compress.thread.num: The number of compression threads. The value
must be an integer ranging from 1 to 3. Generally, the value is automatically
set by the Agent based on the source server conditions. You can change it
manually.

● block.node.cache.size.MB: The size of a single data cache node. There are six
cache nodes configured on the source server by the Agent. The value must be
an integer ranging from 1 to 8. The default value is 4.

● block.need.compress: controls whether to compress data during
transmission. The value can be True or False. If you do not want to compress
data during transmission, set this parameter to False.
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CA UTION

Data compression occupies a large amount of CPU resources. When you configure
this function, you need to consider the actual resource usage of the source server
to prevent services on it from being affected. For details about the default
resource usage, see Resource Usage Description for Linux Block-Level
Migrations.

4.1.36 Do I Need to Activate My Windows OS and Paid
Software After the Migration?

SMS migrates an entire server. After you use SMS to migrate a source server
running Windows, you need to activate Windows and other paid software on the
target server. SMS cannot help you activate Windows and other paid software. You
need to contact the Windows OS provider and software providers to activate
them.

4.1.37 How Do I Set the Number of Concurrent Processes for
Linux File-Level Migrations?

Overview

You can set the maximum number of processes that the SMS-Agent can start
concurrently (1 to 4) when migrating and synchronizing files of a Linux source
server. However, the number of processes that can actually be started depends on
how well the source server performs and how many disks and partitions the
source server has.

CA UTION

● Enabling concurrency consumes source server resources, especially disk I/O,
bandwidth, and CPU resources. To prevent the services on the source server
from being affected, before enabling this function, you can evaluate the
impacts on source services or How Do I Set Resource Limits for SMS-Agent
During a Linux Server Migration?.

● If the migration bandwidth from the source server to the target server is less
than 300 Mbit/s, you are not advised to enable this function.

Calculating the Maximum Number of Concurrent Processes

The formula is:

Max. concurrent processes = Min. (Disks, Bandwidth/Disk I/O performance, 4)

where

Disks is the number of disks to be migrated on the source server.

Server Migration Service
User Guide 4 FAQs

2023-04-30 74



Network bandwidth is the network bandwidth between the source server and
the target server. You can calculate the bandwidth by referring to How Do I Test
the Network Between the Source and Target Servers Using iPerf?

Disk read or write performance is either the average disk read performance of
the source server or the average disk write performance of the target server,
whichever is smaller.

Assume that the migration involves four disks, the network bandwidth is 1,000
Mbit/s, the average read performance of the source server is 500 Mbit/s, the
average write performance of the target server is 300 Mbit/s. In this example, we
need to divide the network bandwidth by the average write performance of the
target server (1,000 Mbit/s / 300 Mbit/s ≈ 3). That makes the three values for the
formula, respectively, 4, 3 and 4, which means there can be 3 concurrent processes
for this migration.

Setting the Maximum Number of Concurrent Processes
On the Configure Basic Settings page, set Migration Method to Linux file-level
and Enable Concurrency to Yes, and specify Max. Concurrent Migrations and
Max. Concurrent Syncs.

4.1.38 Which Directories Are Not Synchronized by Default
During Incremental Synchronization on a Linux Server?

When incremental data synchronization is performed after full replication is
complete on a Linux server, data will not be synchronized for the following
directories related to host configurations:

/proc/*,
/sys/*,
/lost+found/*,
/tmp/_MEI*,
/var/lib/ntp/proc/*,
/boot/*,
/boot/efi/*,
/etc/fstab,
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/etc/*,
/etc/X11/*,
/root/initrd_bak/*,
/lib/modules/*,
/boot/grub2/x86_64-efi/*,
/boot/grub2/i386-pc/*

Reasons

After the first full migration of a Linux server, some parameter settings in the
preceding directories on the target server are modified to make the target server
compatible with the cloud platform and ensure that the target server can start
properly. During incremental synchronization, to ensure that the parameter
settings in these directories on the target server are not overwritten or modified
by the source data, the data in these directories on the source server is not
synchronized by default.

Important Notes

If there is service data in the preceding directories, you need to manually
synchronize the incremental service data to the target server.

4.1.39 How Do I Verify Data Consistency Between the Source
and Target Servers?

SMS consistency verification allows you to verify data consistency before and after
the migration. You can enable this function when you start an incremental
synchronization.

Precautions
● Before enabling this function, you are advised to stop services (and databases

if any) on the source server. If they are not stopped, data on the source server
keeps changing, which will affect the consistency.

NO TE

It is normal for some directories on the source and target servers to have slight
differences. For instance, there are directories on the source server where data is
always changing, such as the directory where SMS-Agent was installed and
the /var/log directory where stores system logs.

● The time required for consistency verification depends on the number and size
of files to be verified. If consistency verification takes a long time during the
final incremental synchronization, the time required for service cutover will
also increase. Evaluate the impact on your services.

● Consistency verification occupies significant source disk I/O resources.
Evaluate the potential impacts on your source services.

Constraints
● Consistency verification does not apply to migration scenarios where disks or

partitions are adjusted. In this case, directories and paths on the source and
target servers are not perfectly mapped to each other.

● It is not applicable to verification of cross-file system files or shared folders.
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● To ensure your services can run normally on the source server, a maximum of
100,000 files can be verified in a single directory.

● To prevent excessive memory usage, only files whose paths do not exceed
1024 bytes are verified.

Enabling Consistency Verification

Step 1 Open the Sync Incremental Data dialog box by referring to section
Synchronizing Incremental Data.

Step 2 Enable Verify Consistency and correctly enter the directories for which data
consistency is to be verified. If the entered directories are incorrect or empty, 0 will
be displayed for these directories in the verification results.

NO TICE

● The larger the amount of data to be verified, the longer the consistency
verification goes on. You are advised to verify only key directories.

● The following directories will be excluded from consistency verification by
default:

– /, /etc, /dev, /sys, /usr, /boot, and /run in Linux

– Root directories of partitions in Windows, for example, C:\ and D:\.

Step 3 Select a verification method.

● Quick verification: compares the file size and last modification time.
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● CRC verification: compares CRC64 checksums. This method scans file content
in binary mode, which occupies a large amount of disk I/O resources and
takes a long time but is more accurate.

Step 4 (Optional) Enable Verify Inconsistencies to verify files that were verified to be
inconsistent in the previous verification. This option can only be enabled after at
least one consistency verification is complete.

Step 5 Click Yes to synchronize incremental data and verify consistency. After the
synchronization and verification are complete, you can view the verification results
by referring to Viewing Verification Results.

----End

Disabling Consistency Verification

If you want to disable consistency verification after the incremental
synchronization starts, perform the following steps:

Step 1 Choose More > Pause in the Operation column to pause the synchronization
task.

Step 2 Click Start in the Operation column.

Step 3 In the displayed dialog box, disable Verify Consistency and click Yes.

----End

Viewing Verification Results

To view the data consistency verification results, choose More > View Verification
Results in the Operation column.

If 0 is displayed in the Files Verified column, it means the specified directory could
not be found or is empty.

All files verified to be inconsistent are recorded in the log file sms_cmp_result.log
in the SMS-Agent installation directory (*/SmsAgent/agent/Logs/ on Linux and
C://SMS-Agent-Py*/Logs on Windows) on the source server.
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Verification Time Estimation

The following table lists the verification time tested on servers where only the
migration process runs but is for reference only.

OS Specificati
ons

Disk
Performanc
e

Verification Time (per 100 GB)

Windows 2 vCPUs
and 4 GB
of memory

5,000
IOPS/150
MB/s

About 17 minutes

Linux 2 vCPUs
and 4 GB
of memory

5,000
IOPS/150
MB/s

About 13 minutes

 

4.2 OS Compatibility and Migration Restrictions

4.2.1 What Source Server OSs Are Supported by SMS and Are
There Any Restrictions on Using SMS?

For details about the source server OSs supported by SMS, see Supported
Windows OSs, Table 4-5.

If you need to migrate a source server whose OS is not supported by SMS, use any
of the following methods:

● Use Image Management Service (IMS) to create an image for the source
system disk from an external image file.

● Use a public image from IMS to create ECSs and deploy server applications on
the newly created ECSs. With this method, there is actually no server
migration involved.

Supported Source Server OSs

Table 4-4 Supported Windows OSs

OS Bit UEFI Remarks

Windows Server
2008

64 No Windows Server
2008 and
Windows Server
2008 R2 fail to
boot in UEFI
mode.

Windows Server
2008 R2

64 No

Windows Server
2012

64 Yes N/A
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OS Bit UEFI Remarks

Windows Server
2012 R2

64 Yes

Windows Server
2016

64 Yes

Windows Server
2019

64 Yes

Windows 7 64 No

Windows 8.1 64 No

Windows 10 64 Yes

 

Table 4-5 Linux OSs supported by file-level migration

OS Version Bit UEFI
Supp
ort

Remarks

Red Hat Red Hat Enterprise Linux 6.0 (Only
KVM servers are supported.)

64 No -

Red Hat Enterprise Linux
6.1/6.2/6.3/6.4/6.5/6.7/6.8/6.9/6.10

64 No

Red Hat Enterprise Linux 7.0 64 No

Red Hat Enterprise Linux
7.1/7.2/7.3/7.4/7.5/7.6/7.7/7.8/7.9

64 Yes

Red Hat Enterprise Linux
8.0/8.1/8.2/8.3/8.4/8.5/8.6

64 Yes

Red Hat Enterprise Linux 9.0 64 Yes

CentOS CentOS 6.0 (Only KVM servers are
supported.)

64 No -

CentOS
6.1/6.2/6.3/6.4/6.5/6.6/6.7/6.8/6.9/6.1
0

64 No

CentOS 7.0 64 No

CentOS
7.1/7.2/7.3/7.4/7.5/7.6/7.7/7.8/7.9

64 Yes

CentOS 8.0/8.1/8.2/8.3/8.4/8.5 64 Yes
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OS Version Bit UEFI
Supp
ort

Remarks

CentOS Stream 8 64 Yes This
distribution
will be
identified as
CentOS 8.0.
This does not
affect the
migration.

CentOS Stream 9 64 Yes This
distribution
will be
identified as
CentOS 9.0.
This does not
affect the
migration.

Oracle Oracle Linux
6.0/6.1/6.2/6.3/6.4/6.5/6.6/6.7/6.8/6.9/
6.10

64 No -

Oracle Linux 7.0 64 No

Oracle Linux
7.1/7.2/7.3/7.4/7.5/7.6/7.7/7.8/7.9

64 Yes

Oracle Linux 8.0/8.1/8.2/8.3/8.4/8.5 64 Yes

SUSE SUSE Linux Enterprise Server 11 SP3 64 No -

SUSE Linux Enterprise Server 11 SP4 64 Yes

SUSE Linux Enterprise Server 12 SP0 64 Yes Btrfs file
systems on
this
distribution
cannot be
migrated.

SUSE Linux Enterprise Server 12
SP1/SP2/SP3/SP4/SP5

64 Yes -

SUSE Linux Enterprise Server 15
SP0/SP1/SP2/SP3

64 Yes

SUSE Linux Enterprise Server 15 SP4 64 No

Ubuntu Ubuntu Server 12.04 64 No -

Ubuntu Server 14.04 64 Yes

Ubuntu Server 16.04 64 Yes
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OS Version Bit UEFI
Supp
ort

Remarks

Ubuntu Server 18.04 64 Yes

Ubuntu Server 19.04 64 Yes

Ubuntu Server 20.04 64 Yes

Ubuntu Server 22.04 64 Yes

Debian Debian GNU/Linux 6.0.10 64 No -

Debian GNU/Linux 7.11.0 64 No

Debian GNU/Linux
8.0/8.1/8.2/8.3/8.4/8.5/8.6/8.7/8.8/8.9/
8.10/8.11

64 No

Debian GNU/Linux
9.0/9.1/9.2/9.3/9.4/9.5/9.6/9.7/9.8/9.9/
9.10/9.11/9.12/9.13

64 No

Debian GNU/Linux
10.0/10.1/10.2/10.3/10.4/10.5/10.6/10.
7/10.8/10.9/10.10/10.11/10.12/10.13

64 Yes

Debian GNU/Linux 11.0/11.1/11.2 64 Yes

Debian GNU/Linux
11.3/11.4/11.5/11.7

64 No

Fedora Fedora
23/24/25/26/27/28/29/33/34/35/36/3
7

64 No -

EulerOS EulerOS 2.2.0 64 No -

EulerOS 2.3.0 64 No

EulerOS 2.5.0 64 No

Amazon
Linux

Amazon Linux 2.0 64 No -

Amazon Linux 2018.3 64 No

Alibaba
Cloud
Linux

Alibaba Cloud Linux 3.2104 64 No -

Alibaba Cloud Linux 3.2104 (Quick
Start)

64 No

Alibaba Cloud Linux 2.1903 LTS 64 No

Alibaba Cloud Linux 2.1903 LTS
(Quick Start)

64 No

Alibaba Cloud Linux 2.1903 LTS (CCSP
2.0 Level 3)

64 No
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OS Version Bit UEFI
Supp
ort

Remarks

Tencent
OS

TencentOS Server 2.4 64 No -

TencentOS Server 2.4 (TK4) 64 No

TencentOS Server 3.1 (TK4) 64 No

Kylin Kylin Linux Advanced Server V10
(Sword)

64 No -

OpenEul
er

OpenEuler 20.03 64 No -

OpenEuler 21.09 64 No

OpenSU
SE

OpenSUSE 15.1/15.2/51.3/15.4 64 No -

Rocky
Linux

Rocky Linux 8.5/8.6/8.7/9.0/9.1 64 No -

 

● Migration constraints and limitations

Table 4-6 Constraints and limitations on source servers

Source Server Type Description

OS ● Table 4-4
● Table 4-5
● A server running multiple OSs cannot be

migrated.

Available disk space ● Windows: at least 320 MB of available space on
a partition not smaller than 600 MB; at least 40
MB of available space on a partition smaller
than 600 MB

● Linux: at least 200 MB of available space on the
root partition

File system ● Windows: Only NTFS partitions are supported.
● Linux: Only ext2, ext3, ext4, VFAT, XFS, and Btrfs

file systems are supported.

Shared file system Only files on the local disk can be migrated. Files in
the shared file systems, such as NFS and CIFS file
systems, cannot be migrated.

Encrypted file OSs that contain protected folders and encrypted
volumes cannot be migrated.
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Source Server Type Description

Database and Active
Directory Domain (AD
DS) application

SMS does not support AD and multi-node
database migration.

Applications bound to
hardware

SMS does not support the migration of OSs that
contain applications bound to hardware.

Dynamic disk In Windows, dynamic disks are migrated as basic
disks. After the migration is complete, the target
ECS will not have dynamic disks.

Servers added to a
domain

If you want to migrate a server added to a domain,
after the migration is complete, the target ECS
must be added to that domain.

 

4.2.2 What Are the Important Statements of SMS?
● Source server data collection

After the Agent is installed and configured on the source server, it
automatically reports the source server information to SMS for verification.
The collected information is used only for migration feasibility check. If you
use SMS, you agree that SMS collects the information.

● License invalidity
After OSs, applications, and files on source servers are migrated to target
servers, the SIDs and MAC addresses of the servers will change. This means
that some OS or application licenses may become invalid. SMS is not
responsible for this type of issue. You can use the license server on the cloud
platform to obtain new licenses and update or obtain application licenses at
your own expense.

● Target server disk formatting
During a migration, disks on the target server are formatted and re-
partitioned based on the source disk settings. Any existing data on the target
server will be lost. Before the migration, make sure you have backed up any
data on the target server that you need to save and ensure that the disks can
be formatted. SMS is not responsible for any data losses incurred.

● If your target servers on the cloud platform cannot be started after the
migration is complete, the cloud platform can provide technical support to
help you solve the problem, but does not promise that the all possible
problems can be resolved.
There are many possible reasons that a target server may be unable to start,
for example:
– The source server cannot be restarted.
– The source server has a non-standard OS configuration.
– The source server has drivers or software that are incompatible with the

cloud platform.
● SMS modifies the system configuration of a target server to make it

compatible with the cloud platform. SMS can ensure data consistency before
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and after the migration but cannot ensure that your services run properly
after the migration. You need to modify related service configurations
thereafter.

4.2.3 How Many Servers Can I Migrate Concurrently Using
SMS?

You can migrate a maximum of 1,000 servers concurrently. If you need to migrate
more than 1,000 servers, delete the migrated servers from the server list in a
timely manner so that other servers can continue to be migrated.

4.2.4 How Do I Resolve the Error "Inconsistent firmware type.
Source: UEFI, Target: BIOS" When I Create a Migration Task?

Symptom
If you select a target server with the UEFI boot mode when you create a migration
task for a source server with the UEFI boot mode, you will receive this message.

Possible Causes
The target server uses a different boot mode from the source server. In this case,
the target server cannot be launched after the migration. You must select a target
server created from the image with the UEFI boot mode.

Solution Using the Management Console

Step 1 Download an image file as needed. If such an image file has been stored in your
OBS bucket, go to Step 3.

Step 2 Upload the image file to your OBS bucket.

Step 3 Use the image file to create a private image on the IMS console.

1. Select Image File for Source and select the uploaded image file.
2. Set Boot Mode to UEFI.
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Step 4 Use the private image to create an ECS.

----End

4.2.5 How Do I Resolve Error "Incompatible file system of the
source server"?

Symptom
After the migration feasibility check is complete, you receive error message
"SMS.6509 Incompatible file system of the source server."

Possible Causes
There are unsupported file systems on the source server.

Solution
Currently, SMS supports Ext2, Ext3, Ext4, XFS, VFAT, and Btrfs files systems for
Linux.

For unsupported file systems such as ReiserFS, you can copy files to other file
systems, uninstall the unsupported file systems, and then perform the migration.

If this is not possible on the source server, you can:

● Use IMS to create a system disk image for the source server from an external
image file and use the image to create a server on the cloud platform.

● Use a public image on IMS to create a target server and deploy your
applications on the target server.
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4.2.6 How Do I Resolve Error "Insufficient permissions. Add
corresponding fine-grained permissions"?

Symptom

During the migration, you received error message "SMS.0204 Insufficient
permissions. Cause: xxx. Please add corresponding fine-grained permissions."

Possible Causes

Using SMS requires that you have permissions for ECS, VPC, IMS and EVS, or the
migration will fail.

Solutions

Obtain all required fine-grained permissions and try again. For details, see
Creating a User and Granting Permissions.

4.2.7 How Do Resolve the Error "Source server lacks driver
files"?

Symptom

After you started the Agent, the source server did not pass the migration
feasibility check, and you received error message "SMS.6511 Source server lacks
driver files" on the SMS console.

Possible Causes

After the Agent is started, it will verify the driver files on the source server. If any
necessary driver files are missing, the preceding error is reported.

The following files are necessary:

* C:\Windows\system32\DRIVERS\atapi.sys

* C:\Windows\system32\DRIVERS\pciidex.sys

* C:\Windows\system32\DRIVERS\intelide.sys

Solution

Check whether the preceding files are there on the source server. If any of them
are missing, use the driver repair tool to repair the files or copy the files from
another server.
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4.2.8 How Do I Resolve Error "VSS not installed on the source
server"?

Symptom

After the Agent was started, a source server running Windows did not pass the
migration feasibility check, and error message "SMS.6533 VSS not installed on the
source server" was displayed on the SMS console.

Possible Causes

The possible causes are as follows:

1. The VSS service is not installed on the source server.
2. The VSS service is disabled on the source server.

Solution
1. Open the Task Manager and check whether the VSS service is there. If it is,

go to 2. If it is not, go to 3.

Figure 4-1 Checking whether the VSS service exists

2. Modify the configuration file to disable I/O monitoring.
If you do not need to synchronize data, you can modify the configuration file
to disable I/O monitoring.
In the Agent installation directory config, change the value of enablesync to
False in the g-property.cfg file, and then restart the Agent.
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Figure 4-2 Modifying the g-property.cfg file

3. Check VSS status. If its status is Stopped, right-click the service and choose
Open Services from the shortcut menu. Locate and right-click Volume
Shadow Copy, and choose Properties from the shortcut menu. On the
displayed Volume Shadow Copy Properties window, change the Startup
type to Manual. Click OK.

Figure 4-3 Changing the startup mode of VSS

4. Go back to the Task Manager window, locate and right-click VSS, and choose
Start from the shortcut menu.
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Figure 4-4 Starting VSS

5. Log in to the SMS console, locate the migration task, and in the Operation
column, choose More > Delete.

After the deletion is complete, restart the Agent.

4.2.9 How Do I Check the Firmware Type of a Source Server?
After the Agent is installed and started on the source server, click the source server
name on the Servers page of the SMS console. On the Basic Information tab
page, in the Source Server area, you can view the firmware type of the source
server.

4.2.10 Why Can't I Save the Migration Configuration as a
Template?

Symptom

After you completed the migration configuration, you clicked Save as Template to
save the configuration as a template for future use, but the message "Failed to
save the configuration" was displayed.

Possible Causes

The image used to create the target server is a private image and has been
deleted. SMS cannot identify the information about this private image. As a result,
the migration configuration fails to be saved as a template.
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Solution

Go to the ECS console and reinstall or change the OS of the target server.

If you want to change the firmware type of the target server from BIOS to UEFI,
create a private image by following the instructions provided in How Do I Resolve
Error "Inconsistent firmware type. Source: UEFI, Target: BIOS" When I Create a
Migration Task?

4.2.11 How Do I Set Resource Limits for SMS-Agent During a
Linux Server Migration?

You can set limits for CPU usage, memory usage, and disk throughput for SMS-
Agent on the source server.

Prerequisites

Cgroups has been installed and enabled on the source server.

To check if it has been installed, run the following command on the source server:

mount | grep cgroup

If the following cgroups V1 or V2 mounting information is displayed, cgroups is
enabled on the source server. Otherwise, it is not.

Before setting resource limits on the SMS console, evaluate whether installing or
enabling cgroups will affect services on the source server. If source services are
related to cgroups, submit a service ticket to contact SMS migration experts in
advance to check whether the SMS resource limits conflict with the source
services.

● cgroups V1

The example output shows that the following three mount points were
attached to the CPU, memory, and disk I/O controllers, respectively.
– /sys/fs/cgroup/CPU,CPUacct
– /sys/fs/cgroup/memory
– /sys/fs/cgroup/blkio

● cgroup V2

cgroup V2 is mounted on /sys/fs/cgroup. Unlike cgroup V1, cgroup V2 has no
mount points attached to specific resources.
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Procedure

Step 1 Log in to the SMS console.

Step 2 In the navigation pane on the left, choose Servers.

Step 3 In the server list, locate the server to be migrated, and click Configure in the
Target column.

Step 4 Set resource limits based on the following table.
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Table 4-7 Parameters

Parameter Description Precaution

CPU Limit Controls the maximum of CPU
resources to be used by the SMS-
Agent on the source server.
● If this parameter is left blank,

the CPU usage of SMS-Agent is
not limited.

● 1% ≤ CPU limit (integer) ≤
100%

● To ensure a smooth migration,
allocate at least 0.2 CPUs to
SMS-Agent.

Formula: CPU limit (%) =
Maximum number of CPUs
allowed for SMS-Agent/Total
number of CPUs x 100%
For example:
If the source server has 4 CPUs,
and you want to allocate 0.5 CPUs
for SMS-Agent, you can enter 13%
(0.5/4x100%).

● The CPU limit and
disk throughput limit
may affect the
migration speed.

● When the resource
limits are applied, a
folder named
sms_mig_cgroup will
be created in /sys/fs/
cgroup on the source
server, and
parameters for
configured limits are
created here.

Memory Limit Controls the maximum of memory
to be used by SMS-Agent. If the
configured limit is reached, SMS-
Agent will be stopped or ended.
● If this parameter is left blank,

the memory usage of SMS-
Agent is not limited.

● 200 MB ≤ Memory Limit ≤
1,000 MB

● To ensure a successful
migration, allocate at least 200
MB of memory to SMS-Agent.
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Parameter Description Precaution

Disk
Throughput
Limit

Controls the maximum disk
throughput to be used by SMS-
Agent. After the limit is set, the
disk read/write speed during the
migration will not exceed the limit.
● If this parameter is left blank,

the disk throughput of SMS-
Agent is not limited.

● 10 MB/s ≤ Disk Throughput
Limit ≤1000 MB/s

● To ensure a successful
migration, allocate at least 10
MB/s of disk throughput to
SMS-Agent.

 

----End

Modifying Resource Limits

You can modify resource limits for tasks in which the target servers have been
configured but the migration is not started, those have been paused, and those in
which the full migration is complete and incremental synchronizations are to be
performed. After locating such a task, choose More > Set Migration Limits in the
Operation column to reset the resource limits.

Viewing Resource Usage

You can run the top and iotop commands on the source server to view the
resource usage during the migration. It is normal for the resource usage of SMS-
Agent to slightly exceed the configured limits.

4.3 Migration Network
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4.3.1 How Do I Set Up a Secure Migration Network for Using
SMS?

Scenarios
To use SMS, you need to install the Agent on each source server to be migrated.
During the migration, each source server must continuously communicate with
SMS and the paired target server.

Figure 4-5 SMS networking

Connecting Source Servers to API Gateway
● The Agent installed on source servers must communicate with services IAM,

ECS, EVS, IMS, VPC, SMS, OBS, and DNS during the migration. You must
ensure that the Agent can call the APIs of these services in the region where
you are migrating to. You can view the domain names of these services in
supported regions in the SMS-Agent/config/cloud-region.json file.

● If the DNS server addresses are not configured on the source server, you need
to map each endpoint to its IP address in the local hosts file (C:\Windows
\System32\drivers\etc\hosts for Windows and /etc/hosts for Linux). The IP
addresses can be obtained by pinging the endpoints.

Connecting Source Servers to Target Servers
● If you want to migrate over the Internet, you need to an EIP for the target

server.
● If you want to migrate over a private network, you need to a Direct Connect

or VPN connection from your source environment to the cloud platform.
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Opening Required Ports on Target Servers
● For Windows target servers, open inbound ports 8899, 8900, and 22 in their

security groups. For Linux target servers, open inbound ports 8900 and 22 in
their security groups.

● If a network ACL is configured for the subnet you are migrating to, you also
need to open the required inbound ports in the ACL.
For details, see How Do I Configure Security Group Rules for Target
Servers?

4.3.2 How Do I Prepare a Target Server Before the Migration?
If you want to use an existing ECS as the target server, make the following
preparations:

Step 1 Make sure the ECS meets the requirements described in How Do I Select a Target
Server?.

Step 2 Connect the source server to the ECS using an EIP or VPN or Direct Connect
connection.

Step 3 Correctly configure the security group associated with the ECS.

If the ECS runs Windows, enable TCP ports 8899, 8900, and 22. If the target ECS
runs Linux, enable TCP port 22 for a file-level migration or ports 8900 and 22 for a
block-level migration.

For details about how to configure security group rules, see How Do I Configure
Security Group Rules for Target Servers?

CA UTION

If you indeed use the ECS as the target server, do not perform any operations on
the ECS during the migration, such as stopping or restarting the ECS, attaching or
detaching a disk, or changing the password, or the migration will fail.

----End

4.3.3 How Do I Configure Security Group Rules for Target
Servers?

1. Log in to the management console.

2. Click  in the upper left corner and select the desired region and project.
3. Under Compute, click Elastic Cloud Server.
4. In the ECS list, click the name of the target ECS.

The page providing details about the ECS is displayed.
5. Click the Security Groups tab and view security group rules.
6. Click Modify Security Group Rule.

The Summary page of the security group is displayed.
7. On the Inbound Rules tab, click Add Rule to configure an inbound rule.
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– If the ECS runs Windows, configure three rules: one for port 8899, one for
port 8900, and one for port 22. For each, set the protocol to TCP.

– If the ECS runs Linux, configure two rules: one for port 8900 and one for
port 22. For each, set the protocol to TCP.

– For all the rules, set Source to the IP address range containing the IP
addresses that you want to allow to access the ECS over the Internet.

NO TE

If you retain the default value 0.0.0.0/0 for Source IP Address, it indicates that
all IP addresses can access the ECS.

8. Click OK.

4.3.4 How Do I Resolve the Error "Failed to establish an SSH
connection with the target ECS"?

Symptom

The migration task failed, and you received the error message "sms.3802 Failed to
establish an SSH connection with the target ECS."

Problem Analysis

During a Linux file-level migration, an SSH connection is established between the
source server and target server for data transmission. If the SSH connection is not
set up, the preceding error message is displayed. You are advised to review the
following parts to locate the cause of the SSH connection failure.

● Checking Whether the Target Server Is Stopped
● Checking Whether Port 22 Is Allowed in the Security Group of the Target

Server and the Source IP Address Is Configured Correctly
● Checking Whether the Source Server Can Connect to the Target Server
● Checking Whether the SSH Client Is Installed on the Source Server
● Checking Whether the VPC or IP Address of the Target ECS Is Changed

During the Migration
● Checking the Firewall Settings of the Source Server

Checking Whether the Target Server Is Stopped

Step 1 Log in to the management console.

Step 2 Under Compute, click Elastic Cloud Server. Locate the target ECS and view its
status. If the ECS is stopped, choose More > Start in the Operation column.

----End

Checking Whether Port 22 Is Allowed in the Security Group of the Target
Server and the Source IP Address Is Configured Correctly

Step 1 Log in to the management console.
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Step 2 Under Compute, click Elastic Cloud Server. In the ECS list, click the name of the
target ECS.

Step 3 On the ECS details page, click the Security Groups tab. Check whether port 22 is
allowed and whether the source IP address is specified correctly.

If port 22 is not allowed in the inbound direction, add an inbound rule for port 22.
If such an inbound rule exists but the source IP address is not 0.0.0.0/0 or the IP
address of the source server, change the source IP address to 0.0.0.0/0.

For details, see How Do I Configure Security Group Rules for Target Servers?

----End

Checking Whether the Source Server Can Connect to the Target Server

Step 1 Log in to the source server.

Step 2 Run telnet Target server IP address Port in the error message. If the port is not
reachable, check the configurations of the DNS servers, firewalls, security groups,
and local networks of the source and target servers.

Step 3 Run telnet Target server IP address Port in the error message. If the port is not
reachable, check the configurations of the DNS servers, firewalls, security groups,
and local networks of the source and target servers.

----End

Checking Whether the SSH Client Is Installed on the Source Server

Step 1 Log in to the source server as user root.

Step 2 Check whether the SSH client is installed.

If the SSH path shown in the following figure is not returned, install the SSH
client.

command -v ssh

----End

Checking Whether the VPC or IP Address of the Target ECS Is Changed
During the Migration

If the VPC or IP address of the target server is changed during the migration,
change it back to the original VPC or IP address. Otherwise, you will need to
repeat the migration.

Checking the Firewall Settings of the Source Server

Check whether the outbound traffic is blocked by the source server firewall. If yes,
permit the traffic and continue the migration.
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4.3.5 How Do I Fix the Error "Failed to connect to the target
ECS. Check whether its IP address is reachable and confirm
that port XX is enabled"?

Symptom
The target server could not be accessed, and either of the following messages was
displayed:

● Failed to connect to the target ECS. Check whether its IP address is reachable
and confirm that port 8900 is enabled.

● Failed to connect to the target ECS. Check whether its IP address is reachable
and confirm that port 8899 is enabled.

Problem Analysis
For a Windows migration, ports 8899 and 8900 must be enabled on the target
server for communicating with SMS and the source server. If communications
cannot be established, this error occurs. You can locate the fault by:

● Checking Whether the Source Server Can Connect to the Target Server
● Checking Whether the Peagent on the Target Server Is Running Properly
● Checking Whether Ports 8899 and 8900 Are Enabled in the Security Group

of the Target Server
● Checking Whether Ports 8899 and 8900 Are Allowed in the Network ACL

of the Subnet Where the Target Server Is Running

Checking Whether the Source Server Can Connect to the Target Server

Step 1 Log in to the source server.

Step 2 Run telnet Target server IP address Port in the error message. If the port is not
reachable, check the configurations of the DNS servers, firewalls, security groups,
and local networks of the source and target servers.

Step 3 Run telnet Target server IP address Port in the error message. If the port is not
reachable, check the configurations of the DNS servers, firewalls, security groups,
and local networks of the source and target servers.

----End

Checking Whether the Peagent on the Target Server Is Running Properly
After confirming the network is normal, forcibly restart the target server. Wait for
about 3 minutes and start the migration again.

Checking Whether Ports 8899 and 8900 Are Enabled in the Security Group of
the Target Server

Step 1 Log in to the management console.
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Step 2 Under Compute, click Elastic Cloud Server. In the ECS list, click the name of the
target ECS.

Step 3 On the ECS details page, click the Security Groups tab. Check whether ports 8899
and 8900 are opened and the source IP address is specified correctly.

If port 8899 or 8900 is not opened, add an inbound rule for the port. If such rules
exist but the source IP address is not 0.0.0.0/0 or the IP address of the source
server, change it to 0.0.0.0/0.

For detailed instructions, see How Do I Configure Security Group Rules for
Target Servers?

----End

Checking Whether Ports 8899 and 8900 Are Allowed in the Network ACL of
the Subnet Where the Target Server Is Running

Step 1 Log in to the management console.

Step 2 Check whether the subnet of the target server is associated with a network ACL.

If a network ACL has been associated and there are inbound rules configured for
ports 8899 and 8900, change the action to Allow.

For details, see "Modifying a Network ACL Rule" in Virtual Private Cloud User
Guide.

----End

4.3.6 How Do I Fix a Connection Failure Between the Source
Server and API Gateway Due to a Busy Network?

Symptom

The Agent could not be started, and either of the following message was
displayed:

Linux: Failed to start sms agent! Please check the network connection with below
commands!

Windows: Network busy. The source server failed to connect to API Gateway.

Possible Causes

The source server cannot communicate with IAM or SMS over the Internet. In this
case, check the source network.
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Solution

Step 1 Log in to the source server.

Step 2 Confirm that you can access IAM and SMS on the source server.

curl -v {Endpoint of IAM}:443

curl -v {Endpoint of IAM}:443

If curl fails to be executed, for example, due to a network timeout, the source
server cannot access the IAM or SMS management console.

Step 3 Check whether the source server can access the Internet. If it cannot, locate the
fault by checking the configurations of the DNS server, firewall, security group,
and local network of the source server. For details, see Why Cannot an EIP Be
Pinged? Then rectify the fault and restart the Agent.

Step 4 If a proxy server is used, check whether the proxy server is running properly.

Common proxy problems are incorrect login credentials, network disconnections,
and firewall or various software restrictions.

----End

4.3.7 How Do I Restore the Connection Between the Agent
and SMS?

Symptom

The server migration was in the Disconnected status, so most operations could
not be performed.

Possible Causes
● The Agent on the source server is not running.

● The Agent is disconnected from SMS. This can happen if no operations are
performed on the Agent for a long time (30 days by default, but this can be
changed using the heartmonitorday parameter in the config/g-property.cfg
file).

● The network connection between the source server and the Agent is
abnormal.

● The SMS-Agent-Py3 process exits. This can happen if you have been logged
out of or have exited from the source server automatically.

Windows Server 2019/2016/2012 and Windows 10/8.1

Step 1 Log in to the source server, search for the Agent icon in the lower right corner, and
check whether the Agent is running properly.

● If the Agent has exited, restart the Agent.
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CA UTION

Do not log out or exit the source server, or the SMS-Agent-Py3 will also exit.
If you have such requirements, use SMS-Agent-Py2 to perform the migration
again.

● If the Agent is running properly, go to Step 2.

Step 2 On the Agent operation page, check whether the Start button can be clicked.
● If it can, the Agent has proactively disconnected from SMS. Click Start to

reconnect to it.
● If it cannot, go to Step 3.

Step 3 Run the curl -v {endpoint of SMS}/v3/sources command to check the connection
between the source server and the SMS API.
● If the connection is unavailable, check whether the DNS and firewall of the

source server are correctly configured.
● If the connection is available and data is being transmitted, check whether the

outbound bandwidth of the source server is lower than 10 Mbit/s. If it is, the
data transmission may be using up all the bandwidth, which can cause the
connection between the Agent and SMS to time out. In this case, increase the
outbound bandwidth of the source server to more than 10 Mbit/s, and then
continue the migration.

Step 4 Wait for about a minute and log in to the management console.

Step 5 Click Service List. Under Migration, click Server Migration Service.

The SMS console is displayed.

Step 6 In the navigation pane on the left, choose Servers.

In the Status column, view the connection status of the source server.

----End

Windows Server 2008 and Windows 7

Step 1 Log in to the source server and check whether the SMSAgentDeploy.exe process
is running properly.
● If the process does not exist, restart the Agent and go to Step 2.

WARNING

If you restart the Agent, you need to repeat the migration.

● If the process exists, go to Step 2.

Step 2 Go to the SMS-Agent installation directory, run agent-cli.exe, and then run status
to check the Agent connection status.
● If the status is True, go to Step 4.
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● If the status is False, the Agent has proactively disconnected from SMS. In this
case, go to Step 3.

Step 3 Enter connect to reconnect the source server to SMS.

If in the command output, the value of Connected between sms agent and sms
server is True, the connection between the source server and SMS has been
restored.

Step 4 Run the curl -v {endpoint of SMS}/v3/sources command to check the connection
between the source server and the SMS API.
● If the connection is unavailable, check whether the DNS and firewall of the

source server are correctly configured.
● If the connection is available and data is being transmitted, check whether the

outbound bandwidth of the source server is lower than 10 Mbit/s. If it is, the
data transmission may be using up all the bandwidth, which can cause the
connection between the Agent and SMS to time out. In this case, increase the
outbound bandwidth of the source server to more than 10 Mbit/s, and then
continue the migration.

Step 5 Wait for about a minute and log in to the management console.

Step 6 Click Service List. Under Migration, click Server Migration Service.

The SMS console is displayed.

Step 7 In the navigation pane on the left, choose Servers.

In the Status column, view the connection status of the source server.

----End

Linux
Step 1 Use PuTTY or another SSH client to log in to the source server.

Step 2 Run ps -ef | grep -v grep | grep linuxmain to check whether the Agent is running
properly.
● If the linuxmain process is not running, restart the Agent.
● If the linuxmain process is running, go to Step 3.
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Step 3 Run ./agent-cli.sh in the SMS-Agent directory to go to agent-cli, and run status
to check the Agent connection status.

● If the status is True, go to Step 5.

● If the status is False, the Agent has proactively disconnected from SMS. In this
case, go to Step 4.

Step 4 Enter connect to reconnect the source server to SMS.

If in the command output, the value of Connected between sms agent and sms
server is True, the connection between the source server and SMS has been
restored.

Figure 4-6 Reconnecting the source server to SMS

Step 5 Run the curl -v {endpoint of SMS}/v3/sources command to check the connection
between the source server and the SMS API.

● If the connection is unavailable, check whether the DNS and firewall of the
source server are correctly configured.

● If the connection is available and data is being transmitted, check whether the
outbound bandwidth of the source server is lower than 10 Mbit/s. If it is, the
data transmission may be using up all the bandwidth, which can cause the
connection between the Agent and SMS to time out. In this case, increase the
outbound bandwidth of the source server to more than 10 Mbit/s, and then
continue the migration.

Step 6 Wait for about a minute and log in to the management console.

Step 7 Click Service List. Under Migration, click Server Migration Service.

The SMS console is displayed.

Step 8 In the navigation pane on the left, choose Servers.

In the Status column, view the connection status of the source server.

----End
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4.3.8 Why the Migration Progress Is Suspended or Slow?

Symptom
During the migration, the progress bar changes slowly or does not change.

Possible Causes
This problem may be caused by multiple factors, such as the network bandwidth,
the number of small files on the source server, and the difference comparison
during incremental synchronization.

Procedure
● Check the bandwidths of the source and target servers. Allocate sufficient

bandwidth for the migration process without affecting services.
● Check whether there are a large number of small files on the source server. If

there are, delete as many unnecessary files as possible.
● During a Linux file-level migration, if the synchronization progress stays at 6%

for a long time, please wait patiently. The migration process is comparing and
synchronizing the differences between the source and target servers.

● Check the migration status on the SMS console. If it is Connected, wait
patiently. If it is Disconnected, see How Do I Restore the Connection
Between the Agent and SMS?

4.3.9 Does a Source Server Have to Connect to the Internet?
The source server must connect to the Internet. It does not matter if it connects to
the target server through a Direct Connect connection, VPN connection, or VPC
peering connection. In the following figure, the Direct Connect connection, VPN
connection, or VPC peering connection between the source and target servers is
used only for data flow transmission. The control flow between the source server
and SMS needs to be transmitted over the Internet.

NO TE

If the source server cannot access the Internet, you can configure a proxy server for the
source server.

The following figure shows how SMS works.
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Figure 4-7 How SMS works

● Control flow: the interaction process between the source server and SMS
The interactions include:
Step 2: The Agent registers itself with SMS and reports the information about
the source server to SMS. Then, SMS evaluates migration feasibility of the
source server.
Step 4: The Agent receives and executes the migration commands sent by
SMS.

● Data flow: the process of migrating data on the source server
The data migration includes:
Step 5: SMS migrates the system disk of the source server.
Step 6: SMS migrates the data disks of the source server.

4.3.10 Can I Release or Change the Target Server EIP During
the Migration?

No.

If you choose to migrate over the Internet, the Agent on the source server records
the target server EIP when the migration starts, and uses that EIP for data
transmission during the migration. Releasing or changing the EIP during the
migration will cause the migration to fail.

You can release or modify the EIP only after the migration is complete and no
data synchronization is required.
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4.3.11 How Do I Resolve the Error "SMS.0302 Failed to resolve
domain name xxx"?

Symptom
When you started your migration task, you received the error message "SMS.0302
Failed to resolve domain name %s."

Possible Causes
The source server can communicate with SMS for migration only after all
dependent domain names are resolved successfully. If any domain name fails to
be resolved, this error message is displayed.

The possible causes of domain name resolution failures are as follows:

1. The local network is abnormal.
2. The record set is abnormal.
3. The record set has been modified or cached by a local DNS server.

Solutions
For details about the cause analysis and solution, see the Domain Name Service
(DNS) Documentation.

4.3.12 How Do I Resolve the Error "SMS.0303 Unable to access
domain name xxx"?

Symptom
When you started your migration task, you received the error message "SMS.0303
Unable to access domain name xxx."

Possible Causes
For a successful migration, the source server must access all dependent domain
names. If any domain name fails to be connected, this error message is displayed.

The possible causes are as follows:

1. The network is abnormal, for example, the connection times out or the
network is disconnected or inaccessible.

2. The access is blocked by the firewall.
3. Security alarms are generated on the source server, or the source server EIP is

unbound or frozen.
4. The access is blocked by the security group of the source server.

Solutions
1. Ping another domain name.
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– If the ping operation succeeds, the network is normal.

– If the ping operation fails, the network is abnormal. Check the local
network.

2. Check the firewall settings of the source server.

If the access is blocked, allow the access and continue the migration.

3. Check whether security alarms are generated on the source server, or the
source server EIP is unbound or frozen.

– If the EIP has been unbound, you can bind it back or use a private
network for migration.

– If the EIP is frozen, contact ECS or EIP technical support.

4. Check whether the required outbound ports are allowed in the security group
of the source server.

– If there are no outbound rules for the protocols and ports shown in
Figure 4-8, add rules for them.

– If there are outbound rules for the ports but Action is set to Deny,
change the actions to Allow.

– If there are outbound rules for allowing the ports but the destination IP
addresses are not 0.0.0.0/0, change them to 0.0.0.0/0.

Figure 4-8 Outbound rules

4.3.13 How Do I Measure the Network Performance Before
the Migration?

Background

Poor network performance may prolong the migration or cause migration failures.
SMS can help you measure the network performance before the migration.

CA UTION

● It takes 4 to 5 minutes to complete the measurement. To accurately measure
the network performance, the migration rate limits you configure are not
applied during the measurement, and more network resources may be used.
You are advised to evaluate the actual resource usage on the source server to
ensure that your services run properly.

● You must make sure that inbound ICMP traffic is allowed in the security group
of the target server.
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Procedure
When you configure the migration task, on the Configure Basic Settings page, set
Measure Network Performance to Yes. During the full migration, SMS will
generate a subtask Measure the network performance.

Measurement Results
This subtask measures four major network metrics packet loss rate, jitter, latency,
and bandwidth as well as memory usage and CPU usage that impact the network
performance. The measurement results are displayed in green, orange, and red,
which indicate good, medium, and poor respectively. After the measurement is
complete, SMS will display how well your network is performing and estimate
how long the migration will take.

NO TE

● The evaluation result represents only the network performance during the test.
● The migration duration is estimated when the migration rate limits are not applied and

is for reference only. In addition to the migration network, the migration duration is
affected by many other factors, such as the number of small files on the source server,
network fluctuation, disk read/write speed, and network traffic limit. A more reliable
indicator is the remaining migration time displayed in the task list.

4.4 Migration Duration

4.4.1 How Long Does a Migration Take?
1. Pre-migration evaluation

Test the TCP speed from a source server to the target server. For details, see
How Do I Test the Network Between the Source and Target Servers Using
iPerf?

where
– T: the migration time, in hours
– C: the total data volume of the source server, in GB
– S: the TCP speed (in Mbit/s) from the source server to the target ECS,

that is, the TCP speed obtained in 4.b
– U: the network usage, which is related to network quality (jitter, delay,

and packet loss). The value is usually between 50% and 80%.
For example, if the total data volume of the source server is 100 GB, the TCP
speed tested by iPerf is 100 Mbit/s, and the network usage is 70%, the
migration time is calculated as follows:
Migration time T = 100 GB x 1000 x 8 / 100 Mbit/s / 3600 / 70% ≈ 3.17 hours
You can refer to Table 4-8 to view the migration time of source servers of
different data volumes and TCP speeds assuming that the network usage U is
70%.
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Table 4-8 Migration time

Total Data
Volume on
Source Server
(C) (GB)

TCP Speed
(S) (Mbit/s)

Migration Time (T) (Hour)
NOTE

For migration time T, if the unit is hour,
two digits are retained after the decimal
point. If the unit is min, the value is an
integer.

10 GB 0.5 Mbit/s SMS is not recommended.

1 Mbit/s SMS is not recommended.

5 Mbit/s 6.35 hours

10 Mbit/s 3.17 hours

100 Mbit/s 0.32 hours (about 19 minutes)

500 Mbit/s 0.06 hours (about 4 minutes)

1,000 Mbit/s 0.03 hours (about 2 minutes)

30 GB 0.5 Mbit/s SMS is not recommended.

1 Mbit/s SMS is not recommended.

5 Mbit/s 19.04 hours

10 Mbit/s 9.52 hours

100 Mbit/s 0.95 hours (about 57 minutes)

500 Mbit/s 0.19 hours (about 11 minutes)

1,000 Mbit/s 0.10 hours (about 6 minutes)

50 GB 0.5 Mbit/s SMS is not recommended.

1 Mbit/s SMS is not recommended.

5 Mbit/s SMS is not recommended.

10 Mbit/s 15.87 hours

100 Mbit/s 1.59 hours

500 Mbit/s 0.32 hours (about 19 minutes)

1,000 Mbit/s 0.16 hours (about 10 minutes)

100 GB 0.5 Mbit/s SMS is not recommended.

1 Mbit/s

5 Mbit/s

10 Mbit/s

100 Mbit/s 3.17 hours
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Total Data
Volume on
Source Server
(C) (GB)

TCP Speed
(S) (Mbit/s)

Migration Time (T) (Hour)
NOTE

For migration time T, if the unit is hour,
two digits are retained after the decimal
point. If the unit is min, the value is an
integer.

500 Mbit/s 0.63 hours (about 38 minutes)

1,000 Mbit/s 0.32 hours (about 19 minutes)

500 GB 0.5 Mbit/s SMS is not recommended.

1 Mbit/s

5 Mbit/s

10 Mbit/s

100 Mbit/s 15.87 hours

500 Mbit/s 3.17 hours

1,000 Mbit/s 1.59 hours

1 TB 0.5 Mbit/s SMS is not recommended.

1 Mbit/s

5 Mbit/s

10 Mbit/s

100 Mbit/s

500 Mbit/s 6.50 hours

1,000 Mbit/s 3.25 hours

Greater than 1
TB

N/A SMS is not recommended.

 
2. Evaluation during migration (remaining time)

T = C x 1000 x 8 x (80% - P) / 60% / S / 3600
– T: the time required, in hours
– C: the total data volume of the source server
– P: the transmission progress. P can be viewed on the SMS console. If P is

larger than 80%, the data transmission is complete and you do not need
to evaluate the remaining time.

– S: the migration speed in Mbit/s. S cannot be tested accurately with iPerf.
To obtain the accurate migration speed:

▪ Windows: Choose Windows Task Manager > Performance >
Resource Monitor to view the migration speed S for Windows OSs.
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▪ Linux: You are advised to use the sar tool or use /proc/net/dev to
monitor the NIC speed.

Take an example where there is 100 GB to be migrated (C), the progress (P) is
70%, and the migration speed (S) is 100 Mbit/s. If we plug in the numbers in
our formula, we get:
Migration time T = 100 GB x 1000 x 8 x (80% - 70%) / 60% / 100 Mbit/s /
3600 = 0.37 hours

4.4.2 How Do I View the Remaining Migration Time?
The remaining migration time depends on how much data is left to migrate and
on how fast it is being migrated. Because the migration rate changes over time,
the remaining time shown on the SMS management console is only an estimate.
You can perform the following operations to view the remaining migration time:

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

The SMS console is displayed.

Step 3 In the navigation pane on the left, choose Servers.

The server list is displayed.

Step 4 Locate the source server, hover over the icon corresponding to Full Replication in
the Migration Stage > Real-Time Status, and view the remaining migration time.

----End
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4.4.3 How Is the Migration Rate Displayed on the SMS
Console Calculated?

Metrics

Table 4-9 Related metrics

Metric Windows Block-
Level

Linux File-Level Linux Block-Level

Total
data

Total used space of
all partitions to be
migrated. You can
right-click a partition
and choose
Properties from the
shortcut menu. On
the General tab, you
see details about
partition usage.

Total used space of all
partitions to be
migrated. You can run
df -TH to view the
used and available
space on each
partition.

Total size of all
partitions to be
migrated. You can
run fdisk -lu to
view the size of all
the partitions.

Migrated
data

Total size of all
migrated data blocks
that are located in
the used partition
space.

Total size of all
migrated files.

Total size of all
migrated data
blocks in the
partition.

Elapsed
time

Time elapsed after a migration starts.

Remainin
g time

Remaining time = (Total data – Migrated data) / Migration rate
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Metric Windows Block-
Level

Linux File-Level Linux Block-Level

Migration
rate

Calculated using the
amount of data
migrated over the
last 5 seconds. For
example, if 200 MB
data was migrated
over the last 5
seconds, the
migration rate is 320
Mbit/s (200 MB x
8/5s). The migration
rate is different from
the NIC rate because
the data is
compressed before
being transmitted
through the NIC. For
details, see Windows
Block-Level
Migration.

Actual migration
speed, which is the
NIC rate of the target
server.

Calculated using
the amount of
data migrated
over the last 5
seconds. For
example, if 200 MB
data was migrated
over the last 5
seconds, the
migration rate is
320 Mbit/s (200
MB x 8/5s). The
migration rate is
different from the
NIC rate because
the data is
compressed before
being transmitted
through the NIC.
For details, see
Linux Block-Level
Migration.

 

Windows Block-Level Migration
There are two types of Windows block-level migration rates. One is the rate
displayed on the SMS console, which is the average migration rate over the last 5
seconds. The other is the actual NIC throughput for the migration process, which is
less than what is displayed on the console because the data is compressed before
being transmitted through the NIC

● Migration rate displayed on the SMS console (before compression)
The migration rate displayed on the console is the actual amount of data
migrated per second, which is the data transmission rate before compression.
This rate shown is based on the average amount of data migrated over the
last 5 seconds. For example, if 200 MB of data was transmitted over the last 5
seconds, and the amount of data after compression is 50 MB, the rate
displayed on the console is 320 Mbit/s (200 MB*8/5s), but the NIC throughput
for the migration process is 80 Mbit/s (50 MB*8/5s).

● Actual NIC throughput (after compression)
During a Windows block-level migration, the Agent compresses data before
transmitting it to the target ECS. The agent on the target ECS decompresses
the data and writes the data to disks. The actual NIC throughput is the
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network bandwidth occupied by the migration process. You can view this rate
in the task managers on the source server and target ECS. However, you can
view this rate only after the target ECS is unlocked. The following uses
Windows Server 2012 as an example.

CA UTION

● You can view the network bandwidth occupied by the migration process in
the task manager. Use the migration rate displayed on the SMS console to
estimate how long the migration will take.

● The NIC rate of the source server also includes the bandwidth occupied by
applications running on the source server. A more reliable indicator is the
migration rate of the migration process. The rate displayed in the task
manager is the compressed data transmission rate.

● A Windows block-level migration rate is more stable because it is not
affected by the number or size of files to be migrated.

Linux File-Level Migration
During a Linux file-level migration, data is not compressed, so the migration rate
displayed on the console and the NIC throughput should match.

However, there is an exception. A Linux file-level migration is inefficient when
transferring small files. When migrating a large number of small files, the network
bandwidth cannot be fully utilized. In such a scenario, the migration rate is far
lower than the available network bandwidth.

Linux Block-Level Migration
During a Linux file-level migration, data is not compressed, so the migration rate
displayed on the console and the NIC throughput should match.
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4.4.4 How Do I Speed Up Migration?
● Improve your network speed. You can test the network performance from the

source server to the target ECS on the cloud platform. For details, see How
Do I Test the Network Between the Source and Target Servers Using
iPerf? If the network speed is less than 500 Kbit/s, check the following items:
– If the source server is in a data center, check the bandwidth, switches,

routers, security devices (such as firewalls), network lines, and network
protocols between the source server and the Internet for issues. If there
are any issues, contact network engineers to rectify the fault. It is
recommended that the speed of the network from the source server to
the cloud platform be at least 10 Mbit/s.

– Check the outbound bandwidth of the source server and the inbound
bandwidth of the target server. Increase the smaller bandwidth or both as
needed. For the influence of bandwidth on migration duration, see Table
4-8.

– Check that the OS settings of the source servers and target ECSs. In
Windows, you can run perfmon to invoke Performance Monitor to
monitor the network. In Linux, you are advised to use the sar tool to
monitor the network and use /proc/net/dev to monitor the NIC speed. If
the network is slow, the OS configuration may be incorrect. Note that
your OS services and processes cannot limit the NIC speed.

● Delete any files you no longer need from the source server before migration.
● Check the I/O read and write performance and CPU performance of the

source server. In Windows, you can run perfmon to invoke Performance
Monitor to monitor the CPU and I/O read and write performance. In Linux,
you can use top or ps to monitor the CPU, and use iostat or iotop to monitor
the I/O performance. If the I/O and CPU performance of your source server is
poor, you are advised to increase the I/O and CPU resources or reduce the
workloads on the source server.

4.4.5 Why Does the Migration Speed Fluctuate?
During the migration, operations such as module initialization, data backup, and
data clearing are performed. It is difficult to accurately estimate the duration of
these operations. Speed fluctuation is a normal phenomenon.

4.4.6 How Do I Test the Network Between the Source and
Target Servers Using iPerf?

Prerequisites

Ensure that the network between the source and target server is connected, and
the port used for the iPerf test is allowed by a security group rule configured for
the target server. For how to configure a security group rule, see How Do I
Configure Security Group Rules for Target Servers?

This test must be performed before the migration, and services running on the
source server need to be those with little impact on the network, or the test
results will be inaccurate.
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Procedure

Step 1 Download iPerf based on the source server OS.

Step 2 Extract the iPerf installation package into directories on the source and target
servers (or another server in the same region as the target server). On a Windows
server, the iPerf installation package looks like follows.

Step 3 On the target server, run iPerf in server mode using the CLI. The following uses
Windows as an example.

1. Switch to the directory with the iPerf executable:
cd /d path
In this command, path is where you extracted iPerf on the target server in
Step 2.

2. Run iPerf in server mode:
iperf3 -p port -s
In this command, port is the port the iperf server listens on. It is
recommended that port 8900 be used for Windows and port 22 for Linux
since the two ports are configured as data transmission ports. You can also
use another port for testing, but ensure that the TCP or UDP port is allowed
in security group rules configured for the target server.
For details about more parameters, run the iperf -h command.
Assuming that port 8900 is used for Windows, if Server listening on 8900 is
displayed in the command output, the iPerf server is running.

Step 4 On the source server, run iPerf in client mode using the CLI. Test the TCP
bandwidth, UDP jitter, packet loss rate, and bandwidth. The following uses
Windows as an example.

1. Switch to the directory with the iPerf executable:
cd /d path
In this command, path is where you extracted iPerf on the source server in
Step 2.

2. Test the TCP bandwidth using iPerf:
iperf3 -c target_IP -p port -t time
In the preceding command, -c is used to run iPerf in client mode.
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– target_IP is the IP address of the target server (iPerf server).

– port is the port used for connecting to the target server, that is, the iPerf
listening port 8900 in Step 3.2.

– time is the total test time. The default unit is second.

Wait for the iPerf client to connect to the iPerf server and the bandwidth test
to complete, and then check the results.

3. Test the UDP jitter, packet loss rate, and bandwidth.

iperf3 -c target_IP -p port -u -t time
-u is used to measure the UDP jitter, packet loss rate, and bandwidth.

– target_IP is the IP address of the target server (iPerf server).

– port is the port used for connecting to the target server, that is, the iPerf
listening port 8900 in Step 3.2.

– time is the total test time. The default unit is second.

Wait for the iPerf client is connected to the iPerf server and the test is
complete, and check the result.
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4. Run the following ping command to measure the network delay:
ping target_iP
target_IP is the IP address of the target server (iPerf server).
Ensure the ICMP packets are allowed to pass through by the security group
rules of the VPC to which the target server belongs.

Step 5 View all testing options. Alternatively, you can obtain the help information about
iPerf on its official website.

iperf3 -h

----End

4.4.7 Why Isn't the Increased Bandwidth Being Used During
the Migration?

The bandwidth being used will be limited by one of the three bottlenecks:

● The newly increased bandwidth of the source server
● The inbound bandwidth of the target server.
● The migration rate limit you configured on the SMS console. For details, see

Setting the Migration Rate.

CA UTION

As long as there is on other bottleneck, the newly increased bandwidth takes
effect after 5 to 10 minutes.

4.4.8 Is the Migration Speed Determined by the Source
Bandwidth or the Target Bandwidth?

The migration speed is limited by either the outbound bandwidth of the source
server or the inbound bandwidth of the target server, whichever is smaller.

4.4.9 Why Does the Migration Stay in a Stage for a Long
Time?

A migration may stay in the Continuous Synchronization, Full Replication, or
Target Launch stage for a long time. For details about the stage your migration is
in, see Where Can I Find the Agent Run Logs?

● Scenario 1: Continuous Synchronization

Continuous synchronization is a new feature of SMS. It automatically synchronizes
incremental data from a source server to the target server. If you set Continuous
Synchronization to Yes when you configure the migration settings, after the full
replication is complete, the migration enters the Continuous Synchronization
stage.

To complete the migration, you need to manually launch the target server, or the
migration remains in the Continuous Synchronization stage.
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● Scenario 2: Full Replication

During the full replication, the migration progress is suspended for a long time if
the data volume is large but the migration speed is too slow. You can verify the
causes by viewing the Agent run logs.

If information similar to the following is displayed, the migration is normal.

Parameter Description

speed The migration rate

task progress The migration progress

total size The amount of data to be migrated

replicate size The amount of data migrated

 

NO TE

If the migration rate is not 0 and the amount of migrated data keeps increasing, the
migration runs normally.

● Scenario 3: Target Launch
– After you launch the target server, the task progress bar stays at 0% for a

long time.
After you launch the target server, the system performs an incremental
data synchronization. The incremental data volume determines how
much time is required for the synchronization. The synchronization
progress may remain unchanged for a long time if there is too much
incremental data on the source server.
To check whether data is being synchronized, view the latest
sms_Info.log file. If no error logs were generated during the target server
launch, the migration went smoothly.

– After you launch the target server, the task progress bar remains
unchanged for a long time.
You can pause the task and start it again. Wait for about 10 minutes and
check whether the progress bar changes.

4.4.10 What Factors Affect the Migration Speed?
The following table lists the factors that may affect the migration speed and
duration.
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OS Factor Description

None CPU or memory
usage

The migration occupies some memory and
CPU resources of the source server. The
usage varies depending on the source
conditions. Before the migration, ensure
that both the CPU usage and memory
usage of the source server are not higher
than 75%, and the available memory is at
least 520 MB.

Network bandwidth The network latency between the source
and target servers must not be too high.
The migration speed depends on the
source bandwidth and the target
bandwidth, whichever is smaller. For
details about the network requirements,
see How Do I Set Up a Secure Migration
Network for Using SMS?

Windows Disk fragments SMS supports only block-level migration
for Windows servers. During migration, the
migration process identifies and migrates
valid blocks. A large number of disk
fragments will be generated on disks in
daily use, which prolongs the migration
duration.

Linux ● Large files
● Too many small

files

For a file-level Linux migration, the
migration speed will be affected if
● There are files larger than 2 GB.
● There are a large number of small files,

such as, those smaller than 20 KB.

 

The following table lists the factors that may affect the synchronization duration.

OS Factor Description

None ● Too many new
data on the
source server

● Too many
changed data
on the source
server

During an incremental synchronization, if a
large amount of data is newly generated or
changed on the source server, the
synchronization takes a long time.

Windows Too many file
fragments

During a synchronization, if a large number
of file fragments are generated on the
source server, the synchronization takes a
long time.
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OS Factor Description

Linux Large sparse files During a synchronization, the system scans
but does not migrate sparse files. If there
are large sparse files on the source server,
the synchronization takes a long time.

 

4.4.11 Why Is the Linux Block-Level Migration Very Slow?

Symptom
During a Linux block-level migration, you found that the actual migration rate was
far lower than the bandwidth limit I have configured.

Possible Causes
The possible causes are as follows:

● A small amount of data is stored in disk blocks.
● A large number of sparse files are stored in source disks.

In a Linux block-level migration, data is compressed before being transmitted. If
the disk blocks to be migrated store a small amount of data or are empty, the
data compression rate is high, for example, 100 MB of data is compressed to 5
MB. In this case, the displayed migration rate will be very low. But actually, the
migration is still performed quickly, and the network connection and bandwidth
are normal.

4.5 Agent Installation and Startup

4.5.1 How Do I Install the Agent on Source Servers?
● To install the Agent on a Windows source server, see Windows.
● To install the Agent on a Linux source server, see Linux.

4.5.2 What Can I Do If I Fail to Download the Agent
Installation File?

Step 1 Check that your computer can access the Internet. Then, run the following
command in the cmd window to check whether Address is followed by an IP
address.

nslookup sms-agent-bucket.obs.ae-ad-1.myhuaweicloud.com

Step 2 If an IP address is displayed, check whether the domain name corresponding to
the IP address is contained in the hosts file. If it is, delete the record and download
the installation package again.
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If the IP address is not displayed, add the following record to the hosts file, and
download the package again:

{Addresses} sms-agent-bucket.obs.ae-ad-1.myhuaweicloud.com

Example: 100.100.100.0 sms-agent-bucket.obs.ae-ad-1.myhuaweicloud.com

NO TE

In Windows, the hosts file is stored in the C:\Windows\System32\drivers\etc directory and
can only be edited by the super administrator. In Linux, the hosts file is stored in the /etc
directory.

Step 3 If the download still fails after you have performed the preceding steps, you are
advised to use another computer to download the package and upload it to the
source server from there.

----End

4.5.3 How Do I Verify the Integrity of the Agent Installation
File?

Step 1 Log in to the SMS console.

Step 2 In the navigation pane on the left, choose Agents. Click SHA256 File in the pane
of the Agent you need to save the file containing the hash value to a local
directory.

Step 3 Obtain the hash value of the Agent installation file you have downloaded.
● Windows Agent

certutil -hashfile SMS-Agent-PyN.exe SHA256
SMS-Agent-PyN.exe is the Agent installation file name.

● Linux Agent
sha256sum SMS-Agent.tar.gz SHA256

Step 4 Compare the hash values obtained in Step 2 and Step 3.
● If they are consistent, the Agent installation file is complete.
● If they are inconsistent, download the Agent you need again and repeat Step

3 and Step 4 for verification.

----End

4.5.4 Why Wasn't My Source Server Added to the SMS Console
After I Configured the Agent?

After the Agent was installed and configured on the source server, the source
server information was not added to the SMS console. In this case, you need to
perform the following operations:

Step 1 Check whether the source server has been registered with SMS. If the source
server is registered with SMS, the message "Upload success. Waiting for the SMS
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instruction" will be displayed on the CLIs of Windows Agent Python 2 and Linux
Agent, and the message "sms agent starts up successfully" will be displayed in the
GUI of Windows Agent Python 3.

Step 2 Check whether you use the correct account to log in to the SMS console and
whether the AK/SK pair of the account is entered when you start the Agent.

Step 3 If the source server has been successfully registered with SMS, and the console
version matches the Agent version, but no records are displayed, wait for about a
minute and refresh the page.

----End

4.5.5 How Do I Find and Modify the Agent Configuration
Files?

The configuration files of the Agent are stored in the installation directory of the
Agent. For details, see SMS-Agent configuration files.

Table 4-10 Agent configuration files

Agent
configuration
files

Description Location

auth.cfg Modify this configuration file
when an HTTPS proxy server
is used for migration. You do
not need to modify this file
when a public network is
used for migration.

Windows: C:\SMS-Agent-
Py3\config or C:\SMS-Agent-
Py2\config
Linux: ../SMS-Agent/agent/
config
NOTE

../ indicates the directory where
the Agent is stored.

cloud-
region.json

You do not need to modify
this file.

g-property.cfg It is recommended that you
do not modify this main
configuration file. If you
need to modify this file,
modify it under the
guidance of professional
personnel.

disk.cfg Modify this configuration file
when you want to migrate a
partition on the source
server running Windows to a
specified disk on the target
server.
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4.5.6 Where Can I Find the Agent Run Logs?
The run logs of the Agent are stored in the Logs folder under the installation
directory of the Agent. For details, see Agent log files.

Table 4-11 Agent log files

File Location Description

startup.log Windows: C:\SMS-Agent-
Py3\Logs or C:\SMS-Agent-
Py2\Logs
Linux: ../SMS-Agent/agent/
Logs
NOTE

In the preceding directory, ../
indicates the directory where the
Agent is stored.

Records the Agent startup logs.

SmsAgent_
Info.log

Records the Agent run logs.

SmsAgent_
Error.log

Logs Agent errors.

 

4.5.7 Why Is My Target Server Locked During the Migration?
During the migration, operations on the target server may cause migration
failures. To ensure a smooth migration, the target server will be automatically
locked during the migration and unlocked after the migration. For details about
how to unlock the target serer manually, see How Do I Unlock a Target Server
Manually?

4.5.8 How Do I Unlock a Target Server Manually?

Symptom

After the migration is complete, the target server should be automatically
unlocked. However, there are a number of reasons a target server may fail to be
unlocked. For instance, there may be insufficient permissions or network issues. In
this case, you can unlock the target server manually by performing the operations
described in this section.

Possible Causes

The most typical reasons are:

1. The token is invalid or the network is faulty.
2. Account permissions are insufficient.

Solution
1. Check whether the corresponding server record still exists. If the record has

not been deleted, in the Operation column, choose More > Unlock Target
Server to unlock the target server.
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If the system displays a message indicating that you do not have the
permission to unlock the target server, use an account with the required
permission and try again.

2. If the server record has been deleted, unlock the target server by referring to .

4.5.9 How Do I Resolve the "No such file or directory:
'rsync':'rsync" Error When I Start the Linux Agent?

Symptom
If this error message was displayed after you entered the AK/SK pair and start the
Linux Agent, rsync was not installed on the source server. You need to install rsync
and restart the Agent.

Figure 4-9 Error message

Possible Causes
Linux migration depends on rsync. If rsync is not installed on the source server, the
Agent cannot be started.

Solutions
The operations for different OSs are as follows:

CentOS and Red Hat

1. Use PuTTY or another SSH client to log in to the source server as user root.
2. Install rsync.

yum install rsync

3. Enter y and press Enter.
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4. Display rsync details.
rsync --version
If the following information is displayed, rsync has been installed:

5. Start the Agent.
./startup.sh

6. Read the displayed information carefully, enter y, and press Enter.

Figure 4-10 Confirmation

7. Enter the AK and SK of the account that you migrate to.
When the following information is displayed, the Agent has been started up
and will automatically start reporting source server information to SMS.

SUSE

1. Use PuTTY or another SSH client to log in to the source server as user root.
2. Install rsync.

zypper install rsync

3. Enter y and press Enter.
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4. Display rsync details.
rsync --version
If the following information is displayed, rsync has been installed:

5. Start the Agent.
./startup.sh

6. Read the displayed information carefully, enter y, and press Enter.

Figure 4-11 Confirmation

7. Enter the AK and SK of the account that you migrate to.
When the following information is displayed, the Agent has been started up
and will automatically start reporting source server information to SMS.

Ubuntu

1. Use PuTTY or another SSH client to log in to the source server as user root.
2. Install rsync.

apt-get install rsync

3. Display rsync details.
rsync --version
If the following information is displayed, rsync has been installed:
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4. Start the Agent.
./startup.sh

5. Read the displayed information carefully, enter y, and press Enter.

6. Enter the AK and SK of the account that you migrate to.
When the following information is displayed, the Agent has been started up
and will automatically start reporting source server information to SMS.

4.5.10 How Do I Resolve Error "The application cannot be
started due to incorrect parallel configuration" When I Start
the Agent?

Symptom

When you started the Windows Agent (Python 2), you received error message
"SMS.5109 The application cannot be started due to incorrect parallel
configuration."

Solution

For details, see Why Does the Agent Not Start the First Time I Launch It?

4.5.11 Why Does the Agent Not Start the First Time I Launch
It?

Due to the permission structure on some Windows machines, the Agent cannot be
started the first time you launch it. If this happens:

1. Right-click the Start menu.
2. Click Run and enter cmd.
3. Enter cd C:\SMS-Agent-Py2 to switch to the Agent installation directory. Run

SMSAgentDeploy.exe, as shown in Figure 4-12.
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Figure 4-12 Starting SMSAgentDeploy.exe

NO TE

● You must have a valid AK/SK pair.

● If message "[401:{"error_msg": " Incorrect IAM authentication in formation: xxx xxx not
exist","error_code":"APIGW.0301","request_id":"xxx"} "]" is displayed during the
execution, check whether the entered AK and SK are correct.

4.5.12 Why Does the Windows Agent Executable Not Run
When I Double-Click It?

Symptom

You double-clicked the Windows Agent executable to install the Agent, but the file
did not run.

Possible Causes

The file is blocked by the system.

Solution

Right-click SMS-Agent-py*.exe and select Properties from the shortcut. In the
Security area of the General tab, select Unblock, and run the file again.

4.5.13 How Do I Fix Error "Failed to start the I/O monitoring
module" When I Start the Agent?

Symptom

When you started the Agent, you received error message "Failed to start I/O
monitoring."

Procedure

Perform the following operations:
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1. Uninstall the Agent and re-install it.

a. If the Agent (Python 3) is installed, enter the AK/SK pair and SMS
domain name when prompted.

b. If the Agent (Python 2) is installed, enter the AK/SK pair and SMS
domain name when prompted, as shown in Figure 4-13. If no prompt is
displayed, double-click start.bat in the installation directory and enter
the AK and SK when prompted.

Figure 4-13 Entering the AK/SK pair and SMS domain name

2. Check whether antivirus software is installed on the source server.

a. If any antivirus or security software is installed, or the firewall is enabled,
a pop-up window may be displayed indicating the I/O monitoring driver
was blocked. Allow the system to run the I/O monitoring process.

b. If there is no pop-up warning, but the driver is blocked, you need to start
the I/O monitoring driver manually. In this case, uninstall the antivirus
software.

NO TE

Some antivirus software has persistent blocking functions and may block the
driver even if disabled.

3. Modify the configuration file to disable I/O monitoring.
If you do not need to synchronize data, you can modify the configuration file
to disable I/O monitoring.
In the Agent installation directory config, change the value of enablesync to
False in the g-property.cfg file, and then restart the Agent.
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Figure 4-14 Modifying the g-property.cfg file

4.5.14 How Do I Fix Error "INTERNAL ERROR: cannot create
temporary directory!" When I Start the Agent?

Symptom
When you started the SMS-Agent-Py2, you received error message "INTERNAL
ERROR: cannot create temporary directory!"

Possible Causes
Some files will be generated in a temp directory of the C: drive when you install
the Agent. This error occurs if the available space of the C: drive is insufficient or if
you do not have the permission to create a temp directory there.

Solutions
● Check how much space is available on the C: drive. If there is not enough

space, clean up the drive.
● Check whether you can create a temp directory on the C: drive. You may need

to obtain write permissions.
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4.5.15 How Do I Resolve Error "AK/SK authentication failed.
Ensure that the system time is consistent with the standard
time and the AK and SK are correct" When I Start the Agent?

Symptom
The AK and SK of your account were entered in the Agent, but the AK/SK-based
authentication fails. The specific error message depends on the OS.

● Windows: AK/SK authentication failed. Ensure that the system time is
consistent with the standard time and the AK and SK are correct."

● Linux: AK/SK authentication failed. Ensure that the system time is consistent
with the standard time and the AK and SK are correct.

NO TE

For details about how to obtain an AK/SK pair, see How Do I Create an AK/SK Pair
for an Account? or How Do I Create an AK/SK Pair for an IAM User?

Possible Causes
Possible causes are:

● The entered AK or SK is incorrect.
● The system time of the source server is consistent with the local standard

time.
● The time zone in the source server is configured incorrectly.
● The AK/SK pair has been deleted or disabled.
● The programmatic access method is not enabled for the account you used for

migration.

Handling Methods
● Case 1: The entered AK or SK is incorrect.

Check whether the entered AK and SK of the account is correct, especially
whether any spaces or characters are missed during the copy. Enter the AK/SK
pair for authentication again.

● Case 2: The system time of the source server is consistent with the local
standard time.
Check whether the system time of the source server is consistent with the
standard time of the time zone where the source server is located.
If it is not, change the system time to the local standard time, and enter the
AK/SK pair for authentication again.

CA UTION

If services on the source server depend on the system time, check whether the
time can be changed to avoid impact on services.
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● Case 3: The time zone in the source server is configured incorrectly.

Change the time zone in the source server so that the system time plus the
time zone is equal to the standard UTC time. For details, see section
"Changing the Time Zone" in Elastic Cloud Server User Guide. Enter the AK/SK
pair for authentication again.

● Case 4: The AK/SK pair has been deleted or disabled.

Choose My Credentials > Access Keys to check whether the AK is in the list.

– If it is not, change or create an AK.

– If it is, check whether it is disabled. If the AK is disabled, enable it.

● Case 5: The programmatic access method is not enabled for the account you
used for migration.

a. Log in to the management console.

b. Click the username in the upper right corner and choose Identity and
Access Management.

c. In the navigation pane on the left, choose Users and click the username
you used for migration.

d. On the Basic Information tab page, check whether Programmatic
access is selected for Access Type.

e. If it is not, click , select Programmatic access, and click OK.

4.5.16 How Do I Troubleshoot Failures of Pasting the AK/SK
Pair When I Start the Agent (Python 2)?

Symptom

When you started the SMS-Agent (Python 2), you could not paste the AK/SK pair
by right-clicking in the command window.

Prerequisites

You have obtained the AK/SK pair. For details, see How Do I Create an AK/SK
Pair for an Account? or How Do I Create an AK/SK Pair for an IAM User?

Solution

Step 1 Log in to the source server.

Step 2 Go to the Agent installation directory C:\SMS-Agent-Py2 and double-click agent-
start.exe.

Step 3 Copy the AK, click the icon in the upper left corner of the window, choose Edit >
Paste from the displayed menu, and press Enter.

Step 4 Copy the SK, click the icon in the upper left corner of the window, choose Edit >
Paste from the displayed menu, and press Enter.
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----End

4.5.17 How Do I Resolve Error "utf-8 codec can't decode byte
0xce in position0: invalid continuation byte" When I Start the
Agent?

Symptom
In Linux, after you ran ./startup.sh or bash startup.sh to start the Agent, the
following message was displayed: "utf-8 codec can't decode byte 0xce in position0:
invalid continuation byte."

Possible Causes
The character set of the source system is incorrect and is incompatible with SMS.
As a result, the Agent could not be started.

Handling Method
1. Log in to the source server.
2. Set the character set.

export LANG="en_US.UTF-8"

3. Restart the Agent. If the problem persists, set the character set again.
export LC_ALL="en_US.UTF-8"
export LANG="en_US.UTF-8"
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Impact Scope
Setting the character set affects only the current shell and applications in the
shell. It does not affect your files or other applications.

4.5.18 How Do I Resolve Error "Failed to load wmi" During the
Agent Startup?

Symptom
When you started the Agent, the message "SMS.1205 Failed to load wmi" was
reported.

Possible Causes
Files related to Windows Management Instrumentation (WMI) are missing or
damaged. In Windows, the Agent uses the WMI module to collect source server
details, such as the CPU, memory, and disks details. The missing or damaged
WMI-related files need to be restored.

CA UTION

● WMI will be stopped during the restoration. Confirm that stopping WMI will
not affect services on the source server. The restoration will also change the
files on the source server, which may involve certain risks. It is recommended
that you perform the operations on a cloned source server first.

● If the issue persists, you can create an ECS by referring to "Creating a Windows
ECS from an Image".

Restoring WMI

Step 1 Right-click This Computer in the navigation pane on the left in your file explorer
and choose Manage from the shortcut menu.

Step 2 On the Computer Management page, choose Services and Applications >
Services. Stop Windows Management Instrumentation.

Step 3 Change C:\Windows\System32\wbem\repository to C:\Windows
\System32\wbem\repository_old.

Step 4 Start Windows Management Instrumentation.

Step 5 Open the cmd window as administrator.

Step 6 Go to the C:\Windows\System32\wbem\ directory.

cd C:\Windows\System32\wbem\

Step 7 Restore WMI.

for /f %s in ('dir /b *.mof') do mofcomp %s

for /f %s in ('dir /b en-us\*.mfl') do mofcomp en-us\%s
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Step 8 Restart the Agent.

----End

4.5.19 How Do I Fix the Agent Startup Failures Due to Agent
Files Write or Read Failures?

Symptom

When you install the Agent on a Windows source server, the system displayed a
message indicating that the Agent failed to be installed because Agent file cannot
be written or opened for writing.

Possible Causes
● If a message indicating a write failure is displayed, it may be that there is not

enough space on the system disk of the source server.
● If a message indicating a read failure is displayed, the possible cases are as

follows:

a. Role permissions are insufficient.
b. Antivirus software is blocking access to the files.

Agent Files Write Failure
● Windows: There is a partition of 600 MB or larger, but the available space is

less than 320 MB. There is a partition smaller than 600 MB, but the available
space is less than 40 MB.

● Linux: The available space on the root partition is less than 200 MB.

Agent Files Read Failure
1. Install the Agent as administrator.
2. Disable the antivirus software and try again. If the error persists, uninstall the

antivirus software and try again.

4.5.20 How Do I Restart the Agent?

Windows
● Windows Agent (Python 3)

1. Right-click the SMS-Agent icon in the task tray and choose Quit from the
shortcut menu.
2. Open the C:\SMS-Agent-Py3 folder and double-click SMS-Agent.exe.
3. On the page that is displayed, enter the AK/SK pair when promoted and
click Start.

● Windows Agent (Python 2)
1. Open the C:\SMS-Agent-Py2 folder and double-click restart.bat.
2. In the CMD window that is displayed, enter the AK/SK when prompted.
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Linux

1. Go to the directory where the SMS-Agent installation package is decompressed
and run ./restart.sh.

2. On the page that is displayed, enter the AK/SK pair when prompted.

4.5.21 How Do I Fix Agent Startup Failures Due to Insufficient
Space in /tmp on a Linux Source Server?

Symptom

When you ran sh startup.sh to start the SMS Agent, the following message was
displayed:

Failed to write all bytes for cffibackend.cpython-36m-x86_64-linux.gnu.so
fwrite: No space left on device

Possible Causes

When the Agent is being started, directories and files are generated in the /tmp
directory on the source server. These files will occupy about 40 MB of space. You
need to reserve more than 100 MB space for the /tmp directory.

Solution

Step 1 Log in to the source server.

Step 2 Run the df -lh command to check whether there is a volume mounted to
the /tmp directory. If there is, check the available space for that volume.

Step 3 If the available space in the /tmp directory is insufficient for the mounted volume,
delete unnecessary files or expand the capacity of the volume mounted to
the /tmp directory.

----End

4.5.22 How Do I Fix Error "Agent startup failed because the
noexec permission is not allowed on /tmp for SMS Agent.
Please remount /tmp without noexec" When I Start the Linux
Agent?

Symptom

When you ran sh startup.sh to start the SMS Agent, the following message was
reported: "SMS.5102 Agent startup failed because the noexec permission is not
allowed on /tmp for SMS Agent Please remount /tmp without noexec."
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Possible Causes
This problem occurs because a block device is mounted to the /tmp directory, but
the exec permission was not assigned or the noexec permission was assigned
during the mounting.

Solution
Step 1 Log in to the source server.

Step 2 Run mount -l | grep /tmp. If information similar to the following is displayed, the
noexec permission is assigned:
/dev/vdb1 on /tmp type ext4 (rw, noexec, relatime, data=ordered)

Step 3 Remount the block device to the /tmp directory. Do not assign the noexec
permission during the mounting. Alternatively, run mount -o remount exec /tmp
to assign the exec permission.

Step 4 Run mount -l | grep /tmp again. If information similar to the following is
displayed, restart the Agent.
/dev/vdb1 on /tmp type ext4 (rw, relatime, data=ordered)

----End

4.5.23 How Do I Resolve Error "Only servers with x86
architecture can be migrated"?

Symptom
When you started the Agent, you got the message "Only servers with x86
architecture can be migrated."

Possible Causes
SMS can only migrate x86 servers.

4.5.24 How Do I Fix Error "Failed to start sms agent! 'disks'"
When I Start the Agent on a Linux Source Server?

Symptom
When you started the Agent on a Linux source server, message "Failed to start sms
agent!'disks'" was displayed.
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Possible Causes

Possible causes are:

1. Multiple volume groups are with the same name.
Check whether the SmsAgent_Error.log file records "Multiple VGs found with
the same name".
SMS requires that a Linux source server cannot have volume groups with the
same name, or the Agent will be unable to collect information about the
source server disks. Run the vgdisplay command to check whether there are
volume groups with the same name, and run the lvdisplay command to view
logical volume properties, such as the host name and creation time.

2. The fdisk command cannot be found on the source server.
Run the fdisk -l command on the source server to check whether the fdisk
command exists in your path. If fdisk cannot be found, the possible cause is
that the /sbin directory is not included in PATH, or the /sbin directory is
included in PATH but does not take effect. This problem may occur after you
run the su command to switch to the root user.

Solutions
1. If there are volume groups with the same name in Linux, these volume groups

and the corresponding logical volumes cannot be mounted or read.
You can detach the disks in the volume groups that fail to be mounted from
the source server and attach them to another server. Then check whether the
data in the disks needs to be migrated.
– If the data needs to be migrated, run the vgrename command to rename

each of these volume groups, and attach the disks in these groups back
to the source server. Then restart the SMS Agent.

– If the data does not need to be migrated, restart the SMS Agent. After
the migration is complete, attach the disks back to the source server.

2. Run the source /etc/profile command and restart the SMS Agent.

4.5.25 How Do I Fix Error "SMS.1901, Agent cannot read disk
information" When I Start the Agent Installed on a Windows
Source Server?

Symptom

When you started the Agent installed on the source server running Windows,
message "SMS.1901, Agent cannot read the disk information" was displayed.

Possible Cause

The disk manager on the source server cannot be opened.

Solutions

Step 1 Restart the source server.
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Step 2 Open the Run dialog box, enter cmd, and click OK.

Step 3 Enter diskmgmt.msc and press Enter.
● If the Disk Management box can be opened, restart the Agent.
● If the Disk Management box cannot be opened, use images to perform the

migration.

----End

4.5.26 How Do I Fix Error "Failed to obtain information about
disk X" When I Start the Agent on a Linux Source Server?

Symptom
When you started the Agent on a Linux source server, you received message
"Failed to obtain information about disk %s. Cause: unknown physical
volume!"

Possible Causes
The source server uses LVM and there are unknown physical volumes on the
server. The Agent cannot collect the information about these volumes.

You can run the pvs command on the source server to check the details about its
physical volumes.

Solutions

Step 1 Contact technical support of the source platform to restore the source server.

Step 2 After the source server is restored, run the pvs command to check if there are still
any unknown physical volumes on the server.

If there are no unknown physical volumes, perform the migration again.

----End
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4.5.27 How Do I Choose When the System Asks Whether to
Disable the Google Services Detected on My Source Server on
the Google Cloud?

Description
When I started the Agent on the Linux source server running on the Google Cloud,
the system asked me whether to disable the detected Google services.

Background
Some Google Cloud services depend on the Google Cloud. After the source server
is migrated to the cloud platform, these Google Cloud services cannot run
properly. As a result, after the migration the target server may fail to be launched
or other services may fail to be started. Before the migration, read Description of
Disabling Google Services and make evaluations based on service requirements.

NO TE

● Disabling these services does not affect the source server. It only affects the
configuration of startup services on the target server.

● If your services depend on these Google Cloud services, contact technical support before
the migration.

● If you choose to disable these Google services, enter y. During the target
server configuration, the Agent will disable these services on the target server.

● If you choose not to disable these Google Cloud services, enter n. All the
service settings will be retained on the target server after the migration. But
the target server may fail to be launched or some services may fail to be
started.

Description of Disabling Google Services
● Servers with startup services in the /etc/systemd/system directory, such as

those running Ubuntu, CentOS 8, or CentOS 9
If you choose to disable the Google services, the Agent will only delete the
soft links related to these services in the /etc/systemd/system directory. The
service files pointed by the soft links are not affected.

NO TE

Deleting the soft links of a service prevents the service from starting automatically at
startup but does not affect the actual files of the service.

● Servers with startup services in the /etc/init directory, such as those running
CentOS 6
If you choose to disable the Google services, the Agent will check the
configuration files whose names start with google in the /etc/init directory,
move these configuration files to /etc/backup_googleconf, and compress the
folder into package google_conf_bak.tar.gz for backup.
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4.5.28 How Do I Fix Error "SMS.0410: Failed to obtain
NicName/IPAddress information of source server " When I
Start the Agent on a Linux Server?

Symptom

When you started the Agent on a Linux server, one of the following messages was
displayed:

● SMS.0410: Failed to obtain NicName information of source server.

● SMS.0410: Failed to obtain IPAddress information of source server.

Possible Causes

If the source server has multiple NICs, the Agent may fail to obtain the default
gateway information of the source server. As a result, the correct NIC name, MAC
address, and IP address cannot be obtained.

Solutions
● Solution for error "SMS.0410: Failed to obtain NicName information of source

server"

a. View the routing table.
#route -n

The following table describes the parameters.

Parameter Description

Destination The destination IP address. The gateway
corresponding to 0.0.0.0 is the default gateway.

Gateway The gateway IP address.

Iface The network interface.

 

As shown in the preceding figure, if the source server has multiple default
gateways, the Agent may fail to obtain the default gateway information.
In this case, proceed with the subsequent steps.

b. Check the network configuration.
#ifconfig -a
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NO TE

● The leftmost column lists NICs, such as ethx, ensx, and enp0sx.

● inet is the IP address of a NIC.

● ether is the MAC address of a NIC.

c. Modify network.dev in the .../SMS-Agent/agent/config/g-property.cfg
configuration file.

You need to check which NIC of the source server is used for migration.
Then set network.dev to the name of the NIC used for migration.

For example, the NICs queried in step 2 include eth0, eth1, and eth2. The
NIC used for migration is eth0, so set network.dev to eth0.

d. After the configuration is complete, restart the Agent.

● Solution for error "SMS.0410: Failed to obtain IPAddress information of source
server"

a. Check whether the network.dev parameter in the .../SMS-Agent/agent/
config/g-property.cfg file has been configured.

▪ If it has, go to step 2.

▪ If it has not, go to 3.
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b. Check whether the NIC specified by network.dev is correct by referring to
Solution for error 1.

▪ If the configuration is incorrect, modify it and restart the Agent. If
the problem persists, go to step 3.

▪ If the configuration is correct, go to step 3.

c. Modify network.macaddr and network.ipaddr in the .../SMS-Agent/
agent/config/g-property.cfg configuration file.
Set network.macaddr and network.ipaddr to the values of inet (IP
address) and ether (MAC address) corresponding to the correct NIC
queried in step 2 in handling error 1.
network.macaddr = xx-xx-xx-xx-xx-xx (MAC address)
network.ipaddr = xxx.xxx.xxx.xxx (IP address)

CA UTION

Both the MAC address and IP address need to be configured. The six
groups of characters in the MAC address must be separated by hyphens
(-).

d. After the configuration is complete, restart the Agent.

4.5.29 What Do I Do If the SMS-Agent Fails to Start and Error
"SMS.0609 An earlier version of Agent is detected. Please exit
the old Agent, uninstall the old Agent completely, and install
the latest version" Is Displayed?

Symptom
During the startup of the SMS-Agent, the Agent reported that the pre-migration
check failed and displayed the following message:
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● Windows: SMS.0609 An earlier version of Agent is detected. Please exit the
old Agent, uninstall the old Agent completely, and install the latest version.

● Linux: SMS.0609 An earlier version of Agent is detected. Please exit the old
Agent, uninstall the old Agent completely, and install the latest version.

Possible Causes

If an earlier version of the Agent is not or not completely uninstalled, files cannot
be completely replaced and the latest version cannot be installed correctly.

Solutions
● Windows

a. Open the Task Manager and check whether the SMS-Agent program is
running.

▪ If the program is running, stop it and go to step 2.

▪ If the program is not running, go to step 2.

b. Uninstall the SMS-Agent of the earlier version. For details, see How Do I
Uninstall the SMS-Agent from the Source Server?

c. Install the SMS-Agent of the latest version . For details, see Installing the
SMS-Agent on Linux.

● Linux

a. Uninstall the SMS-Agent of the earlier version. For details, see How Do I
Uninstall the SMS-Agent from the Source Server?

b. Install the SMS-Agent of the latest version . For details, see Installing the
SMS-Agent on Linux.

4.5.30 How Do I Fix Error "SMS.5103: Agent startup failed."
When I Fail to Start the Agent on a Linux Source Server?
Folder /tmp is missing

Symptom

On a Linux source server, the Agent failed to be started, and message"SMS.5103:
Agent startup failed. Folder /tmp is missing" was displayed.

Possible Causes

The /tmp folder is missing on the source server.
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Check whether there is a /tmp folder.

# ls

Solution

Step 1 Create the /tmp folder on the source server.
#mkdir /tmp

Step 2 Check that the /tmp folder has been created and restart the SMS-Agent.
# ls

----End

4.5.31 How Do I Fix Error "SMS.1353: Bind mount or repeated
mount detected on /xxx of the source server" When I Fail to
Start the Agent on a Linux Source Server?

Symptom
On a Linux source server, the Agent failed to be started, and the message
"SMS.1353: Bind mount or repeated mount detected on /xxx of the source server."
was displayed.

Possible Causes
The source server may have repeated or bind mounts. In this case, data may be
migrated repeatedly or the disk space of the target server may be insufficient.

A repeated mount indicates that a disk or partition is mounted on multiple
directories. For example, disk /dev/vda1 is mounted on both the root directory /
and the /home/mnt_test directory.

A bind mount indicates that the directory where a disk or partition is mounted on
another directory. For example, disk /dev/vda1 is mounted on the root directory /,
and the root directory / is mounted on the /root/bind_test/bind_mount directory.

The common features of repeated mounts and bind mounts are as follows:

● If the data in a mounted directory changes, the changes will be synchronized
to other mounted directories.

● A disk or partition is identified at several locations by the mount command.

NO TE

The disks and folders mentioned in this section are only examples. Replace them as
required.
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● Possible cause 1: Repeated mounts
Check Method

a. Run mount on the source server to check whether a disk or partition is
mounted on multiple directories. In the following figure, the /dev/vda1
disk is mounted on both the root directory / and the /home/mnt_test
directory.

b. The SMS-Agent uses df -TH to determine how much data is on the
source server. As shown in the following figure, even if there are two
mount points, only one of them will be returned by df -TH. However,
because of the two mount points, the data in /dev/vda1 gets migrated
twice and the amount of data displayed on the SMS console (which relies
on df -TH) is less than the amount of data actually migrated.

c. Run the ls command to check the files in the root directory / and /home/
mnt_test. If the files are the same, it indicates that a repeated mount
exists. To learn how to fix this problem, see •Solution for repeated
mounts.

● Possible cause 2: Bind mounts
Check Method

a. Run mount on the source server to check whether a disk or partition is
mounted on multiple directories. In the following figure, the /dev/vda1
disk is mounted on both the / and /root/bind_test/bind_mount
directories.
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b. Run df -TH on the source server. The command output shows that only
one mount point can be returned.

c. In the /root directory on the source server, run the # du -h --max-
depth=1 ~ command to check how large the bind_test folder is.
Run the # du -h --max-depth=1 ~/bind_test command to check how
large the /root/bind_test/bind_mount folder is. As shown in the
command outputs, the subdirectory is larger than its parent directory.
This indicates a bind mount exists. To learn how to fix this problem, see
•Solution for bind mounts.
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Solutions
● Solution for repeated mounts

a. Add mount points to be excluded from migration after the
tar.exclude.dir and rsync.exclude.dir parameters in the .../SMS-Agent/
agent/config/g-property.cfg file in directory where the SMS-Agent is
installed on the source server.
In example 1, if /home/mnt_test/* is added to the end of tar.exclude.dir
and rsync.exclude.dir, all files in the /home/mnt_test/ directory will not
be migrated and synchronized.

b. (Optional) If you want that the target server has the same mounted
directories as the source server after the migration is complete, perform
the following operations:
After the migration is complete, modify the mounted directories in
the /etc/fstab file on the target server, as shown in the figure below.
Ensure that the disk /dev/vdb on the target server is automatically
mounted to the /mnt and /home/mnt_test directories.

c. Restart the SMS-Agent.
● Solution for bind mounts

a. Add mount points to be excluded from migration after the
tar.exclude.dir and rsync.exclude.dir parameters in the .../SMS-Agent/
agent/config/g-property.cfg file in the SMS-Agent installation path on
the source server.
In example 2, if /root/bind_test/bind_mount/ is added to the end of
tar.exclude.dir and rsync.exclude.dir, all files in the /root/bind_test/

Server Migration Service
User Guide 4 FAQs

2023-04-30 150



bind_mount/ directory will be excluded from migration and
synchronization.

b. (Optional) If you want that the target server has the same mounted
directories as the source server after the migration is complete, perform
the following operations:

After the migration is complete, modify the mounted directories in
the /etc/fstab file on the target server, as shown in the figure below.
Ensure that partition /dev/vda1 on the target server is automatically
mounted to the /root/bind_test/bind_mount directory.
/    /root/bind_test/bind_mount  ext3  rw,bind 0 0

NO TE

Change the mount directories and mount points based on your requirements. In
the command shown in the above figure, the first item (/) is the mount directory,
the second item (/root/bind_test/bind_mount) is the mount point, and the third
item (ext3) is the file system type. Retain rw,bind 0 0.

c. Restart the SMS-Agent.

4.5.32 How Do I Fix Error "SMS.1352: Unknown physical
volumes detected on the source server" When I Fail to Start
the Agent on a Linux Source Server?

Symptom

On a Linux source server, the Agent failed to be started, and the message
"SMS.1352: Unknown physical volumes detected on the source server." was
displayed.

Possible Causes

A volume group on the source server is created from two physical volumes, but
one of the physical volumes is detached.

As shown in the following figure, the # pvs command tells that an unknown
physical volume is detected. Volume group testvg is created from two physical
volumes, but one of the physical volumes is detached.
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Solutions
● Solution 1: Attach the unknown physical volume to the source server and then

perform the migration again.
● Solution 2: Contact SMS technical support to masquerade unknown physical

volumes and perform the migration again.

4.5.33 How Do I Fix Error "SMS.1351: Mount point /xxx
detected on the source server, which has no free space. Ensure
that there is at least 1 MB of space" When I Fail to Start the
Agent on a Linux Source Server?

Symptom
On a Linux source server, the Agent failed to be started, and the message
"SMS.1351: Mount point /xxx detected on the source server, which has no free
space. Ensure that there is at least 1 MB of space." was displayed.

Possible Causes
A directory used as a mount point on the source server is full.

Solutions

Step 1 Run the df -TH command on the source server to identify which directory is full.

Step 2 Distribute the data across different directories to ensure that each directory has at
least 1 MB of free space.

Step 3 Run the df -TH command again to confirm that there is a required free space in
each directory. Then restart the SMS-Agent.

----End

4.6 Disk Management

4.6.1 Why Was a 40 GB EVS Disk Added to the Target Server
During the Migration?

SMS creates and attaches a 40 GB EVS disk to each target server temporarily
during the migration. These EVS disks are billed on a pay-per-use base. After the
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migration is complete, these EVS disks will be released. Do not delete this EVS disk
during the migration, or the migration will fail.

4.6.2 Why Can't I Attach the Original System Disk Back to a
Target Server?

Symptom

If a migration fails, the system disk of the target server is a temporary disk with
the disk name starting with sms. As a result, the original system disk of the target
server cannot be attached back.

Possible Causes

The temporary system disk was not detached. You need to manually detach the
temporary disk.

Procedure

The following uses Linux as an example to describe how to handle this problem.

1. Connect the source server to SMS by switching to the SMS-Agent directory on
the source server, running ./agent-cli, entering connect, and pressing Enter.

2. Run clear in the CLI.
After about a minute, the temporary disk on the target server will be
detached and deleted, and the original system disk will be re-attached.

4.6.3 How Do I Resolve Error "Disk info in source server has
changed, task fail, please delete the task and then restart the
agent"?

Symptom

When you started the migration, you got the error message "SMS.0515 Disk info
in source server has changed, task fail, please delete the task and then restart the
agent."
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Possible Causes
The Agent collects information about the disks on the source server every two
hours. This error will occur if the source server disks are changed during the period
from the last collection to the start of migration. Possible changes in source server
disks include:

● Disks or partitions were attached or detached to the source server.
● The capacity of a source partition may have been expanded, and now the

target disk space is insufficient.
● A large amount of data was written to a source partition, and now the target

partition space is insufficient.
● The file system type of the source partition was changed.

Solution

Step 1 Log in to the management console.

Step 2 Click Service List. Under Migration, click Server Migration Service.

The SMS console is displayed.

Step 3 In the navigation pane on the left, choose Task Management.

Locate the task to be deleted, and in the Operation column, choose More >
Delete.

Step 4 Log in to the source server and restart the Agent. The Agent automatically reports
changed source disk information to SMS.

Step 5 Create a migration task for the source server again and start the task. For details,
see "Creating and Starting a Migration Task."

----End

4.6.4 How Do I Resize Partitions and Disks When I Migrate a
Windows Source Server?

Scenarios
You need to manually resize partitions and disks if:

● The system disk of a source server is larger than 1 TB.
● A file system on the source server is not supported by SMS.
● There are partitions that do not need to be migrated or there are other

resizing requirements.

Scenario 1
The source system disk is 1.1 TB, with 100 GB allocated for the system and boot
partitions and 1,024 GB for data disk D. You can prepare a 100 GB and a 1,024 GB
disk on the target server for receiving data from the source system disk.

The procedure is as follows:
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1. Go to the Agent configuration directory on the source server.
– Agent (Python 3)

C:\SMS-Agent-Py3\config
– Agent (Python 2)

C:\SMS-Agent-Py2\config
2. Modify the disk.cfg file as follows and save it.

[volmap]
D = 2

NO TE

● D = 2 indicates that data in disk D will be migrated to the second disk on the
target server.

● There are multiple partitions on the source server, and you want to migrate them
to different disks on the target server. In this case, modify the disk.cfg file in the
same way, such as D=2, E=3, F=4.

3. Go to the SMS console, and delete the record corresponding to this source
server.

4. Restart the Agent installed on the source server. Go back to the SMS console
to check whether the disk information has been changed in the source server
details.

CA UTION

This method is not suitable for migrating system and boot partitions, because the
system and boot partitions can be migrated only to the first disk on the target
server.

Scenario 2

Data disk D on the source server is a FAT32 partition, which caused the source
server failed the migration feasibility check. You can exclude this partition from
migration using the configuration file.

The procedure is as follows:

1. Go to the Agent configuration directory on the source server.
– Agent (Python 3)

C:\SMS-Agent-Py3\config
– Agent (Python 2)

C:\SMS-Agent-Py2\config
2. Modify the disk.cfg file as follows and save it.

[volmap]
D = -1

NO TE

D = -1 indicates that disk D will not be migrated.

3. Go to the SMS console, and delete the record corresponding to this source
server.
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4. Restart the Agent. Go back to the SMS console to check whether the disk
information has been changed in the source server details.

Scenario 3

The source server has two data disks, disk D and disk E. You want to migrate the
two data disks to the same disk on the target server.

The procedure is as follows:

1. Go to the Agent configuration directory on the source server.
– Agent (Python 3)

C:\SMS-Agent-Py3\config
– Agent (Python 2)

C:\SMS-Agent-Py2\config
2. Modify the disk.cfg file as follows and save it.

[volmap]
E = 2

NO TE

E = 2 indicates that data in disk E will be migrated to the second disk on the target
server.

3. Go to the SMS console, and delete the record corresponding to this source
server.

4. Restart the Agent. Go back to the SMS console to check whether in the source
server details, there is only one data disk which consists of partition D and
partition E.

4.6.5 How Do I Shrink the Disk Partitions on a Source Server
Running Windows?

Symptom

When you use SMS to migrate a source server running Windows, the disks on the
target server should be at least the size recommended on the Source
Management page. Otherwise, the migration may fail. If you have created a
target server running Windows, and the disks on the target server are too small,
you can shrink the source server disks to be no larger than the target server disks.

Possible Causes

For a migration to be successful, the target server disks must be at least as large
as the source disks. If they are not, you need to either scale up the target server
disk or shrink the source server disk. On a Windows server, you can shrink disk
partitions of the source server using the Windows Disk Management tool.

Procedure
1. Choose Start, enter diskmgmt.msc in the search box.

The Disk Management tool is displayed.
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2. Right-click the partition of the disk you want to shrink and choose Shrink
Volume.
The Shrink Volume dialog box is displayed.

3. Enter the amount you wish to shrink the partition by in the Enter the
amount of space to shrink in MB text box.

4. Click Shrink.
The new space available is displayed as unallocated space.

Figure 4-15 Disk partition after shrink
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5. Log in to the management console.

6. Click Service List. Under Migration, click Server Migration Service.

The SMS console is displayed.

7. In the navigation pane on the left, choose Source Management.

The Source Management page is displayed.

8. On the Source Management page, locate the row where the information
about the source server resides, click Delete in the Operation column.

The Delete Server dialog box is displayed.

9. In the Delete Server dialog box, confirm information about the source server
to be deleted and click Yes.

10. Report the information about the source server to SMS again.

– If the Agent has been uninstalled from the source server, install the Agent
again.

– If the Agent has been installed on your source server, restart the Agent to
report the source server information to SMS.

4.6.6 How Do I Exclude a Partition from Migration in
Windows?

Procedure

Step 1 Go to the Agent configuration directory on the source server.

● Agent (Python 3)

C:\SMS-Agent-Py3\config

● Agent (Python 2)

C:\SMS-Agent-Py2\config

Step 2 Modify the disk.cfg file as follows and save it.

[volmap]

D = -1

NO TE

D = -1 indicates that disk D will not be migrated.

Step 3 Restart the Agent. You will see that disk D is not displayed in the source server
details. If drive D is still displayed in the source server details, delete the source
server record on the SMS console and register the source server with SMS again.

NO TE

This method is only suitable for exclusion before the migration, because restarting the
Agent during the migration will cause a migration failure.

----End
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4.6.7 How Do I Fix Error "Failed to modify the configuration
files of the target server"?

Symptom

When you tried to modify the configuration files of a Linux target server, you got
message "SMS.3101 Failed to modify the configuration files of the target server."

Possible Causes

The possible cause for the error is as follows:

● The /etc/hosts file may be incorrectly configured.

Solution
● The /etc/hosts file may be incorrectly configured.

Possible cause: The content of the /boot/grub2/grub.cfg file is written to
the /etc/default/grub file by mistake.
Handling method: On , create an ECS running the same or similar OS as the
source server, copy the /etc/default/grub file of the new ECS to overwrite
that file of your target ECS, and try again.

4.6.8 How Do I Fix Error "Failed to create snapshot"?

Symptom

During the migration, message "Failed to create snapshot" was reported.

Possible Causes

Before data migration from servers running Windows, the VSS module is used to
create snapshots to ensure that data on the source and target servers is from the
same point in time. If the VSS module on the source server is faulty, the snapshot
creation will fail.

Procedure

Step 1 Go to the Agent configuration directory on the source server.
● Agent (Python 3)

C:\SMS-Agent-Py3\config.
● Agent (Python 2)

C:\SMS-Agent-Py2\config

Step 2 Open the g-property.cfg file and change the value of enablesnapshot to False.

Restart the migration task. In this way, the migration task skips snapshot creation.
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Figure 4-16 Modifying the configuration parameter

NO TE

If you skip snapshot creation, data on the target server and the source server may be from
different points in time during migration, and services on the target server may fail to be
started. If this happens, you can stop the software on the source server when no services
are running, and then perform a new data synchronization to ensure that the data on the
source and target servers is from the same point in time.

----End

4.6.9 How Do I Fix Error "Failed to mount partition xxx to
directory xxx"?

Symptom

During a Linux file-level migration, the migration failed, and you received message
"SMS.3205 Failed to mount partition /dev/vdc1 to directory /mnt/vdc1."

Possible Causes

There is a file system on the source server not supported by SMS.

Solution

Currently, SMS supports Ext2, Ext3, Ext4, XFS, VFAT, and Btrfs files systems for
Linux.

For unsupported file systems such as ReiserFS, you can copy files to other file
systems, uninstall the unsupported file systems, and then perform the migration.

If this is not possible on the source server, you can:
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● Use IMS to create a system disk image for the source server from an external
image file and use the image to create a server on the cloud platform.

● Use a public or Marketplace image to create a server and deploy your
applications on the server.

4.6.10 How Do I Troubleshoot a Failed Migration or
Synchronization of a Partition?

Symptom

During the migration, the system reported the message "SMS.0805 Failed to
migrate partition xxx to target server xxx" or "SMS.0806 Failed to synchronize
partition xxx to target server xxx."

Possible Causes

Possible causes are as follows:

● The network connection linking the source server to the target server is
disconnected.

● There is not enough space on the paired partition of the target server.
● The disk is detached from the target server.
● The /etc/ssh/ssh_config file is incorrectly configured on the source server.
● The TAR processes exited.

Solutions
1. Check whether the fault was caused by a network disconnection. If it was,

rectify the network fault by referring to How Do I Resolve the Error "Failed
to establish an SSH connection with the target ECS"?

2. Check whether there is enough space on the target partition.
If there is not enough space, delete any unnecessary files from the partition
on the target server or the source server, make sure there is enough space,
and try again.

3. Check whether the corresponding target server disk is detached.
If it is, attach the disk to the target server and try again. Log in to the SMS
console, choose Servers in the navigation pane on the left, locate the source
server, and click Start in the Operation column.

4. Check whether errors similar to /etc/ssh/ssh_config: line 69: Bad
configuration option: clientactiveinterval are recorded in the /root/
f2f_migrate_error.log file.
If yes, the ssh_config is incorrectly configured. Correct the configuration and
try again.

5. Check whether there are ongoing tar processes on the source or target server.
If there are not, tar was terminated. Restart the program. Log in to the SMS
console, choose Servers in the navigation pane on the left, locate the source
server, and click Start in the Operation column.

Server Migration Service
User Guide 4 FAQs

2023-04-30 161



4.6.11 How Do I Fix Error "Failed to create a file on the source
server. Cause: /bin/sh: line 0: echo: write error: No space left
on device"?

Symptom

During the migration of your Linux source server, on the SMS console, you
received message "SMS.1204 Failed to create a file on the source server.
Cause: /bin/sh: line 0: echo: write error: No space left on device."

Possible Causes

There is not enough space left on the source server. There is no space available for
creating new files.

Solution

1. Check the usage of each disk partition on the source server using df -Th.

2. If the available space on each partition is less than 1 GB, clear up more disk
space or expand the capacity.

3. Delete the record corresponding to this source server from the SMS console.
Restart the Agent installed on the source server and perform the migration again.

4.6.12 How Do I Fix Error "Failed to read /etc/fstab on the
source server"?

Symptom

When the target server was being launched, you got error message "SMS.3104
Failed to read /etc/fstab on the source server."

Possible Causes

The source server does not have the fstab file. If this is the case, an error is
reported when the system attempts to read the file during configuration
modification.

Solution
1. Log in to the source server and restore the /etc/fstab file.

2. Log in to the SMS console and choose Servers in the navigation pane on the
left.

3. Locate the source server and click Start in the Operation to start the
migration again.
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4.6.13 How Do I Resolve Error "Insufficient disks on the Target
ECS"?

Symptom

When you configure or launch the target server, you got a message "SMS.1311
Insufficient disks on the Target ECS."

Possible Causes
● When configuring the target server, SMS checks whether the target server has

the same number of disks as the source server. If you receive this error, check
whether the number of disks on the target server is less than that on the
source server, or whether any disks on the target server have been manually
deleted or detached. If this is the case, perform the operations described in
Solution for Inconsistent Number of Disks Between the Source and Target
Servers .

● After the Agent is started, any disk additions or deletions on the source server
will make the Agent fail to identify the disk changes. If this is the case,
perform the operations described in Solution for Disk Additions or
Deletions on the Source Server.

Solution for Inconsistent Number of Disks Between the Source and Target
Servers

Step 1 Click Service List. Under Migration, click Server Migration Service.

Step 2 The SMS console is displayed.

Step 3 In the navigation pane on the left, choose Servers.

Step 4 The server list is displayed.

Step 5 Locate the source server and choose More > Delete Target Configuration.

Step 6 Attach disks to the target server to ensure that the target server has at least as
many disks as the source server.

Step 7 Go back to SMS console, locate the source server in the server list, and click
Configure in the Target column to configure the target server. Then perform the
migration again.

----End

Solution for Disk Additions or Deletions on the Source Server

Step 1 Click Service List. Under Migration, click Server Migration Service.

The SMS console is displayed.

Step 2 In the navigation pane on the left, choose Servers.

The server list is displayed.
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Step 3 Locate the source server, choose More > Delete This Server.

Step 4 Attach disks to the target server to ensure that the target server has at least as
many disks as the source server.

Step 5 Go back to SMS console, locate the source server in the server list, and click
Configure in the Target column to configure the target server. Then perform the
migration again.

----End

4.6.14 How Do I Resolve Error "SMS.1105 Disk creation
failed"?

Symptom

During the creation of a target server, message "SMS.1105 Disk creation failed"
was displayed.

Possible Causes

To prevent unforeseen spikes in resource usage, quotas can limit the number or
amount of resources available to users, such as the number of EVS disks, the
capacity of EVS disks, and the number of EVS snapshots.

Solution

Increase the EVS disk quantity quota and try again.

4.6.15 How Do I Resolve Error "Failed to execute df -TH"?

Symptom

When you started the Linux Agent by running the startup.sh script, error "Failed to
execute df -TH" was reported.

Possible Causes

After you run df -TH and echo $? on the source server, if the command output is
not 0, the command execution failed.

In this case, it is possible that a mounted device is offline or does not exist.

Solution

Unmount the device. Run df -TH and echo $? and check whether the output is 0.

4.6.16 What Are the Requirements on Disks on a Target
Server?

SMS requires that:
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1. There must be at least as many disks on the target server as you specified
during partition resizing.

2. Every disk on the target server must be larger than their pair on the source
server.

For details about how to resize disks and partitions, see Configuring a Target
Server.

4.6.17 How Can I Migrate a Source Server with a Large System
Disk?

Windows
● If a source system disk is too large, and the total size of the system and boot

partitions is greater than 1 TB, SMS cannot migrate such a source server.
● If a source disk is larger than 1 TB, but the total size of the system and boot

partitions is less than 1 TB, you can modify the Agent configuration file to
perform the migration successfully.
For example, if the source system disk is 1.1 TB, with 100 GB for the system
and boot partitions and 1,024 GB for the data disk (D:), you can prepare a
100 GB and a 1,024 GB disk on the target server for receiving data from the
source system disk.

CA UTION

The system and boot partitions on the source server can only be migrated to
the first disk on the target server.
You can view the total size of these two partitions using Disk Management in
Windows.

Procedure

a. Go to the Agent configuration directory on the source server.

▪ Agent (Python 3)
C:\SMS-Agent-Py3\config

▪ Agent (Python 2)
C:\SMS-Agent-Py2\config

b. Modify the disk.cfg file as follows and save it.
[volmap]
D = 2

NO TE

1. D = 2 indicates that data in disk D will be migrated to the second disk on the
target server.

2. There are multiple partitions on the source server, and you want to migrate
them to different disks on the target server. In this case, modify the disk.cfg
file in the same way, such as D=2, E=3, F=4.

c. Restart the Agent. You will see that the partition locations have been
changed.
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Linux

If a source disk is too large, you can perform a file-level migration and resize the
disk partitions. For details about partition resizing rules, see Configuring a Target
Server. If this method does not work, contact technical support.

4.6.18 How Do I Resolve Error "Some disks on the target
server are smaller than those on the source server. Select
another target server" When I Configure the Target Server?

Symptom

When you clicked Next: Confirm after you select an existing ECS as the target
server, message "Some disks on the target server are smaller than those on the
source server. Select another target server" was displayed.

Possible Causes

When you configure a target server, ensure that the following requirements are
met:

● The target server must have at least as many disks as the source server.
● Each disk on the target server must be at least as large as the paired disk on

the source server.

If the requirements are not met, the preceding message will be displayed.

Solution

Step 1 Locate any target server disks that do not meet the second requirement, and
expand these disks on the ECS console to be at least as large as their paired
source server disks.

You can expand the target server disks based on the recommended disk sizes on
the Configure Target page of the SMS console.

If the second requirement can be met by adjusting the disk mounting sequence,
perform the following steps:

1. Go to the ECS console and stop the target server.
2. Detach all of the disks from the target server.
3. Attach these disks back to the target server based on the recommended disk

sequence displayed on the Configure Target page of the SMS console.

Step 2 Switch to the SMS console and select the target server you just configured.

----End

4.6.19 Can SMS Migrate Local Disks on a Source Server?
SMS does not migrate local disks on source servers. You are advised to replace the
local disks with EVS disks.
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4.6.20 Why Can't I Specify Whether to Migrate a Physical
Volume When I Resize Disk Partitions in Linux?

● Case 1: Migrate is set to No and cannot be modified for a physical volume.
If none of the logical volumes in a volume group are migrated, their physical
volumes are not migrated by default. If you want to change the settings,
select Yes for Migrate All Volume Groups and try again.

● Case 2: Migrate is set to Yes and cannot be modified for a logical volume.
If there are physical volumes that do not need to be migrated, increase the
total size of the other physical volumes or decrease the total size of logical
volumes, to ensure that the total size of physical volumes is larger than that
of logical volumes.
For details about partition resizing rules, see What Are the Rules for
Resizing Volume Groups, Disks, and Partitions?

● Case 3: In a Linux block-level migration, you can choose to migrate either all
or none of the volume groups.
For a block-level migration of a Linux server using LVM, physical volumes and
logical volumes cannot be resized.

4.6.21 Why Can't I Specify Whether to Migrate a Logical
Volume When I Resize Disk Partitions in Linux?

● Case 1: Logical volumes without mount points are migrated by default.
● Case 2: Migrate is set to No and cannot be modified for a logical volume.

To migrate this logical volume, increase the volume group size to ensure that
it is larger than the total logical volume size.
For details about partition resizing rules, see What Are the Rules for
Resizing Volume Groups, Disks, and Partitions?
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● Case 3: In a Linux block-level migration, you can choose to migrate either all
or none of the volume groups.
For a block-level migration of a Linux server using LVM, physical volumes and
logical volumes cannot be resized.

4.6.22 What Are the Rules for Resizing Volume Groups, Disks,
and Partitions?

Table 4-12 Rules for resizing disks and partitions in Windows

Item Minimum Size Maximum Size

Disk ● System disk (The larger
value is used.)
– Total partition size

after resizing
– 40 GB

● Data disk (The larger
value is used.)
– Total partition size

after resizing
– 10 GB

● System disk: 1,024 GB
● Data disk: 32,768 GB

Disk partition The smaller value is used.
● Used space + 1 GB
● Size before resizing

Disk size after resizing – Total
size of the other partitions on
the disk

 

Table 4-13 Rules for resizing volumes, disks, and partitions in Linux

Scenari
o

Item Minimum Size Maximum Size

LVM Logical
volume (LV)

The smaller value is used.
● Used space + 1 GB
● Size before resizing

VG size after resizing –
Size of the other LVs in
the VG
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Scenari
o

Item Minimum Size Maximum Size

Physical
volume (PV) -
disk

The larger value is used.
● 10 GB
● Total size of LVs in the

VG – Total size of the
other PVs in the VG

32,768 GB

Physical
volume (PV) -
partition

The larger value is used.
● 1 GB
● Total size of LVs in the

VG – Total size of the
other PVs in the VG

Disk size after resizing –
Total size of the other
partitions on the disk

Non-
LVM

Disk ● System disk (The
larger value is used.)
– Total partition size

after resizing
– 40 GB

● Data disk: 10 GB

● System disk: 1,024
GB

● Data disk: 32,768 GB

Partition The smaller value is used.
● Used space + 1 GB
● Size before resizing

Disk size after resizing –
Total size of the other
partitions on the disk

 

4.6.23 How Do I Migrate a Server with a System Disk Larger
Than 1 TB?

Background
SMS is restricted by an IMS limitation on the system disk size. When you use an
image to create an ECS, the system disk cannot be larger than 1 TB. If the system
disk of the source server to be migrated is larger than 1 TB, the migration can only
be performed when certain conditions are met and the disk is resized.

Linux File-Level Migration
If the source system disk is larger than 1 TB but the disk usage is low, less than I
TB of space used, you can resize the system disk and system partition of the target
server before migration.

Step 1 Install the Agent on the source server. For more information, see "Installing the
Agent".

Step 2 Start the Agent. After the Agent is started, configure a target server by referring to
Configuring a Target Server. When you configure the basic settings, select Yes for
Partition Resize to resize the disks and partitions of the target server.
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Step 3 In the Resize Partition window, set a new size for the system disk and partition as
needed.

Step 4 Click Next: Configure Target to complete the migration configuration and start
the migration.

----End

Windows Migration

See How Do I Resize Partitions and Disks on a Target Server Running
Windows Before the Migration?

4.6.24 How Do I Detach the Temporary System Disk from My
Target Server and Re-attach the Original Disk?

Symptom

After you deleted a failed or suspended migration task from the SMS console, the
target server was still using the temporary system disk, whose name starts with
SMS. As a result, the original system disk could not be re-attached.

Possible Causes

If a migration task fails or is suspended, the system will not automatically detach
the temporary system disk and re-attach the original system disk. If you want to
restore this server to its original condition, you need to perform this step manually.

Solution

Step 1 Detach the temporary system disk.

1. Log in to the ECS console.
2. In the server list, locate this server and click its name.
3. Click the Disks tab, locate disk SMS-Temp_Disk_Deleted-after-migration,

and click Detach.

4. Click Yes.

Step 2 Detach the original system disk.

NO TE

The original system disk is attached as a data disk. You need to detach it and attach it as a
system disk again.

1. Detach the original system disk from the target server by referring to step 1.

2. Log in to the EVS console. In the disk list, locate the disk you detached and
click the disk name.
Check whether the disk has changed from a data disk to a system disk. If it
has, go to the next step.

----End
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4.6.25 Why Is There Less Data on the Target Server After the
Migration Than There Was on the Source Server?

Symptom
After the migration was complete, the amount of migrated data was less than the
total amount of data scanned on the source server.

Possible Causes
The total amount of data to be migrated on the source server is collected by the
Agent through the df-Th command. The amount of migrated data is the total
combined size of all the migrated files.

If these two amounts are different, the possible causes are as follows:

● Possible cause 1: Some files were deleted from the source server, but the
processes using these file still exist.
The rm command or other software is often used to delete files. If a file is
used by a running process when it is deleted, it will still be accessible to this
process and will continue to occupy disk space.

a. On the source server, run df -Th to check whether the used disk space is
the same as the total amount of migrated data.

b. In the root directory of the source server, run du -sh * to check the disk
usage of directories.

In the above figures, df reports a larger data volume than du.
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c. Run the following command on the source server:
lsof -n / |grep deleted

If information similar to the following is displayed, some files were
deleted but are still in use by some running processes.

▪ If the migration task can be finished and the target server can be
launched, the data unmigrated has no effects on the target server,
and this problem can be ignored.

▪ (Optional) On the source server, run lsof -n / |grep deleted and stop
all the processes returned.

▪ (Optional) Restart the source server at an appropriate time to stop
the processes.

● Possible cause 2: Some directories were excluded from migration.
In Linux, the Agent does not migrate files in the following directories by
default:
/proc/*
/sys/*
/lost+found/*
/var/lib/ntp/proc/*
But these directories are counted in the total volume of source data scanned
by the Agent.
In the root directory of the source server, run du -sh * to check how much
space is occupied by directories that were not migrated, such as /
proc/*, /sys/*, /lost+found/*, and /var/lib/ntp/proc/*.
If the total size of these excluded directories equals to the size of unmigrated
data, the migration is successful, and this problem can be ignored.

● Possible cause 3: There were data changes on the source server during
the migration.
When a migration starts, the Agent runs the df -Th command to obtain
information about directories where each partition is mounted and traverses
these directories to calculate the amount of data to be migrated.
Data that has already been migrated is not affected by changes to the source
data. However, if data that has not been migrated changes, the most current
version is what migrated.
The amount of data displayed on the SMS console reflects information
collected from the source server during the first scan. During the migration, if
a large amount of data is changed on the source server, for example, a large
amount of data is deleted before being migrated, the amount of data
migrated may be less than the total amount of data scanned for the first
time.
You can run df -Th on the source and target servers for comparison.
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● Possible cause 4: A large number of sparse files existed on the source
server.

Sparse files are scanned but ignored during the migration. This may lead to
the amount of migrated data less than the total amount of data calculated
during the first scan.

NO TE

There are many ways to generate sparse files in Linux, such as running the dd
command.

4.6.26 How Do I Merge Disks During a Linux Migration?

Scenario

When you migrate a Linux server, you can migrate partitions from different disks
on the source server to a single disk on the target server.

Solution

Modify the SMS-Agent configuration file on the source server.

NO TICE

● The modified configuration file will only be used for the target server. It will not
affect the source server.

● The migration progress bar on the SMS console may not be able to show the
real-time progress after you modify the configuration file.

Step 1 On the source server, go to the config directory in the Agent installation directory.
cd SMS-Agent/agent/config

Step 2 Open and edit the disk.cfg configuration file in config.
vi disk.cfg

Step 3 Modify parameters under vol_disk_modify.

● vol_name: Enter the names of the original partitions.

● new_vol_name: Enter the names of the new partitions.

● disk_name: Enter the names of disks where the source partitions are located.

● new_disk_name: Enter the names of target disks.

In this example, we will migrate the vdc1 partition on the vdc disk and the vdd1
partition on the vdd disk of the source server to the vdb4 and vdb5 partitions on
the vdb disk of the target server.

[vol_disk_modify]
vol_name=/dev/vdc1;/dev/vdd1
new_vol_name=/dev/vdb4;/dev/vdb5
disk_name=/dev/vdc;/dev/vdd
new_disk_name=/dev/vdb;/dev/vdb
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CA UTION

● Use semicolons (;) to separate disk or partition names. Make sure that the
same number of values configured for each of the above four parameters.

● Make sure the target disk is larger than the total size of all the partitions on it,
or the migration may fail. If you need to resize the target disk or add a new
disk, see Resizing Disks and Adding Disks.

● Make sure that you follow the right naming format of "Disk name+Partition
number", for example, vdb4. The new partition name must be unique.

● Neither LVM nor Btrfs partitions can be merged.

Step 4 Save settings in the disk.cfg configuration file and restart the Agent.
:wq

----End

Resizing Disks

You can resize target disks by modifying the disk_size_modify parameter in the
disk.cfg configuration file.

● disk_name: Enter the names of target disks.

● adjust_size: Enter the new disk sizes.

In the following example, we will change the size of the target disk vdb to 40 GB.
[disk_size_modify]
disk_name=/dev/vdb
adjust_size=40G

CA UTION

● For a system disk, its size must range from 40 GB to 1024 GB.

● For a data disk, its size must range from 40 GB to 32,768 GB.

Adding Disks

You can add disks by modifying the disk_add parameter in the disk.cfg
configuration file.

● disk_name: Enter the names of new disks.

● adjust_size: Enter the sizes of new disks, in GB.

In the following example, we will add a 10 GB disk called vdd to a target server.
[disk_add]
disk_name=/dev/vdd
disk_size=10G
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CA UTION

● The disk name must comply with the naming rules and must be unique.
● The disk size must range from 10 GB to 32,768 GB.

4.6.27 How Do I Split a Disk During a Linux Migration?

Scenario
When you migrate a Linux server, you can migrate partitions from a disk on the
source server to different disks on the target server.

If you need to reduce the size of a partition or disk on the target server, you can
resize the partition or disk when creating a task on the SMS console after the
SMS-Agent is started.

Solution
Modify the SMS-Agent configuration file on the source server.

NO TICE

● The modified configuration file will only be used for the target server. It will not
affect the source server.

● The migration progress bar on the SMS console may not be able to show the
real-time progress after you modify the configuration file.

Splitting by Partition
You can split a partition by modifying the partition mapping.

Step 1 On the source server, go to the config directory in the Agent installation directory.
cd SMS-Agent/agent/config

Step 2 Open and edit the disk.cfg configuration file in config.
vi disk.cfg

Step 3 Modify parameters under vol_disk_modify.
● vol_name: Enter the names of the original partitions.
● new_vol_name: Enter the names of the new partitions.
● disk_name: Enter the names of disks where the source partitions are located.
● new_disk_name: Enter the names of target disks where the new partitions

are located.

In this example, we will migrate the vda2 and vda3 partitions from the source
disk vda to the target disks vdb and vdc.

[vol_disk_modify]
vol_name=/dev/vda2;/dev/vda3
new_vol_name=/dev/vdb2;/dev/vdc2
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disk_name=/dev/vda;/dev/vda
new_disk_name=/dev/vdb;/dev/vdc

CA UTION

● Use semicolons (;) to separate disk or partition names. Make sure that the
same number of values configured for each of the above four parameters.

● Make sure that the available space on the target server can accommodate the
new partitions, or the migration may fail. To adjust the size, see Resizing Disks
or Adding Disks.

● Make sure that you follow the right naming format of "Disk name+Partition
number", for example, vdb4. The new partition name must be unique.

Step 4 Save settings in the disk.cfg configuration file and restart the Agent.
:wq

----End

Resizing Disks

You can resize target disks by modifying the disk_size_modify parameter in the
disk.cfg configuration file.

● disk_name: Enter the names of target disks.

● adjust_size: Enter the new disk sizes.

In the following example, we will change the size of the target disk vdb to 40 GB.
[disk_size_modify]
disk_name=/dev/vdb
adjust_size=40G

CA UTION

● If the target disk is a system disk, its size range must be from 40 GB to 1024
GB.

● If the target disk is a data disk, its size range must be from 40 GB to 32,768 GB.

Adding Disks

You can add disks by modifying the disk_add parameter in the disk.cfg
configuration file.

● disk_name: Enter the names of new disks.

● adjust_size: Enter the sizes of new disks, in GB.

In the following example, we will add a 10 GB disk called vdd to a target server.
[disk_add]
disk_name=/dev/vdd
disk_size=10G
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CA UTION

● The disk name must comply with the naming rules and must be unique.
● The disk size range must be from 10 GB to 32,768 GB.

4.7 Migration or Synchronization Failures

4.7.1 After the Migration Is Complete, How Do I Replicate Any
New Data from the Source Server to the Target Server?

To synchronize the incremental source data to the target server during migration,
click Synchronize in the Operation column of the task after the migration is
complete.

4.7.2 How Do I Fix the Error "The migration module stops
abnormally and cannot synchronize data"?

Symptom
The message "The migration module stops abnormally and cannot synchronize
data" is displayed during the continuous synchronization.

Possible Causes
The Agent or the source server has been restarted.

NO TE

On the source server, there is a process that monitors disk changes and synchronizes the
incremental data from the source server to the target server. If the source server is
restarted, this process is stopped, and the incremental synchronization cannot be
performed.

Solution
In this case, the migration task cannot continue. Delete the task and create a
migration task for the source server again. To prevent this issue from happening,
take care to avoid restarting the source server or Agent during migration.

4.7.3 What Do I Do If the SMS-Agent Exits Suddenly and
Disconnects a Windows Source Server from the SMS Console
During a Migration?

Symptom
During the migration of a Windows server, the source server was suddenly
disconnected from the SMS console. It was found that the SMS-Agent program
exited on the source server.
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Possible Causes

The SMS-Agent program may exit if the Customer Experience Improvement
Program is turned on on the source server.

1. Check the disconnection time in the SMS-Agent migration logs stored in
C:\SMS-Agent-Py3\SmsAgent_Info.log.

2. On the source server, open Event Viewer > Windows Logs > System.

3. In the system logs, check the log generated at the SMS-Agent disconnection
time. The log says that the source server was automatically restarted due to a
user logout notification for the customer experience improvement program.

Solution

Turn off the customer experience improvement program.

Step 1 On the source server, open the Run window, enter gpedit.msc, and click OK.

Step 2 In the navigation tree, choose Computer Configuration > Administrative
Templates > System > Internet Communication Management > Internet
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Communication settings, and locate Turn off Windows Customer Experience
Improvement Program.

Step 3 Double-click Turn off Windows Customer Experience Improvement Program. In
the displayed window, select Enabled and click OK.

Step 4 Open Computer Management. Choose System Tools > Task Scheduler Library
>Microsoft>Windows>Customer Experience Improvement Program, and disable
all tasks.
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Step 5 Choose System Tools > Task Scheduler Library > Microsoft > Windows >
Application Experience, and disable all tasks.

Step 6 Delete the migration task on the SMS console, create a task for the source server
again, and start the migration task.

----End

4.8 Target Server Configuration and Launch
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4.8.1 What Are the Differences Between Target and Source
Servers After the Migration?

Table 4-14 Differences between target and source servers after the migration

Item Can Be
Changed

After
Migration

Remarks

Security
Identifier
(SID)

Yes The SID of the
target server is
used.

In Windows, a SID is a unique,
immutable identifier for a server
in a given domain. If the source
server is added to a domain, the
SID will become invalid on the
target server. You need to add the
target server to the domain
again.

Host name Possibly The host name
may be
changed.

Services bound to the host name
may be affected.

OS type No The target
server runs the
same type of
OS as the
source server.

The original OS of the target
server is overwritten.

MAC address Yes The MAC
address of the
target server is
used.

A MAC address is a unique
identifier assigned to a NIC when
a target server is created.

NIC name Possibly The names of
NICs on the
target server
are
determined by
the NIC
configuration
files migrated
from the
source server.

You can modify the NIC names
after the migration, or your
services may be affected.

IP address Yes The IP
addresses of
the target
server are
used.

The target server uses its original
public IP address. If the private IP
address of the source server is
included in the network segment
of the VPC to which the target
server belongs, the private IP
address can remain unchanged.
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Item Can Be
Changed

After
Migration

Remarks

DNS The DNS
settings
are
probably
changed
on the
target
server.

The DNS
settings may
be changed on
the target
server.

After the migration is complete,
you can modify the DNS settings
for the target server.

Disk name Possibly New disk
names are
generated
based on the
virtualization
type of the
target server.

Services are not affected.

Username No The target
server uses the
same
username as
the source
server.

None

Password/
Certificate

No The target
server uses the
same
username,
certificate, and
password as
the source
server.

None

Registry and
startup items

Yes The registry
and BCD file
are modified
as needed.

SMS modifies the registry and
startup items to adapt to the
cloud platform.

Other data No Other data,
including files,
applications,
and
configurations,
are consistent
with those on
the source
server.

None
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4.8.2 How Will the Authentication of a Target Server Change?
The changes to the authentication of a target server are as follows:

● For a completed migration, the target server uses the same login credentials
as the source server. Any usernames, certificates, and passwords will remain
unchanged.

● For an ongoing Linux migration, the login credentials of the target server
depend on the option you choose when you configure the target server.
– If Use existing is selected, the target server uses its original login

credentials.
– If Create during migration is selected, a random password is created

during the migration..

4.8.3 How Do I Optimize a Windows Target Server After the
Migration Is Complete?

Scenarios
After the migration is complete, you need to manually install drivers on the target
server to solve compatibility issues.

Procedure
1. Log in to the management console.
2. Under Compute, click Elastic Cloud Server.
3. In the ECS list, view the flavor of the target ECS.

ECS flavors are named in the "AB.C.D" format, for example, m2.8xlarge.8.
A specifies the ECS type. B specifies the type ID. C specifies the flavor size. D
specifies the ratio of memory to vCPUs expressed in a digit.
– If B of the target ECS is 1, for example, s1.small.2, the ECS uses Xen

virtualization, and you will need to install the PV driver.
– If B of your target ECS is not 1, for example, s2.small.3, the ECS uses KVM

virtualization, and you will need to install UVP VMTools.
4. Check whether there is a PV driver or UVP VMTools software package on the

target ECS based on the virtualization type queried in 3.
– If there is, go to 7.
– If there is not, go to 6.

5. Download the PV driver or UVP VMTools software package to the source
server based on the virtualization type queried in 3. For more information, see
Obtaining Required Software Packages in "Optimizing a Windows Private
Image (Windows)" of Image Management Service User Guide.

6. Synchronize the PV driver or UVP VMTools software package from the source
server to the target ECS, and then go to 7.

7. Install the required driver on the target ECS.

a. For more information, see "Optimizing a Windows Private Image" >
"Installing UVP VMTools" in Image Management Service User Guide.
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b. For more information, see "Optimizing a Windows Private Image" >
"Installing the PV Driver" in Image Management Service User Guide.

4.8.4 How Do I Fix the Error "SMS.1113 Failed to reconfigure
partition details on the target server" When I Launch the
Target Server?

Symptom
The target server failed to be launched, and the message "SMS.1113 Failed to
reconfigure partition details on the target server" was displayed.

Possible Causes
When the system attempted to obtain the command, the connection timed out
due to an unstable network, and the target server could not be launched.

Solution
Ensure that the source bandwidth is sufficient. Pause the migration task and then
restart it.

4.8.5 After a Windows Server Was Migrated, Why Is the Used
Space of C: Drive Increased?

Symptom
After a Windows server was migrated to the cloud platform, the used space of C:
drive increased at least 1 GB.

Problem Analysis
This is a normal because the size of the paging file, used for virtual memory, tends
to be larger after the migration is complete.

1. Log in to the source server.
2. Choose Start > Control Panel > Folder Options.

The Folder Options dialog box is displayed.
3. Click the View tab. In the Advanced settings area, perform the following

operations:
– Deselect Hide protected operating system files (Recommended).
– Select Show hidden files, folders, and drives and click Apply.
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4. Log in to the target server and repeat 2 and 3.
5. Compare the size of the virtual memory file pagefile.sys in the Local Disk

(C:) on the source and target servers.
The pagefile.sys file on the target server is larger than that on the source
server.
The size difference of pagefile.sys on the two servers should account for the
difference in used space.

6. On the target server, click Start.
7. Choose Control Panel > System > Advanced system settings.

The System Properties dialog box is displayed.
8. Click the Advanced tab, click Settings in the Performance area.

The Performance Options page is displayed.
9. Click the Advanced tab, click Change in the Virtual memory area.

The Virtual Memory is displayed.
You can see that the target server uses Automatically manage paging file
size for all drives. That is, the size of virtual memory file pagefile.sys on the
target server is equal to the size of file Installed Memory (RAM) on the
server.
If the size of file Installed Memory (RAM) on the target server is different
from that on the source server, the used space of C: drive on the target server
is inconsistent with that on the source server.
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4.8.6 How Do I Uninstall the SMS-Agent from the Source and
Target Servers After the Migration Is Complete?

Symptom

After the migration is complete, you can perform the following operations to
uninstall the SMS-Agent.

Windows
● Method 1

a. Log in to the server where the SMS-Agent is to be uninstalled.
b. Choose Start > All Programs.
c. In the All Programs panel, click the SMS-Agent folder.
d. Click Uninstall in the SMS-Agent file.
e. In the SMS-Agent-1.0.0 Uninstall dialog box, click Yes.

● Method 2

a. Log in to the server where the SMS-Agent is to be uninstalled.
b. Click Start, and then select Computer.
c. Go to the C:\Program Files (x86)\SMS-Agent directory.
d. Double-click Uninstall.exe.
e. In the SMS-Agent-1.0.0 Uninstall dialog box, click Yes.

Linux
1. Log in to the server where SMS-Agent is to be uninstalled as user root.
2. Go to the SMS-Agent installation directory.
3. Stop the SMS-Agent.

shutdown.sh
4. Go to the upper-level directory.

cd ..
5. Delete the SMS-Agent installation directory.

rm -rf SMS-Agent

4.8.7 Why Is the File System Size Inconsistent Before and
After the Migration?

Symptom
● After the migration, the used partition space on the target server is different

from that on the source server.
● After the migration, a particular file size on the target server is different from

that on the source server.
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Possible Causes
If there are sparse files on the source server, the total size of the migrated files on
the target server may be smaller than that on the source server. This is because
rsync automatically truncates sparse files during transmission. The file system
transparently converts metadata representing empty blocks into "real" blocks
filled with null bytes at runtime.

You can check whether the files are consistent before and after the migration. For
details, see Procedure.

NO TE

In a UNIX file system, when the file displacement is greater than the file length, the next
write operation will extend the file length and form a hole in the file, creating a sparse file.
This is achieved by writing brief information (metadata) representing the empty blocks to
disks instead of the actual "empty" space which makes up the block, thus consuming less
disk space. The full block size is written to disk as the actual size only when the block
contains "real" (non-empty) data.

Procedure
1. Check the size of the file on the source server and the used disk space.

The /tmp/test-data.img file is used as an example.

a. Check the size of the /tmp/test-data.img file.
ll /tmp/test-data.img

b. Check the disk space occupied by /tmp/test-data.img.
du -sh /tmp/test-data.img

Figure 4-17 Checking the file size

2. After the migration is complete, check the size of the migrated file on the
target server. Figure 4-18 shows that the used disk space decreases after the
migration.

Figure 4-18 Checking target server file size

3. Run the following command on the source server and target server to obtain
the sha256 values of the files to determine whether the files are the same.
If the sha256 values of the files are the same, the file content is consistent.
sha256sum /tmp/test-data.img

Figure 4-19 Obtaining the sha256 value
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4.8.8 Why Can't I See Data Disks on a Windows Target Server
After Migration?

Possible Causes
The SAN policy for the source server OS is Offline Shared. This means the data
disks will be offline after migration.

Solutions
Solution 1

Step 1 Choose Start > Run.

Step 2 Enter diskmgmt.msc and press Enter to open the Disk Management window.

In the following figure, disk 1 is offline.

Figure 4-20 Offline

Step 3 Right-click the offline data disk and select online from the pop-up menu.
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Figure 4-21 Bringing the disk online

----End

Solution 2

Step 1 Right-click the Start menu.

Step 2 Click Run and enter cmd.

Step 3 Run diskpart to start the disk management tool.

Step 4 Run list disk to list all disks on the server. In the following figure, disk 0 is online
and disk 1 is offline.

Step 5 Run the select disk 1 command.

Step 6 Run the online disk command to change the disk status from offline to online.
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Step 7 If the disk is read only after it goes online, run the attribute disk clear readonly
command to remove the write protection on the disk.

----End

4.8.9 Why Can't a Windows Target Server Access the Internet
After the Migration?

Symptom
After a migration was completed, the Windows target server could not access the
Internet and message "The target server running Windows cannot access the
Internet" was displayed.

Possible Causes
The possible causes are as follows:

● There are abnormal network adapter drivers on the target server.
● The network configuration of the target server is incorrect.

Solutions
● Solution for abnormal network adapter drivers

a. Locate the abnormal network device using the device manager. Use the
Search automatically for updated driver software option to update its
driver. Then restart the target server.

b. If the fault persists, disable the driver and enable it, and restart the target
server.
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c. If the fault persists, find another ECS that is in the same AZ as the target
server and can access the Internet. Then, detach a data disk from the
target server and attach this disk to the ECS you find.

i. On the temporary ECS, download the VMTools installation package
to the disk you have attached but do not install VMTools.

ii. Attach the data disk back to the target server. Then, log in to the
target server and install VMTools.

iii. Restart the target server.
● Solution for incorrect network configuration

1. Open the cmd window, run ipconfig to view the IP address of the target
server. Check whether the IP address is the same as that displayed on the ECS
console. If they are different, a static IP address may be set for the target
server. In this case, change the IP address acquisition mode to DHCP.
2. If the EIP of the target server can be pinged, but the external domain name
cannot be pinged, configure the DNS server.

4.8.10 Why Is the System Recovery Options Window Displayed
When the Target Server Is Started?

Symptom

After the migration is complete, the target server starts and the System Recovery
Options window is displayed.

Possible Causes

Something is wrong with the key startup files.

Solution

Run BCDBoot to resolve the problem.

a. Stop the target server, create a snapshot for its system disk, and detach the disk.

b. Purchase a temporary Windows server with 1 vCPU, 2 GB memory, and 40 GB
system disk. The temporary server must be in the same region and AZ as the
target server.

c. Attach the system disk of the target server to the temporary server as a data
disk.

d. Run cmd as administrator on the temporary server. Run the following
command:

bcdboot e:\windows /s d:

NO TE

In the preceding command, e:\windows indicates the path of the system disk on the target
server, and d: indicates the path of the boot disk on the target server.

You can run bcdboot /? to view the help information.

Server Migration Service
User Guide 4 FAQs

2023-04-30 191



e. After the command is executed, detach the disk from the temporary server and
attach the disk back to the target server. Refresh the page for several times, and
start the target server.

f. If the system still cannot be started, use the created snapshot for rollback. If the
problem persists, contact technical support.

4.8.11 How Do I Expand the Capacity of a Windows System
Disk After the Migration?

Possible Causes
If a source server disk is smaller than the target server disk, there will be
unallocated space left over on the target server disk. You can expand the system
disk of the target server to take advantage of the unallocated space.

Procedure
1. Choose Start > Run.
2. Enter diskmgmt.msc and press Enter.

The Disk Management dialog box is displayed.
3. Right-click partition (C:) and choose Expand Volume.

Figure 4-22 Expanding volumes

4. In the displayed dialog box, click Next.
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Figure 4-23 Extend Volume Wizard

5. Add the available space to the C: drive and click Next.

Figure 4-24 Expanding the disk

6. In the displayed dialog box, click Finish.
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Figure 4-25 Completing the expansion

7. Check the expanded capacity.

Figure 4-26 Checking the expanded capacity
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4.8.12 How Do I Fix a GRUB Error Because an XFS Volume Is
Mounted to the /boot Partition?

Symptom
On a source server running CentOS 7.1, an XFS volume is mounted to the /boot
partition. After the source server is migrated to the cloud platform, the
corresponding target server failed to be launched.

Possible Causes
The XFS file system volume is mounted to the /boot partition, causing a GRUB
error.

Solutions
● Solution 1

Detach the system disk from the target server, and attach it to another ECS
running for example CentOS7.6. After the system disk is successfully attached,
mount the XFS file system and unmount the file system. Then detach the disk
and attach it back to the original server.

● Solution 2
Edit the GRUB installation script file SMS-Agent/agent/linux/resources/
shell/install_grub.sh on the source server, locate the install_grub2 function,
and add the two lines of code in the red box in the following figure. Then
restart the Agent for migration.
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Figure 4-27 Editing the GRUB installation script file

4.8.13 What Do I Do If a Target Server Fails to Be Created?

Symptom

During the migration, the target server fails to be created.

Possible Causes

There are many causes for target server creation failures.

● The quota is insufficient.

● The requested AZ is unavailable.

Solutions
● The quota is insufficient.

Check whether the relevant quotas have been exhausted. If they have,
increase the quotas or delete unnecessary resources to release the quotas.

● Solution for unavailable AZ

Delete the target server configuration. Select another AZ when you create a
task again.
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4.8.14 How Do I Troubleshoot a MySQL Startup Failure on the
Target Server After the Migration?

Symptom
After the migration, the MySQL service on the target server cannot start up or
immediately shut down after being started.

Possible Causes
The MySQL service on the source server is not stopped after the migration. As a
result, the related files on the target server do not match with those on the source
server.

Solution
Stop the MySQL service on the source service, perform a synchronization, and try
again.

4.8.15 How Do I Resolve Error "SELinux targeted" When I
Start a Linux Target Server After the Migration Is Complete?

Symptom
When you started a Linux target server after the migration succeeded, message
"SELinux targeted" was displayed.
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Possible Causes
The SELinux configuration is incorrect.

Solution

Step 1 Find another ECS that is in the same AZ as the target server and can access the
Internet. Detach the system disk from the target server and attach the disk to the
ECS.

Step 2 Mount the related disk partitions.

Step 3 Locate the SELinux configuration file in the disk and set SELinux to Disabled.

CA UTION

Do not modify the SELinux configuration file of the temporary ECS.

Step 4 Mount the system disk and related partitions back to the target server and restart
the target server.

----End

4.8.16 Why Do the Agent Plug-ins from the Source Cloud
Service Provider Exist on the Target Server After the Migration
Is Complete?

SMS migrates everything, such as disk data and service configurations, from a
source server to the target server.

If the agent plug-ins from the source cloud service provider are deployed on the
disks of the source server and are configured to automatically start upon system
startup, these agent plug-ins will be migrated to the target server and still start
upon system startup.

You can delete or uninstall these plug-ins or modify related configurations on the
target server.

NO TICE

SMS only ensures data consistency before and after migration. You need to modify
service configurations as needed.
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4.8.17 Why Is the Usable Memory (RAM) Less Than the Total
Installed Memory on a Target Server Running 64-bit
Windows?

Symptom

On a target server running 64-bit Windows, the usable memory (RAM) is much
less than the installed memory. For example, the system may report that there is
only 2 GB of usable memory on a target server with 32 GB of memory installed.

Possible Causes

The maximum memory is set for the target server.

Solution

Step 1 Press Win and R on the keyboard to open the Run window. Enter msconfig and
click OK. The System Configuration window is displayed.

Step 2 Click the Boot tab and click Advanced options. The BOOT Advanced Options
dialog box is displayed.

Step 3 Check whether Maximum memory is selected. If it is, deselect it and click OK.

Step 4 Click OK to close the system configuration window and restart the target server.

----End

4.8.18 How Do I Fix Error "Failed to execute boot loader on
the target ECS" When I Launch the Target Server?

Symptom

When you launched the target server, you got message SMS.3103 "Failed to
execute boot loader on the target ECS."

Possible Causes

When a target server is being launched, the system reinstalls the Grub on the
server. This error is reported if any files used for installing the Grub are missing,
such as normal.mod in /usr/lib/grub/i386-pc.

NO TE

If the migration fails, other causes may be displayed, for example, readlink not found. In
this case, check whether the SmsAgent_Error.log file on the source server contains the
i386-pc field. If yes, the i386-pc folder is missing on the target server.
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Solution

Step 1 Create an ECS in the same region and AZ and with same OS as the target server.

Step 2 Detach the system disk of the target server, and attach and mount the disk to the
vdb disk of the ECS created in the previous step.

Step 3 Copy and paste the /usr/lib/grub/i386-pc folder from the ECS to the
corresponding directory on the system disk of the target server to overwrite the
original folder.

Step 4 Detach the disk you mounted from the ECS and attach the disk back to the target
server.

Step 5 Restart the target server.

----End

4.8.19 After the Migration Is Complete, Will Deleting the
Target Server Configuration or Server Record Affects the
Source or Target Server?

After the migration is complete, if services are verified on the target server, and no
synchronization is required, you can delete the target server configuration and the
server record, and the source and target servers are not affected.

CA UTION

● If a target server configuration is deleted, the migration task will still be in the
list, but the target server information will be gone. It will no longer be possible
to perform incremental synchronizations. To perform the migration again, you
will need to configure a target server again.

● If a server record is deleted, the migration task will be deleted from the list. To
migrate the source server, you will need to restart the Agent on the source
server, and the system will generate a server record for you.

4.8.20 How Do I Fix BSOD Errors When I Start a Windows
Target Server After the Migration?

Symptom

After the migration, you started and logged in to the Windows target server.
However, the blue screen of death (BSOD) happened and the system restarted
automatically.

Possible Causes

The issue may be caused by antivirus software.
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Solution

Step 1 Start the target server in safe mode. If the server cannot start, rectify the system
driver faults and go to 2. If the server starts, go to 2.

Step 2 Check whether any antivirus software such as Sophos or Kaspersky is installed.

If any antivirus software is installed, there are two ways to fix the issue.

● Method 1

a. Create an ECS in the same region and AZ as the target server. Detach the
system disk from the target server and attach it to the ECS. Search for
and delete all antivirus software-related installation directories, registries,
and startup items.

b. Attach the disk back to target server, restart the system several times to
check that BSOD does not occur.

● Method 2

a. Uninstall the antivirus software on the source server and perform a
synchronization.

NO TE

If you cannot uninstall some antivirus software, contact their providers.

b. After the synchronization, restart the target server several times to check
that BSOD does not occur.

----End

4.8.21 How Do I Fix Startup Failures of a Windows Target
Server After the Migration?

Symptom

After the migration, the Windows target server cannot be started, even in safe
mode.

Possible Causes

The KVM driver or KVM registry is missing.

Solutions
● Solution 1

a. Create a temporary ECS in the same region and AZ as the target server.
Detach the system disk from the target server and attach it to the
temporary ECS.

b. Check for the KVM driver.

▪ Check whether files viostor.sys and vioscsi.sys exist in the Windows
\System32\drivers directory of the disk.
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▪ Check whether files viostor.cat and vioscsi.cat are in the Windows
\System32\CatRoot\{F750E6C3-38EE-11D1-85E5-00C04FC295EE}
directory of the disk.

▪ Check whether files viostor.inf and vioscsi.inf are in the Windows
\System32\drivers directory of the disk.
If any of the preceding files is missing, on the temporary ECS. Copy
the desired file to the corresponding directory on the system disk of
the target server.

CA UTION

The .sys, .cat, and .inf files are used in pairs. You need to copy a file
pair, not just a single file.

c. Check the registry.

i. Open the Registry Editor and click HKEY_LOCAL_MACHINE in the
navigation pane on the left.

ii. On the menu bar, choose File > Local Hive, locate registry
C:\Windows\System32\config\SYSTEM, and change its name from
SYSTEM to p2v.

iii. Open the registry and check whether entries p2v/ControlSet001/
services/viostor and p2v/ControlSet001/services/vioscsi are there.
If they do not, manually add them to the registry by referring to the
registry of the temporary ECS.

d. Stop the temporary ECS, and attach the disk as the system disk to the
target server. Then restart the target server.

● Method 2
on the source server and then perform a synchronization to the target server.

CA UTION

After the UVP Tools are installed, do not restart the source server, or the
synchronization will fail.

4.8.22 If I Change the Password of the Source Server and
Perform an Incremental Replication After the Full Migration
Is Complete, Will the New Password Be Synchronized to the
Target Server?

SMS migrates the passwords of source servers to target servers during the full
migration. If you change the password of a Windows source server after the full
migration is complete, an incremental synchronization cannot be performed. For a
Linux source server, an incremental synchronization can be performed, but the
new password will not be synchronized to the target server.
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CA UTION

● After changing the password of the source server, you need to restart the server
to apply the change.

● For a Windows source server, after the full migration is complete, restarting the
source server or Agent will disconnect the Agent from SMS. If this happens, you
cannot perform an incremental synchronization for the source server. You will
need to delete the original migration task, create a new task, and perform a
full migration again.

● For a Linux source server, after the full migration is complete, you can perform
an incremental synchronization even if you have restarted the source server or
Agent. However, if you change the password of the source server, the new
password will not be synchronized to the target server.
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5 Change History

Released On Description

2023-11-30 Updated FAQs.

2023-03-31 Updated FAQs.

2022-07-14 Updated FAQs.

2022-04-10 The issue is the first official release.
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